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Important Precautions

•  THIS SERVICE MANUAL IS AVAILABLE IN ENGLISH ONLY.
•  IF A CUSTOMER’S SERVICE PROVIDER REQUIRES A LANGUAGE OTHER THAN 

ENGLISH, IT IS THE CUSTOMER’S RESPONSIBILITY TO PROVIDE 
TRANSLATION SERVICES.

•  DO NOT ATTEMPT TO SERVICE THE EQUIPMENT UNLESS THIS SERVICE 
MANUAL HAS BEEN CONSULTED AND IS UNDERSTOOD.

•  FAILURE TO HEED THIS WARNING MAY RESULT IN INJURY TO THE SERVICE 
PROVIDER, OPERATOR OR PATIENT FROM ELECTRIC SHOCK, MECHANICAL 
OR OTHER HAZARDS.

•  CE MANUEL DE MAINTENANCE N’EST DISPONIBLE QU’EN ANGLAIS.
•  SI LE PRESTATAIRE DE SERVICES DU CLIENT A BESOIN DE CE MANUEL DANS 

UNE AUTRE LANGUE QUE L’ANGLAIS, IL INCOMBE AU CLIENT DE LE FAIRE 
TRADUIRE.

•  NE PAS TENTER D’INTERVENTION SUR LES éQUIPEMENTS TANT QUE LE 
MANUEL DE MAINTENANCE N’A PAS éTé CONSULTé ET COMPRIS.

•  LE NON-RESPECT DE CET AVERTISSEMENT PEUT ENTRAîNER CHEZ LE 
TECHNICIEN, L’OPéRATEUR OU LE PATIENT DES BLESSURES DUES à  DES 
DANGERS éLECTRIQUES, MéCANIQUES OU AUTRES.

•  DIESES KUNDENDIENST-HANDBUCH EXISTIERT NUR IN ENGLISCHER 
SPRACHE.

•  FALLS EIN FREMDER KUNDENDIENST EINE ANDERE SPRACHE BENö TIGT, IST 
ES AUFGABE DES KUNDEN, FüR EINE ENTSPRECHENDE ÜBERSETZUNG ZU 
SORGEN.

•  WARTEN SIE DIESES GERÄT NUR, WENN SIE DIE ENTSPRECHENDEN 
ANWEISUNGEN IM KUNDENDIENST-HANDBUCH GELESEN HABEN UND 
NACHVOLLZIEHEN KÖNNEN.

•  WIRD DIESE WARNUNG NICHT BEACHTET, SO KANN ES ZU VERLETZUNGEN 
DES KUNDENDIENSTTECHNIKERS, DES BEDIENERS ODER DES PATIENTEN 
DURCH ELEKTRISCHE SCHLä GE, MECHANISCHE ODER SONSTIGE 
GEFAHREN KOMMEN.

WARNING

AVERTISSEMENT

WARNUNG
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•  ESTE MANUAL DE SERVICIO Só LO ESTÁ DISPONIBLE EN INGLéS.
•  SI ALGúN PROVEEDOR DE SERVICIOS AJENO A GEMS SOLICITA UN IDIOMA 

QUE NO SEA EL INGLéS, LA TRADUCCIÓN ES RESPONSABILIDAD DEL 
CLIENTE.

•  NO SE DEBERá  DAR SERVICIO TéCNICO AL EQUIPO SIN HABER 
CONSULTADO Y COMPRENDIDO ESTE MANUAL DE SERVICIO.

•  LA NO OBSERVANCIA DEL PRESENTE AVISO PUEDE DAR LUGAR A QUE EL 
PROVEEDOR DE SERVICIOS, EL USUARIO O EL PACIENTE SUFRAN LESIONES 
PROVOCADAS POR DESCARGAS ELéCTRICAS, PROBLEMAS MECÁNICOS O 
PELIGROS DE OTRA NATURALEZA.

•  ESTE MANUAL DE ASSISTêNCIA TéCNICA Só  SE ENCONTRA DISPONíVEL EM 
INGLêS.

•  SE QUALQUER OUTRO SERVIç O DE ASSISTêNCIA TéCNICA, QUE Nã O A 
GEMS, SOLICITAR ESTES MANUAIS NOUTRO IDIOMA, é  DA 
RESPONSABILIDADE DO CLIENTE FORNECER OS SERVIç OS DE TRADUç ã O.

•  Nã O TENTE REPARAR O EQUIPAMENTO SEM TER CONSULTADO E 
COMPREENDIDO ESTE MANUAL DE ASSISTêNCIA TéCNICA.

•  O Nã O CUMPRIMENTO DESTE AVISO PODE PÔR EM PERIGO A SEGURANç A 
DO TéCNICO, OPERADOR OU PACIENTE DEVIDO A CHOQUES ELéTRICOS, 
MECâ NICOS OU OUTROS.

•  IL PRESENTE MANUALE DI MANUTENZIONE è DISPONIBILE SOLTANTO IN 
INGLESE.

•  SE UN ADDETTO ALLA MANUTENZIONE ESTERNO ALLA GEMS RICHIEDE IL 
MANUALE IN UNA LINGUA DIVERSA, IL CLIENTE è TENUTO A PROVVEDERE 
DIRETTAMENTE ALLA TRADUZIONE.

•  SI PROCEDA ALLA MANUTENZIONE DELL’APPARECCHIATURA SOLO DOPO 
AVER CONSULTATO IL PRESENTE MANUALE ED AVERNE COMPRESO IL 
CONTENUTO.

•  NON TENERE CONTO DELLA PRESENTE AVVERTENZA POTREBBE FAR 
COMPIERE OPERAZIONI DA CUI DERIVINO LESIONI ALL’ADDETTO ALLA 
MANUTENZIONE, ALL’UTILIZZATORE ED AL PAZIENTE PER FOLGORAZIONE 
ELETTRICA, PER URTI MECCANICI OD ALTRI RISCHI.

•  KÄESOLEV TEENINDUSJUHEND ON SAADAVAL AINULT INGLISE KEELES.
•  KUI KLIENDITEENINDUSE OSUTAJA Nõ UAB JUHENDIT INGLISE KEELEST 

ERINEVAS KEELES, VASTUTAB KLIENT Tõ LKETEENUSE OSUTAMISE EEST. 
•  ä RGE ü RITAGE SEADMEID TEENINDADA ENNE EELNEVALT Kä ESOLEVA 

TEENINDUSJUHENDIGA TUTVUMIST JA SELLEST ARU SAAMIST.
•  Kä ESOLEVA HOIATUSE EIRAMINE Võ IB Põ HJUSTADA TEENUSEOSUTAJA, 

OPERAATORI Võ I PATSIENDI VIGASTAMIST ELEKTRILö ö GI, MEHAANILISE 
Võ I MUU OHU TAGAJä RJEL.

AVISO

ATENÇÃO

AVVERTENZA 

HOIATUS 
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•  TÄMÄ HUOLTO-OHJE ON SAATAVILLA VAIN ENGLANNIKSI.
•  JOS ASIAKKAAN PALVELUNTARJOAJA VAATII MUUTA KUIN 

ENGLANNINKIELISTä  MATERIAALIA, TARVITTAVAN Kä ä NNö KSEN 
HANKKIMINEN ON ASIAKKAAN VASTUULLA. 

•  ä Lä  YRITä  KORJATA LAITTEISTOA ENNEN KUIN OLET VARMASTI LUKENUT 
JA YMMä RTä NYT Tä Mä N HUOLTO-OHJEEN.

•  MIKä LI Tä Tä  VAROITUSTA EI NOUDATETA, SEURAUKSENA VOI OLLA 
PALVELUNTARJOAJAN, LAITTEISTON Kä YTTä Jä N TAI POTILAAN  
VAHINGOITTUMINEN Sä HKö ISKUN, MEKAANISEN VIAN TAI MUUN 
VAARATILANTEEN VUOKSI.

•  ΤΟ ΠΑΡΟΝ ΕΓΧΕΙΡΙ∆ΙΟ ΣΕΡΒΙΣ ∆ΙΑΤΙΘΕΤΑΙ ΣΤΑ ΑΓΓΛΙΚΑ ΜΟΝΟ.
•  ΕΑΝ ΤΟ ΑΤΟΜΟ ΠΑΡΟΧΗΣ ΣΕΡΒΙΣ ΕΝΟΣ ΠΕΛΑΤΗ ΑΠΑΙΤΕΙ ΤΟ ΠΑΡΟΝ 
ΕΓΧΕΙΡΙ∆ΙΟ ΣΕ ΓΛΩΣΣΑ ΕΚΤΟΣ ΤΩΝ ΑΓΓΛΙΚΩΝ, ΑΠΟΤΕΛΕΙ ΕΥΘΥΝΗ ΤΟΥ 
ΠΕΛΑΤΗ ΝΑ ΠΑΡΕΧΕΙ ΥΠΗΡΕΣΙΕΣ ΜΕΤΑΦΡΑΣΗΣ.

•  ΜΗΝ ΕΠΙΧΕΙΡΗΣΕΤΕ ΤΗΝ ΕΚΤΕΛΕΣΗ ΕΡΓΑΣΙΩΝ ΣΕΡΒΙΣ ΣΤΟΝ ΕΞΟΠΛΙΣΜΟ 
ΕΚΤΟΣ ΕΑΝ ΕΧΕΤΕ ΣΥΜΒΟΥΛΕΥΤΕΙ ΚΑΙ ΕΧΕΤΕ ΚΑΤΑΝΟΗΣΕΙ ΤΟ ΠΑΡΟΝ 
ΕΓΧΕΙΡΙ∆ΙΟ ΣΕΡΒΙΣ.

•  ΕΑΝ ∆Ε ΛΑΒΕΤΕ ΥΠΟΨΗ ΤΗΝ ΠΡΟΕΙ∆ΟΠΟΙΗΣΗ ΑΥΤΗ, ΕΝ∆ΕΧΕΤΑΙ ΝΑ 
ΠΡΟΚΛΗΘΕΙ ΤΡΑΥΜΑΤΙΣΜΟΣ ΣΤΟ ΑΤΟΜΟ ΠΑΡΟΧΗΣ ΣΕΡΒΙΣ, ΣΤΟ ΧΕΙΡΙΣΤΗ Ή 
ΣΤΟΝ ΑΣΘΕΝΗ ΑΠΟ ΗΛΕΚΤΡΟΠΛΗΞΙΑ, ΜΗΧΑΝΙΚΟΥΣ Ή ΑΛΛΟΥΣ ΚΙΝ∆ΥΝΟΥΣ.

•  EZEN KARBANTARTÁSI KÉZIKÖNYV KIZÁRÓLAG ANGOL NYELVEN ÉRHETŐ 
EL.

•  HA A VEVŐ SZOLGÁLTATÓJA ANGOLTÓL ELTÉRŐ NYELVRE TART IGÉNYT, 
AKKOR A VEVŐ FELELŐSSÉGE A FORDÍTÁS ELKÉSZÍTTETÉSE.

•  NE PRÓBÁLJA ELKEZDENI HASZNÁLNI A BERENDEZÉST, AMÍG A 
KARBANTARTÁSI KÉZIKÖNYVBEN LEÍRTAKAT NEM ÉRTELMEZTÉK.

•  EZEN FIGYELMEZTETÉS FIGYELMEN KÍVÜL HAGYÁSA A SZOLGÁLTATÓ, 
MŰKÖDTETŐ VAGY A BETEG ÁRAMÜTÉS, MECHANIKAI VAGY EGYÉB 
VESZÉLYHELYZET MIATTI SÉRÜLÉSÉT EREDMÉNYEZHETI.

•  ÞESSI ÞJÓNUSTUHANDBÓK ER EINGÖNGU FÁANLEG Á ENSKU.
•  EF ÞJÓNUSTUAÐILI VIÐSKIPTAMANNS ÞARFNAST ANNARS TUNGUMÁLS EN 

ENSKU, ER ÞAÐ Á ÁBYRGÐ VIÐSKIPTAMANNS AÐ ÚTVEGA ÞÝÐINGU.
•  REYNIÐ EKKI AÐ ÞJÓNUSTA TÆKIÐ NEMA EFTIR AÐ HAFA SKOÐAÐ OG SKILIÐ 

ÞESSA ÞJÓNUSTUHANDBÓK.
•  EF EKKI ER FARIÐ AÐ ÞESSARI VIÐVÖRUN GETUR ÞAÐ VALDIÐ MEIÐSLUM 

ÞJÓNUSTUVEITANDA, STJÓRNANDA EÐA SJÚKLINGS VEGNA RAFLOSTS, 
VÉLRÆNNAR EÐA ANNARRAR HÆTTU.

VAROITUS 

ΠΡΟΕΙ∆ΟΠΟΙΗΣΗ 

FIGYELMEZTETÉS 

VIÐVÖRUN
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•  TENTO SERVISNÍ NÁVOD EXISTUJE POUZE V ANGLICKéM JAZYCE.
•  V Př íPADě , ŽE POSKYTOVATEL SLUŽEB ZÁKAZNÍKŮM POTř EBUJE Ná VOD V 

JINéM JAZYCE, JE ZAJIšTěNí Př EKLADU DO ODPOVíDAJíCíHO JAZYKA 
úKOLEM Zá KAZNíKA. 

•  NEPROVÁDĚJTE úDRŽBU TOHOTO ZAř íZENí, ANIŽ BYSTE SI Př EčETLI 
TENTO SERVISNÍ NÁVOD A POCHOPILI JEHO OBSAH.

•  V Př íPADě  NEDODRŽOVá Ní TéTO VýSTRAHY MůŽE DOJíT ÚRAZU 
ELEKTRICKÁM PROUDEM PRACOVNíKA POSKYTOVATELE SLUŽEB, 
OBSLUŽNéHO PERSONá LU NEBO PACIENTů  VLIVEM ELEKTRICKéHOP 
PROUDU, RESPEKTIVE VLIVEM K RIZIKU MECHANICKÉHO POŠKOZENÍ NEBO 
JINÉMU RIZIKU.

•  DENNE SERVICEMANUAL FINDES KUN PÅ ENGELSK.
•  HVIS EN KUNDES TEKNIKER HAR BRUG FOR ET ANDET SPROG END 

ENGELSK, ER DET KUNDENS ANSVAR AT SØRGE FOR OVERSÆTTELSE.
•  FORSØG IKKE AT SERVICERE UDSTYRET MEDMINDRE

DENNE SERVICEMANUAL ER BLEVET LÆST OG FORSTÅET.
•  MANGLENDE OVERHOLDELSE AF DENNE ADVARSEL KAN MEDFØRE SKADE 

PÅ GRUND AF ELEKTRISK, MEKANISK ELLER ANDEN FARE FOR TEKNIKEREN, 
OPERATØREN ELLER PATIENTEN.

•  DEZE ONDERHOUDSHANDLEIDING IS ENKEL IN HET ENGELS 
VERKRIJGBAAR.

•  ALS HET ONDERHOUDSPERSONEEL EEN ANDERE TAAL VEREIST, DAN IS DE 
KLANT VERANTWOORDELIJK VOOR DE VERTALING ERVAN.

•  PROBEER DE APPARATUUR NIET TE ONDERHOUDEN VOORDAT DEZE 
ONDERHOUDSHANDLEIDING WERD GERAADPLEEGD EN BEGREPEN IS.

•  INDIEN DEZE WAARSCHUWING NIET WORDT OPGEVOLGD, ZOU HET 
ONDERHOUDSPERSONEEL, DE OPERATOR OF EEN PATIËNT GEWOND 
KUNNEN RAKEN ALS GEVOLG VAN EEN ELEKTRISCHE SCHOK, 
MECHANISCHE OF ANDERE GEVAREN.

•  ðÎ APKALPES ROKASGRÂMATA IR PIEEJAMA TIKAI ANGÏU VALODÂ.
•  JA KLIENTA APKALPES SNIEDZÇJAM NEPIECIEÐAMA INFORMÂCIJA CITÂ 

VALODÂ, NEVIS ANGÏU, KLIENTA PIENÂKUMS IR NODROÐINÂT TULKOÐANU.
•  NEVEICIET APRÎKOJUMA APKALPI BEZ APKALPES ROKASGRÂMATAS 

IZLASÎÐANAS UN SAPRAÐANAS.
•  ÐÎ BRÎDINÂJUMA NEIEVÇROÐANA VAR RADÎT ELEKTRISKÂS STRÂVAS 

TRIECIENA, MEHÂNISKU VAI CITU RISKU IZRAISÎTU TRAUMU APKALPES 
SNIEDZÇJAM, OPERATORAM VAI PACIENTAM.

VÝSTRAHA

ADVARSEL

WAARSCHUWING

BRÎDINÂJUMS
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•  ÐIS EKSPLOATAVIMO VADOVAS YRA IÐLEISTAS TIK ANGLØ KALBA.
•  JEI KLIENTO PASLAUGØ TEIKËJUI REIKIA VADOVO KITA KALBA – NE 

ANGLØ, VERTIMU PASIRÛPINTI TURI KLIENTAS.
•  NEMËGINKITE ATLIKTI ÁRANGOS TECHNINËS PRIEÞIÛROS DARBØ, NEBENT 

VADOVAUTUMËTËS ÐIUO EKSPLOATAVIMO VADOVU IR JÁ SUPRASTUMËTE
•  NEPAISANT ÐIO PERSPËJIMO, PASLAUGØ TEIKËJAS, OPERATORIUS AR 

PACIENTAS GALI BÛTI SUÞEISTAS DËL ELEKTROS SMÛGIO, MECHANINIØ AR 
KITØ PAVOJØ.

•  DENNE SERVICEHÅNDBOKEN FINNES BARE PÅ ENGELSK.
•  HVIS KUNDENS SERVICELEVERANDØR TRENGER ET ANNET SPRÅK, ER DET 

KUNDENS ANSVAR Å SØRGE FOR OVERSETTELSE.
•  IKKE FORSØK Å REPARERE UTSTYRET UTEN AT DENNE 

SERVICEHÅNDBOKEN ER LEST OG FORSTÅTT.
•  MANGLENDE HENSYN TIL DENNE ADVARSELEN KAN FØRE TIL AT 

SERVICELEVERANDØREN, OPERATØREN ELLER PASIENTEN SKADES PÅ 
GRUNN AV ELEKTRISK STØT, MEKANISKE ELLER ANDRE FARER.

•  NINIEJSZY PODRĘCZNIK SERWISOWY DOSTĘPNY JEST JEDYNIE W JĘZYKU 
ANGIELSKIM.

•  JEśLI FIRMA śWIADCZĄCA KLIENTOWI USłUGI SERWISOWE WYMAGA 
UDOSTęPNIENIA PODRęCZNIKA W JęZYKU INNYM NIŻ ANGIELSKI, 
OBOWIĄZEK ZAPEWNIENIA STOSOWNEGO TłUMACZENIA SPOCZYWA NA 
KLIENCIE.

•  NIE PRó BOWAć  SERWISOWAć  NINIEJSZEGO SPRZęTU BEZ UPRZEDNIEGO 
ZAPOZNANIA SIę  Z PODRęCZNIKIEM SERWISOWYM.

•  NIEZASTOSOWANIE SIę  DO TEGO OSTRZEŻENIA MOżE GROZIć  
OBRAŻENIAMI CIAłA SERWISANTA, OPERATORA LUB PACJENTA W WYNIKU 
PORAŻENIA PRĄDEM, URAZU MECHANICZNEGO LUB INNEGO RODZAJU 
ZAGROŻEń .

•  ACEST MANUAL DE SERVICE ESTE DISPONIBIL NUMAI ÎN LIMBA ENGLEZĂ.
•  DACĂ UN FURNIZOR DE SERVICII PENTRU CLIENŢI NECESITĂ O ALTĂ LIMBĂ 

DECÂT CEA ENGLEZĂ, ESTE DE DATORIA CLIENTULUI SĂ FURNIZEZE O 
TRADUCERE.

•  NU ÎNCERCAŢI SĂ REPARAŢI ECHIPAMENTUL DECÂT ULTERIOR 
CONSULTĂRII �I ÎNŢELEGERII ACESTUI MANUAL DE SERVICE.

•  IGNORAREA ACESTUI AVERTISMENT AR PUTEA DUCE LA RĂNIREA 
DEPANATORULUI, OPERATORULUI SAU PACIENTULUI ÎN URMA 
PERICOLELOR DE ELECTROCUTARE, MECANICE SAU DE ALTĂ NATURĂ.

ÁSPËJIMAS

ADVARSEL

OSTRZEŻENIE

ATENŢIE
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•  Данно е  руководс тво  по  обслуж иванию ПРЕДОСТАВЛЯЕТСЯ 
только  на  английс ком  Языке .

•  Если  с ервисноМУ ПЕРСОНАЛУ клиента  необходимо  руководс тво  
не  на  английс ком  ЯЗЫКЕ, клиенту следует  с амос тоЯтельно  
ОБЕСПЕЧИТЬ перевод.

•  ПЕРЕД ОБСЛУЖИВАНИЕМ ОБОРУДОВАНИЯ ОБЯЗАТЕЛЬНО ОБРАТИТЕСЬ 
К ДАННОМУ РУКОВОДСТВУ И ПОЙМИТЕ ИЗЛОЖЕННЫЕ В НЕМ СВЕДЕНИЯ.

•  НЕСОБЛЮДЕНИЕ УКАЗАННЫХ ТРЕБОВАНИЙ МОЖЕТ ПРИВЕСТИ К ТОМУ, 
ЧТО СПЕЦИАЛИСТ ПО ТЕХОБСЛУЖИВАНИЮ, ОПЕРАТОР ИЛИ ПАЦИЕНТ 
ПОЛУЧАТ УДАР ЗЛЕКТРИЧЕСКИМ ТОКОМ, МЕХАНИЧЕСКУЮ ТРАВМУ ИЛИ 
ДРУГОЕ ПОВРЕЖДЕНИЕ. 

•  TÁTO SERVISNÁ PRÍRUČKA JE K DISPOZíCII LEN V ANGLIČTINE.
•  AK ZÁKAZNÍKOV POSKYTOVATEĽ SLUŽIEB VYŽADUJE INÝ JAZYK AKO 

ANGLIČTINU, POSKYTNUTIE PREKLADATEĽSKÝCH SLUŽIEB JE 
ZODPOVEDNOSŤOU ZÁKAZNÍKA. 

•  NEPOKÚŠAJTE SA VYKONÁVAŤ SERVIS ZARIADENIA SKÔR, AKO SI 
NEPREČÍTATE SERVISNÚ PRÍRUČKU A NEPOROZUMIETE JEJ.

•  ZANEDBANIE TOHTO UPOZORNENIA Mô ŽE VYÚSTIŤ DO ZRANENIA 
POSKYTOVATEĽA SLUŽIEB, OBSLUHUJúCEJ OSOBY ALEBO PACIENTA 
ELEKTRICKýM PRúDOM, PRÍPADNE DO MECHANICKéHO ALEBO INéHO 
NEBEZPEčENSTVA.

•  DEN HÄR SERVICEHANDBOKEN FINNS BARA TILLGÄNGLIG PÅ ENGELSKA.
•  OM EN KUNDS SERVICETEKNIKER HAR BEHOV AV ETT ANNAT SPRÅK ÄN 

ENGELSKA ANSVARAR KUNDEN FÖR ATT TILLHANDAHÅLLA 
ÖVERSÄTTNINGSTJÄNSTER.

•  FÖRSÖK INTE UTFÖRA SERVICE PÅ UTRUSTNINGEN OM DU INTE HAR LÄST 
OCH FÖRSTÅR DEN HÄR SERVICEHANDBOKEN.

•  OM DU INTE TAR HÄNSYN TILL DEN HÄR VARNINGEN KAN DET RESULTERA I 
SKADOR PÅ SERVICETEKNIKERN, OPERATÖREN ELLER PATIENTEN TILL 
FÖLJD AV ELEKTRISKA STÖTAR, MEKANISKA FAROR ELLER ANDRA FAROR.

•  BU SERV�S KILAVUZU YALNIZCA �NG�L�ZCE OLARAK SAĞLANMI�TIR.
•  EĞER MÜ�TER� TEKN�SYEN� KILAVUZUN �NG�L�ZCE DI�INDAK� B�R D�LDE 

OLMASINI �STERSE, KILAVUZU TERCÜME ETT�RMEK MÜ�TER�N�N 
SORUMLULUĞUNDADIR.

•  SERV�S KILAVUZUNU OKUYUP ANLAMADAN EK�PMANLARA MÜDAHALE 
ETMEY�N�Z.

•  BU UYARININ GÖZ ARDI ED�LMES�, ELEKTR�K ÇARPMASI YA DA MEKAN�K 
VEYA D�ĞER TÜRDEN KAZALAR SONUCUNDA TEKN�SYEN�N, OPERATÖRÜN 
YA DA HASTANIN YARALANMASINA YOL AÇAB�L�R.

ОСТОРОЖНО!

UPOZORNENIE

VARNING

D�KKAT
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DAMAGE IN TRANSPORTATION
All packages should be closely examined at time of delivery. If damage is apparent write “Damage In 
Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed for” by 
a GE representative or hospital receiving agent. Whether noted or concealed, damage MUST be 
reported to the carrier immediately upon discovery, or in any event, within 14 days after receipt, and the 
contents and containers held for inspection by the carrier. A transportation company will not pay a claim 
for damage if an inspection is not requested within this 14 day period.

CERTIFIED ELECTRICAL CONTRACTOR STATEMENT
All electrical Installations that are preliminary to positioning of the equipment at the site prepared for the 
equipment shall be performed by licensed electrical contractors. Other connections between pieces of 
electrical equipment, calibrations and testing shall be performed by qualified GE Medical Systems 
personnel. In performing all electrical work on these products, GE will use its own specially trained field 
engineers. All of GE’s electrical work on these products will comply with the requirements of the 
applicable electrical codes.

The purchaser of GE equipment shall only utilize qualified personnel (i.e., GE’s field engineers, 
personnel of third-party service companies with equivalent training, or licensed electricians) to perform 
electrical servicing on the equipment.

OMISSIONS & ERRORS
If there are any omissions, errors or suggestions for improving this documentation, please contact the 
GE Medical Systems Global Documentation Group with specific information listing the system type, 
manual title, part number, revision number, page number and suggestion details.  Mail the information 
to :  Service Documentation,9900 Innovation Drive (RP-2123), Wauwatosa, WI 53226, USA.

GE Medical Systems employees should use the iTrak System to report all documentation errors or 
omissions.
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LEGAL NOTES

The contents of this publication may not be copied or duplicated in any form, in whole or in part, without 
prior written permission of GE Medical Systems.

GE Medical Systems may revise this publication from time to time without written notice.

PROPRIETARY TO GE MEDICAL SYSTEMS
Permission to use this Advanced Service Software and related documentation (herein called the 
material) by persons other than GE Medical Systems employees is provided only under an Advanced 
Service Package License relating specifically to this Proprietary Material. This is a different agreement 
from the one under which operating and basic service software is licensed. A license to use operating 
or basic service software does not extend to or cover this software or related documentation.

If you are a GE Medical Systems employee or a customer who has entered into such a license 
agreement with GE Medical Systems to use this proprietary software, you are authorized to use this 
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Chapter 1
Introduction

Section 1-1
Overview

1-1-1 Purpose of Chapter 1
This Chapter describes important issues related to safety servicing this ultrasound machine. The 
service provider must read and understand all the information presented here before installing or 
servicing a unit.

1-1-2 Chapter Contents

1-1-3 Purpose of Service Manual
This manual provides service information on the LOGIQ™ 7 Ultrasound Scanning System. It contains 
the following chapters:

1.) Chapter 1, Introduction: Contains a content summary and warnings.
2.) Chapter 2, Pre-Installation: Contains any pre-installation requirements for the LOGIQ™ 7.
3.) Chapter 3, Installation: Contains the LOGIQ™ 7 installation procedure with installation 

checklist.
4.) Chapter 4, Functional Checks: Contains functional checks that must be performed as part of 

the installation, or as required during servicing and periodic maintenance.
5.) Chapter 5 Theory: Contains block diagrams and functional explanations of the LOGIQ™ 7 

electronics.
6.) Chapter 6, Service Adjustments: Contains instructions on how to make any available 

adjustments to the LOGIQ™ 7.
7.) Chapter 7, Diagnostics/Trouble Shooting: Provides procedures for running and diagnostic 

or related routines for the LOGIQ™ 7.
8.) Chapter 8, Replacement Procedures: Provides disassembly procedures and reassembly 

procedures for all changeable FRU.
9.) Chapter 9, Renewal Parts: Contains a complete list of replacement parts for the LOGIQ™ 7.
10.)Chapter 10, Periodic Maintenance: Provides periodic maintenance procedures for the 

LOGIQ™ 7.

Table 1-1   Contents in Chapter 1

Section Description Page Number

1-1 Overview 1-1

1-2 Important Conventions 1-5

1-3 Safety Considerations 1-10

1-4 EMC, EMI, and ESD 1-21

1-5 Customer Assistance 1-22
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1-1-4 Typical Users of the Basic Service Manual
• Service Personnel (installation, maintenance, etc.).
• Hospital’s Service Personnel
• Architects (Some parts of Chapter 2 - Pre-Installation)

1-1-5 LOGIQ™ 7 Models Covered by this Manual

Table 1-2   LOGIQ™ 7 Model Designations

Part Number Description Reference Remarks

2287317 LOGIQ™ 7 100V / NTSC Console and Peripherals BT01

2304806 LOGIQ™ 7 120V / NTSC Console and Peripherals BT01

2304807 LOGIQ™ 7 220V / PAL Console and Peripherals BT01

2304808 LOGIQ™ 7 220V / NTSC Console and Peripherals BT01

2354857 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style B/Ver2) BT02

2354858 LOGIQ™ 7 120V / NTSC Console and Peripherals (Style B/Ver2) BT02

2354859 LOGIQ™ 7 220V / PAL Console and Peripherals (Style B/Ver2) BT02

2354860 LOGIQ™ 7 220V / NTSC Console and Peripherals (Style B/Ver2) BT02

2355589 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style B/Ver2) BT02

2389221 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style C/Ver3) BT03

2389220 LOGIQ™ 7 120V / NTSC Console and Peripherals (Style C/Ver3) BT03

2389219 LOGIQ™ 7 220V / PAL Console and Peripherals (Style C/Ver3) BT03

2389218 LOGIQ™ 7 220V / NTSC Console and Peripherals (Style C/Ver3) BT03

2389217 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style C/Ver3) BT03

5118055 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style D/Ver4) BT04

5118056 LOGIQ™ 7 120V / NTSC Console and Peripherals (Style D/Ver4) BT04

5118057 LOGIQ™ 7 220V / PAL Console and Peripherals (Style D/Ver4) BT04

5118058 LOGIQ™ 7 220V / NTSC Console and Peripherals (Style D/Ver4) BT04

5118059 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style D/Ver4) BT04

5148047 LOGIQ™ 7 100V / NTSC Console and Peripherals, CRT monitor (Style E) BT06 CRT

5148048 LOGIQ™ 7 120V / NTSC Console and Peripherals, CRT monitor (Style E) BT06 CRT

5148049 LOGIQ™ 7 220V / PAL Console and Peripherals, CRT monitor (Style E) BT06 CRT

5148050 LOGIQ™ 7 220V / NTSC Console and Peripherals, CRT monitor (Style E) BT06 CRT

5148052 LOGIQ™ 7 100V / NTSC Console and Peripherals, LCD monitor (Style E) BT06 LCD

5148053 LOGIQ™ 7 120V / NTSC Console and Peripherals, LCD monitor (Style E) BT06 LCD

5148054 LOGIQ™ 7 220V / PAL Console and Peripherals, LCD monitor (Style E) BT06 LCD

5148055 LOGIQ™ 7 220V / NTSC Console and Peripherals, LCD monitor (Style E) BT06 LCD

5148057 LOGIQ™ 7PRO 100V / NTSC Console and Peripherals (Style E) BT06 PRO
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5148058 LOGIQ™ 7PRO 120V / NTSC Console and Peripherals (Style E) BT06 PRO

5148059 LOGIQ™ 7PRO 220V / PAL Console and Peripherals (Style E) BT06 PRO

5148060 LOGIQ™ 7 220V / NTSC Console and Peripherals (Style E) BT06 PRO

5176232 LOGIQ™ 7 100V / NTSC Console and Peripherals, CRT monitor BT06-2 CRT

BT06 New 
Hardware - 

requires 
software R6.2.x 

or later

5176567 LOGIQ™ 7 120V / NTSC Console and Peripherals, CRT monitor BT06-2 CRT

5176948 LOGIQ™ 7 220V / PAL Console and Peripherals, CRT monitor BT06-2 CRT

5176508 LOGIQ™ 7 220V / NTSC Console and Peripherals, CRT monitor BT06-2 CRT

5176713 LOGIQ™ 7 100V / NTSC Console and Peripherals, LCD monitor BT06-2 LCD

5176888 LOGIQ™ 7 120V / NTSC Console and Peripherals, LCD monitor BT06-2 LCD

5176300 LOGIQ™ 7 220V / PAL Console and Peripherals, LCD monitor BT06-2 LCD

5176380 LOGIQ™ 7 220V / NTSC Console and Peripherals, LCD monitor BT06-2 LCD

5176619 LOGIQ™ 7PRO 100V / NTSC Console and Peripherals BT06-2 PRO

5176454 LOGIQ™ 7PRO 120V / NTSC Console and Peripherals BT06-2 PRO

5176439 LOGIQ™ 7PRO 220V / PAL Console and Peripherals BT06-2 PRO

5176774 LOGIQ™ 7 220V / NTSC Console and Peripherals BT06-2 PRO

5179605 LOGIQ™ 7PRO 220V / PAL Console and Peripherals, LCD monitor BT06-2 CONSIP SOI (BT06-2 
PRO with LCD)

5183269 LOGIQ™ 7 100V / NTSC Console and Peripherals, CRT monitor V65x CRT

5183237 LOGIQ™ 7 120V / NTSC Console and Peripherals, CRT monitor V65x CRT

5183396 LOGIQ™ 7 220V / PAL Console and Peripherals, CRT monitor V65x CRT

5183304 LOGIQ™ 7 220V / NTSC Console and Peripherals, CRT monitor V65x CRT

5183330 LOGIQ™ 7 100V / NTSC Console and Peripherals, LCD monitor V65x LCD

5183410 LOGIQ™ 7 120V / NTSC Console and Peripherals, LCD monitor V65x LCD

5183412 LOGIQ™ 7 220V / PAL Console and Peripherals, LCD monitor V65x LCD

5183190 LOGIQ™ 7 220V / NTSC Console and Peripherals, LCD monitor V65x LCD

5183352 LOGIQ™ 7PRO 100V / NTSC Console and Peripherals V65x PRO

5183136 LOGIQ™ 7PRO 120V / NTSC Console and Peripherals V65x PRO

5183125 LOGIQ™ 7PRO 220V / PAL Console and Peripherals V65x PRO

5183515 LOGIQ™ 7PRO 220V / NTSC Console and Peripherals V65x PRO

5191090 LOGIQ™ 7 100V / NTSC Console and Peripherals, CRT monitor (Style H) BT07 CRT

5191824 LOGIQ™ 7 120V / NTSC Console and Peripherals, CRT monitor (Style H) BT07 CRT

5191341 LOGIQ™ 7 220V / PAL Console and Peripherals, CRT monitor (Style H) BT07 CRT

5191701 LOGIQ™ 7 220V / NTSC Console and Peripherals, CRT monitor (Style H) BT07 CRT

5191499 LOGIQ™ 7 100V / NTSC Console and Peripherals, LCD monitor (Style H) BT07 LCD

5191946 LOGIQ™ 7 120V / NTSC Console and Peripherals, LCD monitor (Style H) BT07 LCD

Table 1-2   LOGIQ™ 7 Model Designations

Part Number Description Reference Remarks
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1-1-6 Purpose of Operator Manual(s)
The Operator Manual(s) should be fully read and understood before operating the LOGIQ™ 7 and also 
kept near the unit for quick reference.

5191853 LOGIQ™ 7 220V / PAL Console and Peripherals, LCD monitor (Style H) BT07 LCD

5191441 LOGIQ™ 7 220V / NTSC Console and Peripherals, LCD monitor (Style H) BT07 LCD

5191006 LOGIQ™ 7 100V / NTSC Console and Peripherals (Style H) BT07 PRO

5191258 LOGIQ™ 7 120V / NTSC Console and Peripherals (Style H) BT07 PRO

5191436 LOGIQ™ 7 220V / PAL Console and Peripherals (Style H) BT07 PRO

5191259 LOGIQ™ 7 220V / NTSC Console and Peripherals (Style H) BT07 PRO

5244924 LOGIQ™ 7 100V / NTSC Console and Peripherals, LCD monitor (Style I) R7.5.x LCD

5244925 LOGIQ™ 7 120V / NTSC Console and Peripherals, LCD monitor (Style I) R7.5.x LCD

5244926 LOGIQ™ 7 220V / PAL Console and Peripherals, LCD monitor (Style I) R7.5.x LCD

5244927 LOGIQ™ 7 220V / NTSC Console and Peripherals, LCD monitor (Style I) R7.5.x LCD

5309921 LOGIQ™ 7 LCD, 100V, 60Hz, NTSC, Japan BT09 BEP4 Intro

5309922 LOGIQ™ 7 LCD, 120V, 60Hz, NTSC BT09 BEP4 Intro

5309923 LOGIQ™ 7 LCD, 220V, 50Hz, PAL BT09 BEP4 Intro

5309924 LOGIQ™ 7 LCD, 220V, 60Hz, NTSC, Asia BT09 BEP4 Intro

Table 1-2   LOGIQ™ 7 Model Designations

Part Number Description Reference Remarks
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Section 1-2
Important Conventions

1-2-1 Conventions Used in Book
Model Designations.

This manual covers the LOGIQ™ 7scanners.

Icons.

Pictures, or icons, are used wherever they will reinforce the printed message. The icons, labels and 
conventions used on the product and in the service information are described in this chapter.

Safety Precaution Messages.

Various levels of safety precaution messages may be found on the equipment and in the service 
information. The different levels of concern are identified by a flag word that precedes the precautionary 
message. Known or potential hazards are labeled in one of three ways:

NOTE: Notes are used to provide important information about an item or a procedure. Be sure to read 
the notes; the information contained in a note can often save you time or effort.

DANGER DANGER IS USED TO INDICATE THE PRESENCE OF A HAZARD THAT WILL 
CAUSE SEVERE PERSONAL INJURY OR DEATH IF THE INSTRUCTIONS ARE 
IGNORED.

WARNINGWARNING WARNING IS USED TO INDICATE THE PRESENCE OF A HAZARD THAT CAN CAUSE 
SEVERE PERSONAL INJURY OR PROPERTY DAMAGE IF INSTRUCTIONS ARE 
IGNORED.

CAUTION Caution is used to indicate the presence of a hazard that will or can cause minor personal injury 
and property damage if instructions are ignored.

NOTICE Equipment Damage Possible
Notice is used when a hazard is present that can cause property damage but has absolutely no personal 
injury risk.
Example: Disk Drive will crash.
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1-2-2 Standard Hazard Icons
Important Information will always be preceded by the exclamation point contained within a triangle, as 
seen throughout this chapter. In addition to text, several different graphical icons (symbols) may be used 
to make you aware of specific types of hazards that could possibly cause harm.

Some others make you aware of specific procedures that should be followed.

Some others make you aware of specific procedures that should be followed.

Table 1-3    Standard Hazard Icons

ELECTRICAL MECHANICAL RADIATION

LASER HEAT PINCH

Table 1-4    Standard Icons that indicates that a special procedure is to be used

AVOID STATIC ELECTRICITY TAG AND LOCK OUT WEAR EYE PROTECTION

LASER
LIGHT

Signed Date

TAG 
& 

LOCKOUT EYE
PROTECTION
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1-2-3 Product Icons
The following table describes the purpose and location of safety labels and other important information 
provided on the equipment.

Table 1-5   Warnings

Label/Symbol Purpose/Meaning Location Note

Identification and Rating Plate

Manufacturer's name and address
Date of manufacture
Model and serial numbers
Electrical ratings

Rear of console near power inlet

Type/Class Label Used to indicate the degree of safety 
or protection.

IP Code (IPX8)

Indicates the degree of protection 
provided by the enclosure per IEC60 
529. IPX8 indicates can be used in 
operating room environment.

Footswitch

Equipment Type BF (man in the box 
symbol) IEC 60878-02-03 indicates B 
Type equipment having a floating 
applied part.

Probe connectors and PCG 
connector

Equipment Type CF (heart in the box 
symbol) IEC 878-02-05 indicates 
equipment having a floating applied 
part having a degree of protection 
suitable for direct cardiac contact.

ECG connector and Probes marked 
Type CF

Device Listing/Certification Labels
Laboratory logo or labels denoting 
conformance with industry safety 
standards such as UL or IEC.

Rear of console

CAUTION - This unit weighs...Special 
care must be used to avoid...”

This precaution is intended to prevent 
injury that may result if one person 
attempt to move the unit considerable 
distances or on an incline due to the 
weight of the unit.

On the console where easily seen 
during transport

“DANGER - Risk of explosion 
used in...”

The system is not designed for use 
with flammable anesthetic gases. Rear of console

“CAUTION” The equilateral triangle is 
usually used in combination with 
other symbols to advise or warn the 
user.

Various

ATTENTION - Consult accompanying 
documents is intended to alert the 
user to refer to the operator manual or 
other instructions when complete 
information cannot be provided on the 
label.

Various
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“General Warning Sign” Rear panel and UPS battery BT07 or later

“Warning” - Dangerous voltage” (the 
lightning flash with arrowhead) is 
used to indicate electric shock 
hazards.

Rear panel and inside of console BT07 or later

“Mains OFF” Indicates the power off 
position of the mains power switch.

Rear of system adjacent to mains 
switch

“Mains ON” indicates the power on 
position of the mains power switch.

Rear of system adjustment to mains 
switch

“ON” indicates the power on position 
of the power switch.
CAUTION
This Power Switch DOES NOT 
ISOLATE Mains Supply
“Standby” indicates the power stand 
by position of the power switch.
CAUTION
This Power Switch DOES NOT 
ISOLATE Mains Supply

Adjacent to On/Standby Switch

“Protective Earth” Indicates the 
protective earth (grounding) terminal. Various

“Equipotentiality” Indicates the 
terminal to be used for connecting 
equipotential conductors when 
interconnecting (grounding) with 
other equipment.

Rear of console

Alternating Current symbol is in 
accordance with IEC 60878-01-14.

Rear Panel, Rating Plate, Circuit 
breaker label of console and front 
panel (if applicable).

BT07 or later

This symbol indicates that waste 
electrical and electronic equipment 
must not be disposed of as unsorted 
municipal waste and must be 
collected separately. Please contact 
an authorized representative of the 
manufacturer for information 
concerning the decommissioning of 
your equipment.

Rear Panel BT07 or later

Table 1-5   Warnings

Label/Symbol Purpose/Meaning Location Note
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Indicates the presence of hazardous 
substance(s) above the maximum 
concentration value. Maximum 
concentration values for electronic 
information products, as set by the 
People’s Republic of China 
Electronic Industry Standard SJ/
T11364-2006, include the hazardous 
substances of lead, mercury, 
hexavalent chromium, cadmium, 
polybrominated biphenyl (PBB), and 
polybrominated diphenyl ether 
(PBDE). “10” indicates the number of 
years during which the hazardous 
substance(s) will not leak or mutate 
so that the use of this product will not 
result in any severe environmental 
pollution, bodily injury, or damage to 
any assets.

Probe BT07 or later

Indicates the presence of hazardous 
substance(s) above the maximum 
concentration value. Maximum 
concentration values for electronic 
information products, as set by the 
People’s Republic of China 
Electronic Industry Standard SJ/
T11364-2006, include the hazardous 
substances of lead, mercury, 
hexavalent chromium, cadmium, 
polybrominated biphenyl (PBB), and 
polybrominated diphenyl ether 
(PBDE). “20” indicates the number of 
years during which the hazardous 
substance(s) will not leak or mutate 
so that the use of this product will not 
result in any severe environmental 
pollution, bodily injury, or damage to 
any assets. 

Rear Panel, China Rating Plate BT07 or later

Do not use the following devices near 
this equipment: cellular phone, radio 
receiver, mobile radio transmitter, 
radio controlled toy, broadband 
power lines, etc. Use of these 
devices near this equipment could 
cause this equipment to perform 
outside the published specifications. 
Keep power to these devices turned 
off when near this equipment.

Rear Panel BT07 or later

Table 1-5   Warnings

Label/Symbol Purpose/Meaning Location Note
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Section 1-3
Safety Considerations

1-3-1 Introduction
The following safety precautions must be observed during all phases of operation, service and repair of 
this equipment. Failure to comply with these precautions or with specific warnings elsewhere in this 
manual, violates safety standards of design, manufacture and intended use of the equipment.

1-3-2 Human Safety
Operating personnel must not remove the system covers.

Servicing should be performed by authorized personnel only.

Only personnel who have participated in a LOGIQ™ 7Training Seminar are authorized to service the 
equipment.

1-3-3 Mechanical Safety

NOTE: Special Care should be taken when transporting the unit in a vehicle:

• Secure the unit in an upright position.
• Lock the wheels (brake).
• DO NOT use the Control Panel as an anchor point.
• Place the probes in the carrying case.
• Eject any Magnet Optical disk from the MO Drive (if installed).

WARNINGWARNING WHEN THE UNIT IS RAISED FOR A REPAIR OR MOVED ALONG ANY INCLINE, USE 
EXTREME CAUTION SINCE IT MAY BECAUSE UNSTABLE AND TIP OVER.

WARNINGWARNING ULTRASOUND PROBES ARE HIGHLY SENSITIVE MEDICAL INSTRUMENTS THAT CAN 
EASILY BE DAMAGED BY IMPROPER HANDLING. USE CARE WHEN HANDLING AND 
PROTECT FROM DAMAGE WHEN NOT IN USE. DO NOT USE A DAMAGED OR 
DEFECTIVE PROBE. FAILURE TO FOLLOW THESE PRECAUTIONS CAN RESULT IN 
SERIOUS INJURY AND EQUIPMENT DAMAGE.

WARNINGWARNING NEVER USE A PROBE THAT HAS FALLEN TO THE FLOOR. EVEN IF IT LOOKS OK, IT 
MAY BE DAMAGED.

CAUTION Always lock the Control Console in its parking (locked) position before moving the scanner 
around.

CAUTION Disconnect all probes before moving the scanner around.

CAUTION The LOGIQ™ 7 weights 225 kg or more, depending on installed peripherals, (496 lbs, or more) 
when ready for use. Care must be used when moving it or replacing its parts. Failure to follow 
the precautions listed below could result in injury, uncontrolled motion and costly damage.
ALWAYS:
• Be sure the path way is clear.
• Use slow, careful motions.
• Use two people when moving on inclines or lifting more than 23 kg (50 lb).
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1-3-4 Electrical Safety
To minimize shock hazard, the equipment chassis must be connected to an electrical ground. The 
system is equipped with a three-conductor AC power cable. This must be plugged into an approved 
electrical outlet with safety ground. If an extension cord is used with the system, make sure that the total 
current rating of the system does not exceed the extension cord rating.

The power outlet used for this equipment should not be shared with other types of equipment.

Both the system power cable and the power connector meet international electrical standards.
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1-3-5 Label Locations (For BT07 or later, including R7.5.x)

NOTE: For the symbols shown in the illustration below, refer to previous pages in this chapter.

Figure 1-1 OUTSIDE MARKINGS OF LOGIQ™ 7 For BT07 
or later, including R7.5.x (Back Side)

100-120V～

Japan/USA/Asia Console(100V)

(9)
(10)

(11)

(8)

(2)

(1) 

(3) 

(4) 

(6) 

(7) 

220-240V～

GE Yokogawa Medical Systems

ETL LISTED

CONFORMS TO
UL STD. 2601-1

4 6 4 7 7

R

ETL TESTING LABORATORIES INC.
CORTLAND, NEW YORK 13043

L I S TE D RL I S TE D

CERTIFIED TO
CAN/CSA C22.2 NO. 601.1

C

~

(5) 

(12)

(13)

(14) (15)

(16)

(17)

(18)

(21)

Except for R7.5.x

Label for China

(2)

(1) 

(3) 

(6) 

(7) 

(5) 

CAUTION

CAUTION

LCD model ONLY



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 1-2 - Important Conventions 1-13

1-3-5 Label Locations (For BT07 or later, including R7.5.x) (cont’d)

1.) Possible Shock Hazard
2.) Caution for devices near by the equipment
3.) Caution for Transportation
4.) Prescription Devices (For USA Only)
5.) CE Marking of conformity
6.) WEEE mark
7.) CISPR
8.) Voltage Range
9.) Signal Ground Point Label
10.)Power Indication Label
11.)Caution for Grounding Reliability (For USA, Canada and Japan)
12.)ETL Label
13.)Identification and Rating Plate (USA/Asia 120V console)
14.)Identification and Rating Plate (Europe/Asia/USA 220V console)
15.)Identification and Rating Plate (Jpan 100V console)
16.)Identification and Rating Plate (China)
17.)Label that indicates the presence of hazardous substance(s) above the maximum 

concentration value.
18.)Identification and Rating Plate (Korean)
19.)Caution label on the monitor
20.)Caution label for the range of motion
21.)This machine should be used in compliance with law. Some jurisdictions restrict certain uses, 

such as gender determination. - Korea Console
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1-3-6 Label Locations (For BT04, BT06, and V65x)

NOTE: For the symbols shown in the illustration below, refer to previous pages in this chapter.

1.) Possible Shock Hazard
2.) Caution for devices near by the equipment
3.) Caution for Transportation
4.) Prescription Devices (For USA Only)
5.) CE Marking of conformity and WEEE mark
6.) CISPR
7.) Voltage Range
8.) Signal Ground Point Label
9.) Power Indication Label
10.)Caution for Grounding Reliability (For USA, Canada and Japan)

Figure 1-2 OUTSIDE MARKINGS OF LOGIQ™ 7 For BT04 
or later (Back Side)

1.

3.2.

4.

5.

6.

79.

8.
7.

10.
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1-3-6 Label Locations (For BT04, BT06, and V65x) (cont’d)

1.) ETL Label
2.) Identification and Rating Plate
3.) SFDA or SDA Label (For China ONLY)

Figure 1-3   OUTSIDE MARKINGS OF LOGIQ™ 7 For BT04 
or later

~

China 220V Con
(Right Side)

2.

1.

3.
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1-3-7 Label Locations (For BT03 or lower)

NOTE: For the symbols shown in the illustration below, refer to previous pages in this chapter.

1.) Possible Shock Hazard
2.) Caution for devices near by the equipment
3.) Caution for Transportation
4.) Prescription Devices (For USA Only)
5.) CE Marking of conformity
6.) CISPR
7.) Voltage Range
8.) Signal Ground Point Label
9.) Power Indication Label
10.)Caution for Grounding Reliability (For USA, Canada and Japan)

Figure 1-4 OUTSIDE MARKINGS OF LOGIQ™ 7 For BT03 
or lower (Back Side)

1.

3.2.

4.

5.

6.

10.

9.

8.

7.
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1-3-7 Label Locations (For BT03 or lower) (cont’d)

1.) ETL Label
2.) Identification and Rating Plate
3.) SDA Label (For China ONLY)

Figure 1-5   OUTSIDE MARKINGS OF LOGIQ™ 7 For BT03 
or lower (Left Side)

~

China 220V Console 
(Right Side)

2.

1.

3.
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1-3-8 Dangerous Procedure Warnings
Warnings, such as the example below, precede potentially dangerous procedures through our this 
manual. Instructions contained in the warnings must be followed.

1-3-9 Lockout/Tagout Requirements (For USA Only)
Follow OSHA Lockout/Tagout requirements by ensuring you are in total control of the electrical Mains 
plug.

1-3-10 Returning/Shipping Probes and Repair Parts
Equipment being returned must be clean and free of blood and other infectious substances.

GEMS policy states that body fluids must be properly removed from any part or equipment prior to 
shipment. GEMS employees, as well as customers, are responsible for ensuring that parts/equipment 
have been properly decontaminated prior to shipment. Under no circumstance should a part or 
equipment with visible body fluids be taken or shipped from a clinic or site (for example, body coils or 
an ultrasound probe).

The purpose of the regulation is to protect employees in the transportation industry, as well as the 
people who will receive or open this package.

NOTE: The US Department of Transportation (DOT) has ruled that “items that were saturated and/or 
dripping with human blood that are now caked with dried blood; or which were used or intended 
for use in patient care” are “regulated medical waste” for transportation purposes and must be 
transported as a hazardous material.

DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN 
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND 
ADJUSTING.

WARNINGWARNING EXPLOSION WARNING: DO NOT OPERATE THE EQUIPMENT IN AN EXPLOSIVE 
ATMOSPHERE. OPERATION OF ANY ELECTRICAL EQUIPMENT IN SUCH AN 
ENVIRONMENT CONSTITUTES A DEFINITE SAFETY HAZARD.

WARNINGWARNING DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT: BECAUSE OF THE DANGER 
OF INTERDICTING ADDITIONAL HAZARDS, DO NOT INSTALL SUBSTITUTE PARTS OR 
PERFORM ANY UNAUTHORIZED MODIFICATION OF THE EQUIPMENT.

NOTICE Energy Control and Power Lockout for LOGIQ™ 7
When servicing parts of the system where there is exposure to voltage greater than 30 Volts:
Unplug the system
Maintain control of the system power plug
There are no test points to verify isolation, you must wait for at least 20 seconds for capacitors to 
discharge
Beware that the AC Control Box, Front End Processor and Back End Processor may be energized even 
if the power is turned off when the cord is still plugged into the AC Outlet.
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1-3-11 How to remove the Ghost CD-ROM
The Ghost CD-ROM (Base System Software Load Image CD-ROM) is mounted on the PC-BOX inside 
the scanner using velcro tapes. The upper side of the PC-BOX cover contains sharp edge causing a FE 
to have possibility of cutting his hand if he removes the CD-ROM with the PC-BOX cover closed.

Figure 1-6   How to Remove Ghost CD-ROM

Ghost CD-ROM

Sharp Edge PC-BOX Cover

NG: WITH PC BOX COVER CLOSED

OK: WITH PC BOX COVER OPEN

PC-BOX Cover

Do NOT remove the Ghost CD-ROM
when the PC-Box cover is closed.

For BT04 or later CD-ROMs
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1-3-11 How to remove the Ghost CD-ROM (cont’d)

The sharp edge of the PC Box Cover are chamfered before shipment. However, the Ghost CD-ROM 
must be removed with the PC-Box cover open according to the following steps.

1.) Disconnect the DVI-D connector, then remove the four mounting bolts (three hex bolts and one 
phillips screw).

2.) Open the PC box cover and remove the Ghost CD-ROM from the PC box.
Figure 1-7   Removing Bolts

Figure 1-8   Removing Ghost CD-ROM

Hex boltsPC Box CoverHex bolt Phillips screw

DVI-D connector

PC Box Cover

Open

Ghost CD-ROM
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Section 1-4
EMC, EMI, and ESD

1-4-1 Electromagnetic Compatibility
Electro Magnetic Compatibility describes a level of performance of a device within its electromagnetic 
environment. This environment consists of the device itself and its surroundings including other 
equipment, power sources and persons with which the device must interface. Inadequate compatibility 
results when a susceptible device fails to perform as intended due interface from its environment or 
when the device produces unacceptable levels of mission to its environment. This interface is often 
referred to as radio-frequency or electromagnetic interface (RFI/EMI) and can be radiated through 
space or conducted over interconnecting power of signal cables. In addition to electromagnetic energy, 
EMC also includes possible effects from electrical fields, magnetic fields, electrostatic discharge and 
disturbances in the electrical power supply.

1-4-2 Electrostatic Discharge (ESD) Prevention

1-4-3 CE Compliance
The LOGIQ™ 7 unit conforms to all applicable conducted and radiated emission limits and immunity 
from electrostatic discharge, radiated and conducted RF fields, magnetic fields and power line transient 
requirements.

Applicable standards are: 47CFR Part18, IEC60601-1-2, and 806-13.

NOTE: For CE Compliance, it is critical that all covers, screws, shielding, gaskets, mesh, clamps, are 
in good condition, installed tightly without skew or stress. Proper installation following all 
comments noted in this service manual is required in order to achieve full EMC performance.

WARNINGWARNING DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE 
NECESSARY ESD PRECAUTIONS:
1.) Always connect yourself, via an arm-wrist strap, to the dedicated ground 

point located on the rear of the scanner (to the left of the power 
connector) or a proper frame ground.

2.) Follow general guide lined for handling of electrostatic sensitive 
equipment.
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Section 1-5
Customer Assistance

This system is not repairable by the customer. If this equipment does not work as indicated in the 
Operator Manual, please contact your service support center. If the service engineer needs additional 
information to repair this equipment, please contact the following address (The necessary information 
will be provided to the Service Engineer as needed).

1-5-1 System Manufacture

1-5-2 Contact Information
For GE Service: 

Table 1-6 System Manufacture

GE YOKOGAWA MEDICAL SYSTEMS

4-7-127 Asahigaoka, Hino-shi, Tokyo, 191-8503
JAPAN

Table 1-7 Phone Numbers for Customer Assistance

Location Phone Number

USA/ Canada
GE Medical Systems
Ultrasound Service Engineering
4855 W. Electric Avenue
Milwaukee, WI 53219

Customer Answer Center

Tel: 1-800-321-7937

1-800-682-5327
1-262-524-5698
Fax: +1-414-647-4125

Latin America
GE Medical Systems
Ultrasound Service Engineering
4855 W. Electric Avenue
Milwaukee, WI 53219

Customer Answer Center

Tel: 1-262-524-5300

1-262-524-5698
Fax: +1-414-647-4125

Europe
GE Ultraschall Deutschland GmbH& Co. KG
BeethovenstraBe 239
Postfach 11 05 60, D-42655 Solingen
Germany

Tel:
+33 0 130 831 300 - CARDIAC
+33 0 130 831 300 - GENERAL IMAGING
Fax: +49 212 2802 431

Asia (Singapore)
GE Ultrasound Asia
Service Department - Ultrasound
298 Tiong Bahru Road #15-01/06
Central Plaza
Singapore 169730

Tel: +65-6277-3512

Fax: +65 6272-3997

ASIA (Japan) +65-277-3512
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1-5-2 Contact Information (cont’d)

NOTE: If this equipment does not work as indicated in the Operator Manual(s), contact your support 
center. Have the system ID number available when you call.
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Chapter 2
Pre Installation

Section 2-1
Overview

2-1-1 Purpose of this chapter 2
This chapter provides the information required to plan and prepare for the installation of a LOGIQ™ 7. 
Included are descriptions of the facility and electrical needs to be met by the purchaser of the unit. A 
checklist is also provided at the end of this section to help determine whether the proper planning and 
preparation is accomplished before the actual equipment installation is scheduled.

Table 2-1   Contents in Chapter 2

Section Description Page Number

2-1 Overview 2-1

2-2 General Console Requirements 2-2

2-3 Facility Needs 2-7
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Section 2-2
General Console Requirements

2-2-1 Console Environmental Requirements 

2-2-1-1 Cooling
The cooling requirement for the LOGIQ™ 7 is 3500 BTU/hr. This figure does not include cooling needed 
for lights, people, or other equipment in the room. Each person in the room places an additional 300 
BTU/hr. demand on the cooling system.

2-2-1-2 Lighting
Bright light is needed for system installation, updates and repairs. However, operator and patient 
comfort may be optimized if the room light is subdued and indirect. Therefore a combination lighting 
system (dim/bright) is recommended. Keep in mind that lighting controls and diameters can be a source 
of EMI which could degrade image quality. These controls should be selected to minimize possible 
interface.

Table 2-2   Environmental Requirements for LOGIQ™ 7 Scanners

Operational Storage Transport

Temperature 10 - 35 oC
50 - 95 oF

-10 - 50 oC
14 - 122oF

-10 - 50 oC
14 - 122 oF

Humidity 30 - 80%
non-condensing

30 - 80%
non-condensing

30 - 80%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

Table 2-3   Environmental Requirements for an Ultrasound Room

Item Values

Power Source Refer to Table 2-4 on page 2-3.

Current Rating 20A (120V, 100V); 7.5A (220-240V) CIRCUIT BREAKER

Radiation Shielding NONE REQUIRED for ULTRASOUND ENERGY

Temperature 20-26 DEG. C (68-79 DEG F) for PATIENT COMFORT

Humidity 50% to 70% for PATIENT COMFORT

Heat Dissipation 3500 BTU/Hr. 

Floor Landing  Approximately 680 - 800 kg/m2 without Accessories

Floor Condition Gradient: WITHIN 5 degrees

Weight Approximately 225 kg (496lbs)   without Accessories
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2-2-2 Electrical Requirements

2-2-2-1 Electrical Requirements

NOTE: GE Medical Systems requires a dedicated power and ground for the proper operation of its 
Ultrasound equipment. This dedicated power shall originate at the last distribution panel before 
the system. 

Sites with a mains power system with defined Neutral and Line:
The dedicated line shall consist of one phase, a neutral (not shared with any other circuit), and 
a full size ground wire from the distribution panel to the Ultrasound outlet. 

Sites with a mains power system without a defined Neutral:
The dedicated line shall consist of one phase (two lines), not shared with any other circuit, and 
a full size ground wire from the distribution panel to the Ultrasound outlet. 

Please note that image artifacts can occur, if at any time within the facility, the ground from the 
main facility's incoming power source to the Ultrasound unit is only a conduit.

2-2-2-2 LOGIQ™ 7 Power Requirements
The following power line parameters should be monitored for one week before installation. We 
recommend that you use an analyzer Dranetz Model 606-3 or Dranetz Model 626:

2-2-2-3 Inrush Current
Inrush Current is not a factor to consider due to the inrush current limiting properties of the power 
supplies.

2-2-2-4 Site Circuit Breaker
It is recommended that the branch circuit breaker for the machine be ready accessible.

Table 2-4   Electrical Specifications for LOGIQ™ 7

PARAMETER AREA LIMITS

Voltage Range

100V 100 VAC ±10% (90-110 VAC)

220V 220-240 VAC ±10% (198-264 VAC)

120V 120 VAC ±10% (108-132 VAC)

Power All applications MAX. 1200 VA

Line Frequency All applications 50/60Hz (±2Hz)

Power Transients All applications

Less than 25% of nominal peak 
voltage for less than 1 millisecond for 
any type of transient, including line 
frequency, synchronous, 
asynchronous, or aperiodic 
transients.

Decaying Oscillation All applications Less than 15% of peak voltage for 
less than 1 millisecond.

CAUTION POWER OUTAGE MAY OCCURE. The LOGIQ™ 7 requires a dedicated single branch circuit. To 
avoid circuit overload and possible loss of critical care equipment, make sure you DO NOT have 
any other equipment operating on the same circuit.
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2-2-2-5 Site Power Outlets
A desiccated AC power outlet must be within reach of the unit without extension cords. Other outlets 
adequate for the external peripherals, medical and test equipment needed to support this unit must also 
be present within 1 m (3.2 ft.) of the unit. Electrical installation must meet all current local, state, and 
national electrical codes.

2-2-2-6 Unit Power Plug
If the unit arrives without the power plug, or with the wrong plug, you must contact your GE dealer or 
the installation engineer must supply what is locally required.

2-2-2-7 Power Stability Requirements
Voltage drop-out
Max 10 ms.

Power Transients
Refer Table
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2-2-3  EMI Limitations
Ultrasound machines are susceptible to Electromagnetic Interference (EMI) from radio frequencies, 
magnetic fields, and transient in the air wiring. They also generate EMI. The LOGIQ™ 7 complies with 
limits as stated on the EMC label. However there is no guarantee that interface will not occur in a 
particular installation.

Possible EMI sources should be identified before the unit is installed.

Electrical and electronic equipment may produce EMI unintentionally as the result of defect.

These sources include:

• medical lasers,
• scanners,
• cauterizing guns,
• computers,
• monitors,
• fans,
• gel warmers,
• microwave ovens,
• light dimmers,
• portable phones.
The presence of broadcast station or broadcast van may also cause interference. See for EMI 
Prevention tips.

Table 2-5   EMI Prevention/abatement

EMI Rule Details

Be aware of RF sources
Keep the unit at least 5 meters or 15 feet away from other EMI sources. Special shielding 
may be required to eliminate interference problems caused by high frequency, high 
powered radio or video broadcast signals.

Ground the unit Poor grounding is the most likely reason a unit will have noisy images. Check grounding 
of the power cord and power outlet.

Replace all screws, RF 
gaskets, covers, cores

After you finish repairing or updating the system, replace all covers and tighten all 
screws. Any cable with an external connection requires a magnet wrap at each end. 
Install the shield over the front of card cage. Loose or missing covers or RF gaskets allow 
radio frequencies to interface with the ultrasound signals.

Replace broken RF gaskets If more than 20% or a pair of fingers on the RF gaskets are broken, replace the gaskets. 
Do not turn on the unit until any loose metallic part is removed.

Do not place labels where 
RF gaskets touch metal

Never place a label where RF gaskets meet the unit. Otherwise, the gap created will 
permit RF leakage. Or, if a label has been found in such a position, move the label.

Use GE specified 
harnesses and peripherals

The interconnect cables are grounded and require ferrite beads and other shielding. 
Also, cable length, material, and routing are all important; do not change from what is 
specified.

Take care with cellular 
phones Cellular phones may transmit a 5 V/m signal; that could cause image artifacts.

Properly dress peripheral 
cables

Do not allow cables to lie across the top of the card cage or hang out of the peripheral 
bays. Loop the excess length for peripheral cables inside the peripheral bays. Attach the 
monitor cables to the frame.
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2-2-4 Probes Environmental Requirements

Table 2-6   Operation and storage Temperatures for 2D Probes

Operational Storage Transport

Temperature 10 - 40 oC
50 - 104 oF

-10 - 60 oC
14 - 140oF

-40 - 60 oC
-40 - 140 oF

Humidity 30 - 85%
non-condensing

30 - 90%
non-condensing

30 - 90%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

Table 2-7   Operation and storage Temperatures for 4D Probes

Operational Storage Transport

Temperature 18 - 30 oC
64- 86 oF

-10 - 50 oC
14 - 122 oF

-10 - 50 oC
14 - 122 oF

Humidity Max. 70%
non-condensing

Max. 90%
non-condensing

Max. 90%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 2-3 - Facility Needs 2-7

Section 2-3
Facility Needs

2-3-1 Purchaser Responsibilities
The work and materials needed to prepare the site is the responsibility of the purchaser. Delay, 
confusion, and waste of manpower can be avoided by completing pre installation work before delivery. 
User the Pre Installation checklist to verify that all needed steps have been taken,
Purchaser reasonability includes:

• Procuring the materials required.
• Completing the preparations before delivery of the ultrasound system.
• Paying the costs for any alternations and modifications not specifically provided in the sales 

contract.

NOTE: All electrical installation that are preliminary to the positioning of the equipment at the site 
prepared for the equipment must be performed by licensed electrical contractors. Other 
connections between pieces of electrical equipment, products involved (and the accompanying 
electrical installations) are highly sophisticated and special engineering competence is 
required. All electrical work on these product must comply with the requirements of applicable 
electrical codes. The purchaser of GE equipment must only utilize qualified personnel to 
perform electrical servicing on the equipment.

The desire to use a non-listed or customer provided product or to place an approved product further 
from the system than the interface kit allows presents challenges to the installation team. To avoid 
delays during installation, such variances should be made known to the individuals or group performing 
the installation at the earliest possible date (preferable prior to purchase).
The ultrasound suite must be clean proof to delivery of the machine. Carpet is not recommended 
because it collects dust and creates static. Potential sources of EMI (electromagnetic interference) 
should also be investigated before delivery. Dirt, static, and EMI can negatively impact system.
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2-3-2 Required Features
• Dedicated single branch power outlet of adequate amperage (see Table 2-3) meeting all local and 

national codes which is located less than 2.5 m (8 ft.) from the unit’s proposed location
• Door opening is at least 76 cm (30 in) wide
• Proposed location for unit is at least 0.3 m (1 ft.) from the wall for cooling
• Power outlet and place for any external peripheral are within 2 m (6.5 ft.) of each other with 

peripheral within 1 m of the unit to connect cables.

NOTE: The LOGIQ™ 7 has four outlets inside the unit. One is for the monitor and three for on board peripherals.

• Power outlets for other medical equipment and gel warmer
• Power outlets for test equipment and modem within 1 m (3.2 ft.) of unit
• Clean and protected space to store transducers (in their cases or on a rack)
• Material to safely clean probes (done with a plastic container, never metal)

2-3-3 Desirable Ultrasound Room Facilities
• Door is at least 92 cm (3 ft.) wide
• Circuit breaker for dedicated power outlet is easily accessible
• Sink with hot and cold water
• Receptacle for bio–hazardous waste, like used probe sheaths
• Emergency oxygen supply
• Storage for linens and equipment
• Nearby waiting room, lavatory, and dressing room
• Dual level lighting (bright and dim)
• Lockable cabinet ordered by GE for its software and proprietary manuals
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2-3-4 Recommended and Alternate Ultrasound Room Layout
Recommended standard floor plan and a minimal floor plan for ultrasound equipment:

Figure 2-1   RECOMMENDED ULTRASOUND ROOM 
LAYOUT

LOGIQ

LOGIQ
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2-3-5 Networking Pre-installation Requirements

2-3-5-1 Purpose of DICOM Network Function
DICOM services provide the operator with clinically useful features for moving images and patient 
information over a hospital network. Examples of DICOM services include the transfer of images to 
workstations for viewing or transferring images to remote printers. As an added benefit, transferring 
images in this manner frees up the on-board monitor and peripherals, enabling viewing to be done while 
scanning continues. With DICOM, images can be archived, stored, and retrieved faster, easier, and at 
a lower cost.

2-3-5-2 DICOM Option Pre-installation Requirements
To configure the LOGIQ™ 7 to work with other network connections, the site’s network administrator 
must provide some necessary information.

Information must include: 

• A host name, local port number, AE Title, IP address and Net Mask for the LOGIQ™ 7. 
• The IP addresses for the default gateway and other routers at the site for ROUTING 

INFORMATION.
• The host name, IP address, port and AE Title for each device the site wants connected to the 

LOGIQ™ 7 for DICOM APPLICATION INFORMATION. A field for the make (manufacturer) and 
the revision of the device, is also included. This information may be useful for solving errors.
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2-3-5-2 DICOM Option Pre-installation Requirements (cont’d)
.

Figure 2-2   Worksheet for DICOM Network Information

LOGIQ™ 7
Host Name

AE Title

Local Port IP Address

Net Mask

.

.

. .

.. .

ROUTING INFORMATION

ROUTER2
ROUTER3

ROUTER1

.. .

.. .

.. .

.. .

.. .

.. .

.. .

Destination 
IP Addresses

GATEWAY IP Addresses

Default

DICOM APPLICATION INFORMATION

NAME

Store 2

Store 3

Store 1

MAKE/REVISION IP ADDRESSES PORTAE TITLE

Store 5

Store 6

Store 4

Storage 
Commit

MPPS

Worklist .. .

.. .

.. .

.. .

.. .

.. .

.. .

.. .

.. .
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Chapter 3
Installation

Section 3-1
Overview

3-1-1 Purpose of Chapter 3
This chapter contains information needed to install the unit. Included are references to a procedure that 
describes how to receive and unpack the equipment and how to file a damage or loss claim.
How to prepare the facility and unit of the actual installation, and how to check and test the unit, probes, 
and external peripherals for electrical safety are included in this procedure. Also included in this section 
are guidelines for transporting the unit to a new site.

3-1-2 Average Installation Time

The LOGIQ™ 7 has been designed to be installed and checked out by an experienced service 
technician in approximately four hours. LOGIQ™ 7 consoles with optional equipment may take slightly 
longer.

Table 3-1   Contents in Chapter 3

Section Description Page Number

3-1 Overview 3-1

3-2 Receiving and Unpacking the Equipment 3-3

3-3 Preparing for Installation 3-10

3-4 Completing the Installation 3-11

3-5 Installation Paperwork 3-18

Table 3-2   Average Installation Time

Description Average Installation Time Comments

Unpacking the scanner 0.5 hour

Scanner wo/options 0.5 hour Dependant on the configuration that is required

DICOM Option 0.5 hour Dependant on the amount of configuration

InSite Option 0.5 hour
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3-1-3 Installation Warnings
1.) Since the LOGIQ™ 7 weighs approximately 225 kg. (496 lb) without options, preferably two people 

should unpack it. Two people are also preferable for installing any additional bulky items.
2.) There are no operator serviceable components. To prevent shock, do not remove any covers or 

panels. Should problems or malfunctions occur, unplug the power cord. Only qualified service 
personnel should carry out servicing and troubleshooting.

3.) After being transported, the unit may be very cold or hot. If this is the case, allow the unit to 
acclimate before you turn it on. It requires one hour for each 2.5×C increment it's temperature is 
below 10×C or above 40×C.

3-1-3-1 Brake Pedal Operation

CAUTION Equipment damage possibility. Turning the system on without acclimation after arriving at site 
may cause the system to be damaged.

Table 3-3   Time for Settlement

°C 60 55 50 45 40 35 30 25 20 15 10 5 0 -5 -10 -15 -20 -25 -30 -35 -40

°F 140 131 122 113 104 96 86 77 68 59 50 41 32 23 14 5 -4 -13 -22 -31 -40

hrs 8 6 4 2 0 0 0 0 0 0 0 2 4 6 8 10 12 14 16 18 20

WARNINGWARNING
R

REMEMBER: IF THE FRONT CASTER SWIVEL LOCK IS ENGAGED FOR 
TRANSPORTATION, PRESSING THE RELEASE PEDAL ONCE EDISENGAGES THE 
SWICEL LOCK. YOU MUST DEPRESS THE RELEASE PEDAL A SECOND TIME TO 
ENGAGE THE BRAKE.
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Section 3-2
Receiving and Unpacking the Equipment

When a new system arrives, check that any components are not damaged and are not in short supply. 
If shipping damage or shortage occurs, contact the address shown in Chapter 1.

Unpacking Procedures:

1.) Cut the two Metal Bands.
2.) Lift the Cap up and off.
3.) Remove the six (6) Plastic Joints from the Outer Sleeves.
4.) Remove the Outer Sleeves.
5.) Remove the Monitor Sleeve.
6.) Remove the Box for Peripherals.
7.) Remove the Front and Rear Cushions.
8.) Slide out and set up the Slope.
9.) Unlock the brakes by stepping down on the brake pedal in front, then carefully roll the LOGIQ™ 

7 rear side first off the Skid.

Figure 3-1 Unpacking Procedures

Cap

Plastic Joint

Rear Cushion

Outer Sleeve

Monitor Sleeve
For CRT

Box for 
Peripherals

Front Cushion

Slope

Skid

Plastic Band

Monitor Sleeve
For LCD

Example shown:
LOGIQ 7 system
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Section 3-2      Receiving and Unpacking the Equipment (cont’d)

NOTE: Check the shipping container for special instructions. Verify that the container is intact. In some 
cases a secondary container may be used. If so, ask the carrier for unpacking instructions.

NOTICE For the protection of LCD monitor, re-use the packing sleeve whenever possible, in case of shipment 
after unpacking.

Figure 3-2 Labels on Package

Secure the LCD Sleeve with adhesive tape after 
placing it to the proper location.

Adhesive Tape (Each side)

Turn over the LCD monitor, and 
place the sleeve to the location 
above.  Make sure LCD arm is 
locked.

Pull over the sleeve to the LCD arm. Make sure the LCD arm hinge is 
placed inside of the protective pad.

Note: These labels are attached onto the 
shipping box, defining environment at 
which consoles are to be transported or 
stored.
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3-2-1 Safety Reminders

DANGER WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE OF OPENING THE 
AC GROUND LINE (I.E., METER’S GROUND SWITCH IS OPEN), DO NOT TOUCH 
THE UNIT!

CAUTION Two people should unpack the unit because of its weight. Two people are required whenever a 
part weighing 19kg (35 lb.) or more must be lifted.

CAUTION If the unit is very cold or hot, do not turn on its power until it has had a chance to acclimate to 
its operating environment.

CAUTION To prevent electrical shock, connect the unit to a properly grounded power outlet. Do not use a 
three to two prong adapter. This defeats safety grounding.

CAUTION Do NOT wear the ESD wrist strap when you work on live circuit and more than 30 V peak is 
present.

CAUTION Do not use a 20 Amp to 15 Amp adapter on the 120 Vac unit’s power cord. This unit requires a 
dedicated 20 A circuit and can have a 15 A plug if the on board peripherals do not cause the unit 
to draw more than 14.0 amps.

CAUTION Do not operate this unit unless all board covers and frame panels are securely in place. System 
performance and cooling require this.

CAUTION OPERATOR MANUAL(S)
The User Manual(s) should be fully read and understood before operating the LOGIQ™ 7 and 
kept near the unit for quick reference.

CAUTION ACOUSTIC OUTPUT HAZARD
Although the ultrasound energy transmitted from the LOGIQ™ 7 probe is within FDA limits, 
avoid unnecessary exposure. Ultrasound energy can produce heat and mechanical damage.

CAUTION Do not lift the unit by the Keyboard. Equipment damage may result.

CAUTION The crate with the LOGIQ™ 7 weighs approximately 340 kg. (749.7 lb) Be prepared for a sudden 
shift of weight as the unit is removed from its base (pallet)
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3-2-2 Moving into Position

In general, a single adult can move the LOGIQ™ 7 along an even surface with no steep grades. At least 
two people should move the machine when large humps, grooves, or grades will be encountered. (It is 
better to pull from the rear rather than push from the front of the unit). Before moving, store all loose 
parts in the unit. Wrap transducers in soft cloth or foam to prevent damage.

Although LOGIQ™ 7 is a compact and mobile machine, two people should move it over rough surfaces 
or up and down grades.

CAUTION Do not lift the unit by the Keyboard.
Do not tilt the unit more than 5 degrees to avoid tipping it over.
To avoid injury by tipping over. Set the monitor to the lowest position before moving.

CAUTION Equipment Damage Possibility. Lifting the console by holding covers may damage the covers. 
Do not lift the console by holding any covers.

CAUTION For LCD Model ONLY:
Always lock the LCD monitor arm before removing the LCD monitor. This prevents the monitor 
arm from being suddenly and unexpectedly extended when removing the LCD monitor. Failure 
to heed this warning may result in personal harm, harm to others or death..

Arm Lock (LCD Model ONLY)
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3-2-3 LCD Monitor Tilt Caution

CAUTION Do NOT put your hand here! Your fingers might be pinched when adjusting angle of the LCD 
monitor.

Figure 3-3   LCD Monitor Tilt Caution

For R7.5.x 19inch LCD system
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3-2-4 LCD Monitor Swing CautionLCD Monitor Tilt Caution

CAUTION Arm can be swung 180 degree left and right, and stick out from the side frame. Pay attention to 
the location from the wall in the room for room layout, and notice the attention to customer for 
Examination Table side.

CAUTION LCD will hit the KBD in case of moving over the right/left side.
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3-2-5 LCD Monitor Removal Caution

3-2-6 Shipping Delivery Requirements
Do NOT hold the scanner at the LCD monitor or rotaing arm using the belt as shown. Always hold it at 
the body part of the console.

CAUTION Always lock the LCD monitor arm before removing the LCD monitor. This prevents the monitor 
arm from being suddenly and fastly extended when removing the LCD monitor. Failure to heed 
this warning may result in personal harm, harm to others or death.

Figure 3-4   Shipping Delivery Requirements

Arm Lock (LCD Model ONLY)

CAUTION

Always hold the scanner
at the body.
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Section 3-3
Preparing for Installation

3-3-1 Verify Customer Order
Compare items received by the customer to that which is listed on the delivery order. Report any items 
that are missing, back ordered or damaged.

3-3-2 Physical Inspection

3-3-2-1 System Voltage Settings
• Verify that the scanner is set to the correct voltage. The Voltage settings for the LOGIQ™ 7 Scanner 

is found on the label onto the rear lower of the scanner.

3-3-3 EMI Protection
This Unit has been designed to minimize the effects of Electro Magnetic Interference (EMI). Many of the 
covers, shields, and screws are provided primarily to protect the system from image artifacts caused by 
this interference. For this reason, it is imperative that all covers and hardware are installed and secured 
before the unit is put into operation.

WARNINGWARNING CONNECTING A LOGIQ™ 7 SCANNER TO THE WRONG VOLTAGE LEVEL WILL MOST 
LIKELY DESTROY THE SCANNER.

WARNINGWARNING PROTECTIVE EARTH MUST BE TAKEN WHEN CONNECTING AC POWER CABLE 
(200V) WITHOUT ITS PLUG TO WALL OUTLET.
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Section 3-4
Completing the Installation

3-4-1 Probe (Transducer) Connection

1.) Connect a transducer to the upper transducer receptacle as follows:

a.) Ensure that the transducer twist lock lever to the horizontal position.
b.) Insert the transducer connector on the receptacle guide pin until it touches the receptacle 

mating surface.
c.) Twist the transducer twist lock lever to vertical position to lock it in place. Twist the lever to the 

horizontal position to disconnect the transducer.

NOTE: It is not necessary to turn OFF power to connect or disconnect a transducer.

2.) Connect the main power cable to a hospital grade power receptacle with the proper rated voltage 
checked during pre installation. Never use a three-to-two prong adapter; this defeats the safety 
ground. 

NOTICE To make effective use of the memory space:
1. When a scanner has one linear probe, it must be connected to the most left receptacle.
2. When a scanner has several linear probes, they must be connected from the left to the right.
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3-4-2 Optional Peripherals/Peripheral Connection
Depending on the customer order, the peripheral(s) already has been installed onto the scanner before 
shipment. If it does not, select the proper location to install the peripherals, following the table below.

Figure 3-5   Optional Peripherals/Peripheral Connection

Location for 
peripheral

One peripheral 
(Color printer ONLY)

One peripheral (VCR 
or DVD recorder) Two peripherals

Consle Top Not used Not used VCR or DVD recorder

Device Room Used Used Color Pinter

Console Top

Device Room
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3-4-2 Optional Peripherals/Peripheral Connection (cont’d)

Check if the fixing belts are loosen. If it is, tighten the belts again to secure the peripheral(s). If 
necessary, remove the peripheral from the device room to tighten the belts.

3-4-2-1 Approved on-board peripherals
Refer to Section 5-3 Peripheral Compatibility.

Figure 3-6   How to Hold Peripherals

Belts

Belts

Belts

Connect the related cables 
between the peripheral and 
LOGIQ 7 if they are NOT con-
nected each other.
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3-4-2-1 Approved on-board peripherals (cont’d)
Connecting Cables

3-4-2-2 Reference off-board peripherals and options
None.

CAUTION Equipment damage possibility. Be sure to use the following recommended connecting cables to connect 
recording devices and a network with LOGIQ™ 7 console.

Table 3-4   List of Connecting Cables

Name Part No. Figure NOTE

Power Supply Cable P9509EE Connected to power

USB Serial Bridge 
Cable 2304621

For converting the signal of 
RS232C cable to USB cable:
connected to VCR1 on the Rear 
Panel

AV Cable 2119874 Connected to Video-In/Out on the 
Rear Panel

The followings are the cables for BT04 ore lower system ONLY.

Mini-Plug Cable P9509BE Shutter control signals:
connected to B/W Printer

RS232C Cable 
Cross 2305550 For control signals:

connected to Serial Bridge Cable

RS232C Cable 
Straight 2305549 For control signals:

connected to Serial Bridge Cable

BNC Cable 2297053 For control signal:
connected to Composite B/W

USB Cable 2324360 Connected to USB port.

SCSI cables
(UP-D50 ONLY) 2375479 Connected toSCSI port and SCSI 

Cable Connector.
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3-4-3 Available Probes
See in specification in the LOGIQ™ 7 Reference Manual for Probes and intended use.
See Chapter 9 - Renewal Parts for Part Numbers to be used when ordering new or replacement probes.

Table 3-5   List of Transducers supported (All models)

Probe Name
Material of 
Headshell Area of Using TYPE Catalog Number Part Number

3C PES ABDOMINAL CONVEX H79802P
H40412LB

2286353
2286354

5C PES ABDOMINAL CONVEX H79822P
H40412LA

2294515
2294516

8C PBT NEONATAL
PEDIATRICS MICRO-CONVEX H79792P

H40412LJ
2348093
2348094

E8C NORYL
PBT TRANSVAGINAL MICRO-CONVEX H79852P

H40412LE
2294640
2294641

M7C PBT ABDOMINAL CONVEX H79832P
H40412LC

2294513
2294514

M12L PBT SMALL PARTS LINEAR H79842P
H40412LD

2294510
2294511

7L NORYL
ABDOMINAL

SUPERFICIAL
LINEAR H79862P

H40412LF
2294520
2294521

10L NORYL SUPERFICIAL LINEAR H79872P
H40412LG

2294522
2294523

10S ABS PEDIATRIC SECTOR H79922P
H4901PC

2309478
2298589

3.5C NORYL ABDOMINAL CONVEX H79812P
H4901PE

2303215
2050357

3.5CS NORYL ABDOMINAL CONVEX H78042P
H40412LK

2380854
2051858

3S NORYL CARDIOLOGY SECTOR H79632P
H4701SZ

2348878
2323337

i12L ABS INTRAOPERATIVE LINEAR H79322P
H4012L 

2270556
2264883

M3S PBT CARDIOLOGY SECTOR H79892P
H45011SZ

2293726
2378099

6T-OR-TEE PU: PolyUrethane
TRASOPHAGEAL FOR 

ADULT
CARDIOLOGY

SECTOR H79932P
H45521DX

5131947
KN100068

7S PBT CARDIOLOGY SECTOR H78082P
H40422LB

2355698
2347471

BE9C PBT TRANSRECTAL MICRO-CONVEX H40412LW
2389381
2389382

T739 NORYL INTRAOPERATIVE LINEAR H76572SR
H40212LM

2259245
2259246

4D3C_L PBT ABDOMINAL CONVEX Volume H44801G 5121652
KTZ195893
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NOTE: PES: Polyethersulfone NORYL: Modified Polyphenylene Oxide PU: Polyurethane
PBT: Polybutylene Terephthalate ABS: Acrylonitrile Butadiene Styrene

NOTE: Some probes indicated on the table above have two different part numbers. The upper row 
shows the part numbers of probes for Japan. The lower row shows the part numbers of probes 
for regions other than Japan. Probes which have only one part number are not available in 
Japan.

The following transducers, additional to ones listed in Table 3-6, are supported by V65x and later LOGIQ 
7 models.

The following transducers, additional to ones listed in Table 3-7, are supported by R7.5.x and later 
LOGIQ 7 models.

The following transducers, additional to ones listed in Table 3-8, are supported by BT09 and later 
LOGIQ 7 models.

4D10L PBD SUPERFICIAL LINEAR Volume H44801GB 5121651
KTZ156836

4C PBT ABDOMINAL CONVEX H4904PC 5131944
5123455

12L Noryl SUPERFICIAL LINEAR H40412LH 2295375
2295377

P2D ABS CARDIOLOGY CWD H4830JE TE100024

P6D --- SUPERFICIAL CWD H4830JG TQ100002

Table 3-6   List of Transducers supported by V65x and later 

Probe Name
Material of 
Headshell Area of Using TYPE Catalog Number Part Number

9L PBT VASCULAR SMALL 
PARTS LINEAR H40412LT 5131433

4DE7C PBT OB Gyn Urology CONVEX Volume H44801GA 5121650

Table 3-7   List of Transducers supported by R7.5.x and later 

Probe Name
Material of 
Headshell Area of Using TYPE Catalog Number Part Number

3CRF PU: PolyUrethane ABDOMINAL MICRO-CONVEX H40442LP 5214820
5196216

Table 3-8   List of Transducers supported by BT09 and later 

Probe Name
Material of 
Headshell Area of Using TYPE Catalog Number Part Number

11L PBT SUPERFICIAL LINEAR H78842P
H40412LY

5251881
5171885

Table 3-5   List of Transducers supported (All models)

Probe Name
Material of 
Headshell Area of Using TYPE Catalog Number Part Number
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3-4-4 Video Specification

3-4-5 Software Option Configuration

3-4-5-1 Onsite check and configuration
Select Utility > Admin > System Admin and check the option software to be installed.

Table 3-9   Video Specifications

CRT LCD

Timing Parameter
800x600

75Hz Timing Parameter
1280 x 1024

60Hz

Horizontal Rate [kHz] 46.88 Horizontal Rate [kHz] 64

Horizontal Period [µs] 21.33 Horizontal Period [µs] 15.625

Pixel Clock [MHz] 49.50 Pixel Clock [MHz] 108

H Blank Width [µs] 5.17 H Blank Width [µs] 3.778 (408dots)

H Sync Width [µs] 1.62 H Sync Width [µs] 1.037 (112dots)

H Front Porch [µs] 0.32 H Sync Front Porch [µs] 0.444 (48dots)

Active Horizontal Period [µs] 16.16 Active Horizontal Period [µs] 11.852 
(1280dots)

Vertical Rate [Hz] 75.00 Vertical Rate [Hz] 60.0

Vertical Period [ms] 13.33 Vertical Period [ms] 16.67 
(1066lines)

V Sync Width [lines=ms] 25=0.53 V Sync Front Porch [ms] 0.016 (1 line)

V Front Porch [lines=µs] 3=64.00 Equalization Porch None

Equalization Gate [lines=µs] 1=21.3 Lines: Field/Frame 1066

Lines: Field/Frame 625 Active Lines/Frame 1024

Active Lines/Frame 600
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Section 3-5
Installation Paperwork

NOTE: During and after installation, the documentation (i.e. Users Manual, Installation Manuals...) for 
the peripheral units must be kept as part of the original system documentation. This will ensure 
that all relevant safety and user informations are available during the operation and service of 
the complete system.

3-5-1 Peripherals/Accessories Connector Panel
LOGIQ™ 7 peripherals and accessories can be properly connected using the rear connector panel 
located behind the rear door, front connector panel located next to the video printer, and Footswitch 
connector located bottom of the OP panel.
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3-5-1-1 Rear Panel Connector
Located on the rear panel are video input and output connectors, audio input and output, camera 
expose connectors, footswitch connector power connector and control connections for VCR, printer, 
and service tools. 

This section indicates the pin assignment for each connector.

Figure 3-7   Rear Pannel Connector (BT04 or later)
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3-5-1-1 Rear Panel Connector (cont’d)

NOTE: Each outer (case) ground line of peripheral/accessory connectors are protectively grounded. 
Signal ground lines are not isolated, except the Service port (3). All of signal lines (include signal 
GND) of the Service port are isolated.
The specified peripherals/accessories only can be connected to the USB ports.

Rear Pannel Connector for BT03 or lower

Figure 3-8 Rear Panel Connector (BT03 or lower)

�

�

USB1.1 (USB compatible) 
or (USB + USB Serial Bridge 
+ RS232C)
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8 7
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USB1.1 (USB compatible) 
or (USB + USB Serial Bridge 
+ RS232C)
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3-5-1-1 Rear Panel Connector (cont’d)

Pin Assignment of S-Video Connector

Connector: S-Terminal, 4-pin

Pin Assignment of VGA Connector

Connector: Shrank D-Sub, 15-pin

Pin Assignment of Service/VCR 1/VCR 2 Connector, USB1.1

Connector: 4 pin

Table 3-10   Pin Assignment of S-Video Connector

Pin No Output/Input Signal Description

1 SVIDEO OUT/IN YG Y (Luma) GND

2 SVIDEO OUT/IN CG C (Chroma) GND

3 SVIDEO OUT/IN Y Y (Luma) SIGNAL

4 SVIDEO OUT/IN C C (Chroma) SIGNAL

Table 3-11   Pin Assignment of VGA Connector

Pin No Output Signal Description

1 IO VGA OUT1 R Red

2 IO VGA OUT1 G Green

3 IO VGA OUT1 B Blue

6 IO VGA OUT1 RG Reg GND

7 IO VGA OUT1 GG Green GND

8 IO VGA OUT1 BG Blue GND

13 IO VGA OUT1 HS H Sync

14 IO VGA OUT1 VS V Sync

Others GND GND

Table 3-12   Pin Assignment of Service/VCR 1/VCR 2 Connector

Pin No Output Signal Description

1 VBUSn Power Supply

2 Dn Data (-)

3 Dn Data (+)

4 GNDn Power Ground

1

2

4 3

1

2

 1

 6

 11

5 

10 

15 

3

1  2  3  4
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3-5-1-1 Rear Panel Connector (cont’d)

Pin Assignment of Digital Int. Connector

Connector: 6-pin

Pin Assignment of Ethernet

Connector: RJ-45 Modular, 8-pin

Pin Assignment of Insite

Connector: RJ-11 Modular, 6-pin

Table 3-13   Pin Assignment of IEEE-1394 Connector)

Pin No Output Signal Description

1 VP 1394 Power Supply

2 VG 1394 Power Ground

3 TPB 1394 Data B (-)

4 TPB 1394 Data B (+)

5 TPA 1394 Data A (-)

6 TPA 1394 Data A (+)

Table 3-14   Pin Assignment of Ethernet Connector

Pin No Output Signal Description

1 ETHER TD Ethernet TD+

2 ETHER TD Ethernet TD-

3 ETHER RD Ethernet RD+

6 ETHER RD Ethernet RD-

Others NC Non-connection

Table 3-15   Pin Assignment of Insite Connector

Pin No Output Signal Description

2 TEL L4 Telephone L4

3 TEL L2 Telephone L2

4 TEL L1 Telephone L1

5 TEL L3 Telephone L3

Others NC Non-connection

4

1  3  5

2  4  6

5

 8  1

6

 8  1
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3-5-1-1 Rear Panel Connector (cont’d)

Pin Assignment for Camera B/W

NOTE: Output level of control signals indicated in the above tables are TTL level.

Pin Assignment of Insite

3-5-1-2 Front Connector Panel
Located on the front panel are Microphone, LED, and Reset. 

Table 3-16   Pin Assignment of Mini-Jack for Controlling B/W Camera

Pin No Output Signal

1 PRINT

2 Signal GND

Table 3-17   Pin Assignment of Mini-Jack for Controlling Color Camera

Pin No Output Signal

1 SHUTTER

2 Signal GND

Figure 3-9 Front Connector Panel

7

8

Reset

Microphone

LED
(HD access)

Note:USB1.1. Some 
systems do NOT have this 
port. If your system has 
this port, do NOT use this 
port! Instead, use the 
USB port located at the 
rear connector panel.

Serial

For BT04 or laterFor BT03 or lower

You can use
the serial port.

USB2.0
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3-5-1-3 B/W Printer Connector Panel

3-5-1-4 Footswitch Connector Panel
Round 5 pin connector.

NOTE: Output level of control signals indicated in the above tables are TTL level.

Table 3-18   Pin Assignment of Mini-Jack for Controlling B/W Printer

Pin No Output Signal

1 PRINT

2 Signal GND

Table 3-19   Pin Assignment of Mini-Jack for Footswitch

Pin No Output Signal

1 SW1-WH

2 SW2-RD

3 SW3-GN

4 SW1-BK, SW2-BK, SW3-BK

5 Frame GND

1

2

3

4

5
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Chapter 4
Functional Checks

Section 4-1
Overview

4-1-1 Purpose for Chapter 4
This chapter provides procedures for quickly checking major functions of the LOGIQ™ 7 console, 
diagnostics by using the built-in service software, and power supply adjustments. 

4-1-2 Special Equipment Required
• An empty (blank) MO Disk.
• At least one transducer.

(normally you should check all the transducers used on the system.)

Table 4-1   Contents in chapter 4

Section Description Page Number

4-1 Overview 4-1

4-2 General Procedure 4-2

4-3 Functional Checks 4-20

4-4 Application Turnover Check List 4-27

4-5 Diagnostics 4-28

4-6 Power Supply 4-29

4-7 Site Log 4-30

NOTICE Most of the information pertaining to this Functional Checks chapter is found in the LOGIQ™ 7 Quick 
Guide (Direction Number 2291859-100).
Look for the letters (QG) after a section in the Table of Contents to determine if the information is in this 
chapter or in the Quick Guide.
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Section 4-2
General Procedure

4-2-1 Lockout/Tagout Requirements
Follow OSHA Lockout/Tagout requirements by ensuring you are in total control of the plug.

4-2-2 Power On/Boot Up

NOTE: After turning off the system, wait at least ten seconds before turning it on again. The system 
may not be able to boot if power is recycled too quickly.

4-2-2-1 Power Up

1.) Connect the Main Power Cable at the rear of the System.

2.) Connect the Main Power cable to an appropriate mains power outlet.
3.) Switch ON the Main Circuit Breaker at the rear of the System.

When power is applied to the Scanner, and the Rear Circuit breaker is turned ON, Power is distributed 
to the Fans, Control panel, Monitor, Internal and External I/O’s, Cage Boards, Peripherals and the 
Backend Processor. When the Power ON/OFF key is pressed once, the Backend Processor starts and 
its software code is distributed to initiate the scanner.

CAUTION SYSTEM REQUIRES ALL COVERS
Operate this unit only when all board covers and frame panels are securely in place. The covers 
are required for safe operation, good system performance and cooling purposes.

WARNINGWARNING PROTECTIVE EARTH MUST BE TAKEN WHEN CONNECTING AC POWER CABLE 
(200V) WITHOUT ITS PLUG TO WALL OUTLET.

Figure 4-1 Circuit Breaker

Main Circuit Breaker

Main Power Cable

For BT04 or lator
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4-2-2-1 Power Up (cont’d)
4.) Press the ON/OFF key at the front of the System once.

4-2-2-2 Power Up Sequence

NOTE: For consoles with BEP4 (BT09), power switch lamp is darker compared to existing BT04-BT07 
consoles with BEP3.  This is NOT abnormality and system will function normally regardless of 
the brightness of the power button.

1.) The Start Up Screen will be shown on the Monitor display when the system is turned ON.

Figure 4-2 Power On/Off Standby Switch Location

Figure 4-3 Start Up Screen
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2.) After initialization is complete, all lighted buttons on the Control Panel light and the default B-Mode 
screen or Patient screen (no probes are connected) is displayed on the monitor display.

4-2-2-3 Entering Maintenance Mode

4-2-2-3-1 R6.2.x or later

1.) Insert the service dongle into any USB port.
2.) Wait for scanner boot-up.
3.) Tap ON/OFF the power switch.
4.) Click on Exit.

5.) Enter the proper password to enter the maintenance mode.
6.) Click on OK.

Figure 4-4   Clicking on Exit

Figure 4-5   Clicking on OK
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4-2-2-3 Entering Maintenance Mode (cont’d)
7.) Click on maintenance.

8.) Click on Exit to window.
Figure 4-6   Clicking on Maintetance

Figure 4-7   Clicking on Exit to Window

7

7
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4-2-2-3 Entering Maintenance Mode (cont’d)

4-2-2-3-2 R 4.x.x to R6.0.x

1.) The Start Up Screen will be shown on the Monitor display when the system is turned ON.
2.) The “Probing for maintenance access” dialog appears. Enter Password, then click on OK.

3.) Then Start Loader display will be shown on the Monitor display.Click on Maintenance.

4.) Click on Exit to Windows in maintenace diaglog window.Then the scanner is booted up 
automatically.

4-2-2-3-3 R2.x.x to R4.x.x

1.) Insert the service dongle in the Service port located at the rear panel.
2.) The Start Up Screen will be shown on the Monitor display when the system is turned ON.
3.) Then Start Loader display will be shown on the Monitor display. Then the scanner is booted up 

automatically.

NOTE: To enter the Maintenance Mode, select Maintenance button.

NOTE: Start is selected automatically when it time out.

Figure 4-8   Clicking on Mainttenance

Figure 4-9 Start Application Window
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4-2-3 Power Shutdown
Purpose: This is a description on how to Shutdown the system.

4-2-3-1 Complete Power Down

1.) Press the ON/OFF key at the front of the System for about two (2) seconds. Refer to Figure 4-2.
2.) Switch OFF the Main Circuit Breaker at the rear of the system Refer to Figure 4-1.
3.) Disconnect the Main Power Cable if needed. Refer to Figure 4-1.

4-2-4 System Stand-by
LOGIQ 7 is available with Stand-by option.  The option is effective in reducing the scanner power up 
time, when used as portable device.

Users must follow the procedures in order to use the option.

NOTE: Do not use more than 20 Stand-by mode continuously without shutting down the system.  The 
scanner must be powered off daily.

1.) Press the POWER switch once.
2.) Select Standby.At this point, both the touch panel and the main monitor will go blank.  Keyboard 

lights also turns dark.  Power switch button will be illuminated.

3.) Wait more than 20seconds.

4.) Plug off the power cord from wall outlet.

5.) Transport the scanner as required, but re-connect to power outlet within 20 minutes.  If not powered 
system may shut down due to loss of sustained battery power.

6.) Connect the scanner to a wall electrical outlet.

Figure 4-10   Selecting Standby

NOTICE Do not disconnect the power cable immediately.

NOTICE Do not press the Power button without connecting the power cable.

Standby



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
4-8 Section 4-2 - General Procedure

4-2-4 System Stand-by (cont’d)

7.) To power up the scanner, tap POWER button momentary, and wait for power up.  It will 
approximately 45seconds for the scanner to power up.

Stand-by Sequence

NOTICE Do not press the Power button long time, as it will cause the system to power down.

Figure 4-11   Stand-by Sequence

Press POWER button

Select "Standby"

Check Monitor
OFF

Wait

Check Touch
Panel OFF

Check POWER
button

illuminated

Wait more than 20 seconds

Disconnect Power Cord

Connect to electrical outlet
(Power Cord)

Press POWER button

Wait 5 seconds

Scanner Start up completion
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Standby may be
failed

Stand-by
Sequence

ON

ON

OFF

OFF or Blinking

(Note 1)

Note1 : BT09 Release with BEP4 Hardware have "Blinking Power Button" 
capability to indicate the console in Stand-by condition.  For BEP3 and earlier, 
Power button must be "OFF" before disconnecting the power cord.
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4-2-5 Using CD-R/MOD/DVD Drive

4-2-5-1 Using CD-R or DVD Drive

1.) Push the EJECT button, the disk tray will appear.
2.) Put the disk onto the disk tray.
3.) Press the EJECT button to insert the disk into the CD-R or DVD device.
4.) There are a number of methods to eject a disk from the CD-R or DVD. Ejection is automatic in some 

cases. Manual ejection methods, listed in preferred order of use, are:

a.) Press EJECT button on the CD-R or DVD while system is ON.
b.) Press and hold EJECT button while the system is booting.
c.) Mechanical ejection. Insert the end of a paper clip into the hole while system power is OFF.

NOTE: Be careful not to scratch the disk when wiping it off for cleaning.

NOTE: Keeping your CD-R or DVD disc in an original CD-R or DVD case or caddy all the time will 
prevent it from becoming dirty or damaged.

NOTE: Media Requirement:
Please be aware of the following regarding saving data to DVD-R on R6.0.x.:

Use x8 or x16 speed compatible DVD-R. When it is the upgraded R6.0.x system from R4.x.x. 
or prior version, some systems have a number "4" or "5" printed on the disc tray of the media 
drive and others don't. If there is no number printed on the disc tray, use x4 or x16 speed 
compatible DVD-R.

NOTICE Never move the unit with a disk in the CD-R or DVD because the drive actuator will not be 
locked and the CD-R or DVD could break. 

NOTICE Avoid mechanical ejection whenever possible. Mechanical ejection leaves the actuator 
unlocked and the MOD susceptible to damage if moved. If forced to use this method, reboot 
the system, then insert and eject a known good disk using one of the other methods.

Figure 4-12 CD-R or DVD drive

CD-R Drive
Eject Button

Mechanical 
Eject Hole

DVD Drive



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
4-10 Section 4-2 - General Procedure

4-2-5-2 Using MOD Drive

1.) Before installing an MO disk in the MOD, check the MO disk for loose hardware or damaged labels 
which could jam inside the MO Drive. Also ensure that the slide switch in one corner of the disk is 
set so that the disk is write enabled (disk hole closed).

2.) Insert the disk into the MOD with the label facing up.

3.) The are a number of methods to eject a disk from the MOD. Ejection is automatic in some cases. 
Manual ejection methods, listed in preferred order of use, are:

a.) Press EJECT button on the MOD while system is ON.
b.) Press and hold EJECT button while the system is booting.
c.) Mechanical eject. Insert the end of a paper clip into the hole while system power is OFF.

NOTICE Never move the unit with a disk in the MOD because the drive actuator will not be locked and 
the MOD could break. 

NOTICE Avoid mechanical ejection whenever possible. Mechanical ejection leaves the actuator 
unlocked and the MOD susceptible to damage if moved. If forced to use this method, reboot 
the system, then insert and eject a known good disk using one of the other methods.

Figure 4-13 MOD drive

MO Drive
Eject Button

Mechanical 
Eject Hole

MO Drive



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 4-2 - General Procedure 4-11

4-2-6 Archiving and Loading Presets for BT07 (Including R7.5.x)

NOTE: Always save presets before any software reload. This ensures the presets loaded after the software 
reload are as up–to–date as possible.

All user presets except changes to Summary, Anatomy, and Biometry pages, can be saved on an CD-
R/MO/DVD-R disk for reloading on the system.

4-2-6-1 Regional Preset - General (Supported from BT07)

This feature has the capability to have factory default preset defined by the following regions; Americas, 
Europe, Asia, or Japan.

NOTICE Presets should NOT be saved on the same CD-R/MO/DVD-R disk as images. The Archive Menu 
lists the images but does NOT list the presets stored on a CD-R/MO/DVD-R disk.

NOTICE Do not attempt to change/use Regional Preset buttons for Upgraded BT07.  For Upgrade BT07 always 
use Factory Default in order to avoid preset conflict. Contact application specialist for details.

Table 4-2 

Presets Unique to Regions Presets NOT unique to Regions

System Imaging (System>System Imaging page)
System Measure (System->System Measure page)
Imaging Settings (Imaging page)
Comments (Comments page)
Body Patterns (Body Patterns page)
Application (Application page)
3D/4D (3D/4D page)
Measure (Measure page) : Utility/Measure Advanced and 
Doppler preset

System General (System>General page)
Connectivity (Connectivity page)
Reports (Report page)
Measure (Measure page) : Utility/Measure M&A and OB 
Table preset
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4-2-6-2 Using Regional Preset
Regional Preset is selected during Application Load (Refer to 8-8-13 - Installing R7.x.x Application 
Software for details).

Current Regional Preset is displayed under Utility > System > About .

Factory Default Regional Preset can be re-loaded from Utility > Systme > About > Additional About.

Figure 4-14   Current Regional Preset

NOTICE For Upgraded BT07, this field always shows "None" as Region Preset is feature available for pure BT07 
and onward.

Figure 4-15   Factory Default Regional Preset
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4-2-6-3 Cautions Using Regional Preset
• Do not attempt to modify Regional Preset on Upgraded BT07.
• Backup/Restore function should be used between the same region systems.  Unexpected setting 

may result if you restore the preset files to another region setting system.

4-2-6-4 Formatting CD-R/DVD-R Disk

1.) Insert an empty (blank) CD-R/DVD-R disk into the CD-R/DVD-R device.
2.) Access to the Utility Menu on the Touch Panel, and select Connectivity>Removable Media.
3.) Select the removable media from media list.
4.) Type a name for the removable media in Label field.
5.) Select Format button.

CAUTION When software is upgraded (from BT07 and on) re-loaded or upgraded (from BT07and on), make sure 
to select the factory default.  Because the preset region information in globalconfig.res file shall not be 
upgraded, if different region presets are loaded, then it may cause conflict between system setting and 
region presets. 

Figure 4-16   Selecting Format Button
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4-2-6-5 Archiving Presets to an CD-R/DVD-R Disk

1.) Insert an empty (blank) formatted CD-R/DVD-R disk into the CD-R/DVD-R device.
2.) Access to the Utility Menu on the Touch Panel, and select System>Backup/Restore. The Backup 

screen will be shown on the monitor.
3.) Select the item to back up either from Resource Files.
4.) Select the media to locate the items.
5.) Click on Backup. The backup status for each item is displayed on the Result column. 

6.) Make sure “Finished OK” is displayed on the Result column.
Figure 4-17   Clicking on Backup
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4-2-6-6 Loading Presets from an CD-R/DVD-R disk

1.) Insert the CD-R/DVD-R disk with the archived Presets into the CD-R/DVD-R.
2.) Access to the Utility Menu on the Touch Panel, and select System>Backup/Restore. The Restore 

sheet will be shown on the monitor.
3.) Select the item to restore either from resource Files.
4.) Click on Restore. A message to make sure the restore process is displayed on the monitor. Click 

OK. The restore status for each item is displayed on the Result column.

5.) Make sure “Finished OK” is displayed on the Result column.

4-2-6-7 Regional Preset - Files
Service Tip: The system shall have each region preset files into:

• Americas  : C:/Pegasus/target/resources/Pegasus/ Americas/userdefs/
• Europe: C:/Pegasus/target/resources/Pegasus/Europe/userdefs/
• Asia: C:/Pegasus/target/resources/Pegasus/ Asia/userdefs/
• Japan: C:/Pegasus/target/resources/Pegasus/Japan/userdefs/

When region is selected, Region preset files are copied to:

• C:/Pegasus/target/resources/idunn/userdefs/

Figure 4-18   Clicking on Restore
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4-2-7 Archiving and Loading Presets for BT06/V65x or lower

NOTE: Always save presets before any software reload. This ensures the presets loaded after the software 
reload are as up–to–date as possible.

All user presets except changes to Summary, Anatomy, and Biometry pages, can be saved on an CD-
R/MO/DVD-R disk for reloading on the system.

4-2-7-1 Formatting CD-R/MO/DVD-R Disk

1.) Insert an empty (blank) CD-R/MO/DVD-R disk into the CD-R/MO/DVD-R device.
2.) Access to the Utility Menu on the Touch Panel, and select Connectivity>Removable Media or 

Tools. 

NOTICE Presets should NOT be saved on the same CD-R/MO/DVD-R disk as images. The Archive Menu 
lists the images but does NOT list the presets stored on a CD-R/MO/DVD-R disk.

Figure 4-19 Formatting Removable Media1
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4-2-6-4 Formatting CD-R/DVD-R Disk (cont’d)
3.) Select the removable media from media list.
4.) Type a name for the removable media in Label field.

5.) Select Format button.
Figure 4-20 Formatting Removable Media2
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4-2-7-2 Archiving Presets to an CD-R/MO/DVD-R Disk

1.) Insert an empty (blank) formatted CD-R/MO/DVD-R disk into the CD-R/MO/DVD-R device.
2.) Access to the Utility Menu on the Touch Panel, and select System>Backup/Restore. The Backup 

screen will be shown on the monitor.

3.) Select the item to back up either from Resource Files.
4.) Select the media to locate the items.
5.) Click on Backup. The backup status for each item is displayed on the Result column. 
6.) Make sure “Finished OK” is displayed on the Result column.

Figure 4-21 Backup Sheet
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4-2-7-3 Loading Presets from an CD-R/MO/DVD-R disk

1.) Insert the CD-R/MO/DVD-R disk with the archived Presets into the CD-R/MO/DVD-R.
2.) Access to the Utility Menu on the Touch Panel, and select System>Backup/Restore. The Restore 

sheet will be shown on the monitor.

3.) Select the item to restore either from resource Files.
4.) Click on Restore. A message to make sure the restore process is displayed on the monitor. Click 

OK. The restore status for each item is displayed on the Result column.
5.) Make sure “Finished OK” is displayed on the Result column.

Figure 4-22 Restore Sheet
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Section 4-3
Functional Checks

4-3-1 Basic Controls
For a functional check of the system’s features, including the Control Panel, Touch Panel, Monitor, 
Keyboard and Trackball, refer to the LOGIQ™ 7 Quick Guide.

4-3-2 Performance Tests

4-3-2-1 Recommended Test Phantoms
GE Healthcare recommends the RMI 430GS phantom, but it is not required. It is the most current 
phantom recommended to our field service personnel and provides the necessary targets and extended 
life necessary for consistent system testing.

Figure 4-23 Performance Test
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4-3-3 Mode Checks
For a functional check of the system’s different modes, refer to the LOGIQ™ 7 Quick Guide. The Quick 
Guide will familiarize you with image optimization for B-Mode, M-Mode, Color Flow, and Doppler.

4-3-3-1 System Checks 

4-3-4 Basic Measurements
Basic Measurements for the LOGIQ™ 7 include Distance and Tissue Depth, Circumference/Area 
(Ellipse and Trace), Volume, Time Interval, Velocity, PI, RI, S/D Ratio, D/S Ratio, and A/B Ratio. 
Information for all these tests is found in the LOGIQ™ 7 Quick Guide.

Table 4-3   System Functional Checks

Step Item Description

1 B-Mode Verify basic B-Mode (2D) operation. Check the basic system controls that affect this mode of 
operation.

2 CF-Mode Verify basic CF-Mode (Color Flow Mode) operation. Check the basic system controls that affect this 
mode of operation.

3 Doppler Modes Verify basic Doppler operation (PW and CW if available). Check the basic system controls that affect 
this mode of operation.

4 M-Mode Verify basic M-Mode operation. Check the basic system controls that affect this mode of operation.

5 Probe Elements Perform an Element Test on each probe to verify that all probe elements (and system channels) are 
functional.

6 Monitor Verify basic Monitor display functions. Refer to Chapter 3 of the User Manual.
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4-3-5 ECG Checks
Connect the ECG Harness and check:

4-3-6 Cineloop Check
For activating Cine, creating and storing Cine Loops, and information on the Cine Timeline, refer to the 
LOGIQ™ 7 Quick Guide.

4-3-7 Backend Processor Checks
• If all the previous tests have been passed successfully, the backend processor is most likely OK.
• See Service Platform.
• If the system seems to be operating erratically, please refer to Chapter 7, Diagnostic/

Troubleshooting.

4-3-8 Probe/Connectors Usage (QG)
The LOGIQ™ 7 Quick Guide, provides information on connecting, activating, deactivating and 
disconnecting probes.

Table 4-4   ECG Control

Step Task Expected Result(s)

1 Connect the ECG at the Connector on the 
Front of the system

It will display a curve along the bottom edge 
of the image sector
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4-3-9 Peripheral Checks
Check that peripherals work as described below:

4-3-9-1 Peripheral/Option Checks
If any peripherals or options are not part of the system configuration, the check can be omitted. Refer 
to the User Manual for a list of approved peripherals/options.

Table 4-5   Peripheral checks

Step Task to do Expected Result(s)

1. Press Freeze Stop image acquisition.

2. Press (P1) or (P4) on the Control panel 
The image displayed on the screen is 
printed on B&W or Color printer depending 
on the key assignment configuration.

Table 4-6   GE Approved Peripheral/Hardware Option Functional Checks

Step Item Description

1 VCR Verify record/playback capabilities of the VCR. Clean heads and covers if necessary.

2 B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and covers if necessary.

3 Color Printer Verify hardcopy output of the Color video page printer. Clean heads and covers if necessary.

4 DICOM Verify that DICOM is functioning properly. Send an image to a DICOM device.

5 InSite/iLinq Verify that InSite is functioning properly. Ensure two-way remote communications.
(Warranty & Contract Customers only)

6 Camera Verify hardcopy output of the film camera. Clean as necessary.

7 Footswitch Verify that the footswitch is functioning as programed. Clean as necessary.

8 ECG Verify basic operation with customer

9 3D Probe Ask Engineering about Calibration Check for 3-D
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4-3-10 Mechanical Functions

4-3-10-1 Keyboard and Display Platform Console Check

Table 4-7   Display platform Maneuverability check

Step Task to do Expected Result(s)

1. Pull release lever under the OP Panel to 
release the lock.

The height of the Monitor and OP Panel will 
be maneuverable.

Figure 4-24 Keyboard Lever

Keyboad Lever
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4-3-10-2 Brakes and Direction Locks Checks
Check that: brakes and direction locks function as described below. Refer to Figure 4-25 for the 
locations of brake and swivel.

Table 4-8    Brakes and Direction Lock Check

Step Task to do Expected Result(s)

1.

Press on pedal no.2

To engage the pedal in full lock

2.

Press on pedal no.3

To release the brake

3.

Press on pedal no.1

To engage swivel lock

4.

Press on pedal no.3

To release swivel lock

Figure 4-25 Brake and Swivel Location
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4-3-10-3 Caster and Caster Link Checks
Check if:

• For Caster:
- No loose caster with it jacked up. 
- Smooth operation when moving the scanner.

• For Caster Link Assy:
- Effective brake and direction lock function (See section 4-3-10-2). 
- The pedals can be smoothly returned.
- The lock pin must be removed.
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Section 4-4
Application Turnover Check List

Complete these checks before returning the scanner to customer for use:

4-4-1 Software Configuration Checks

Table 4-9    Software Configuration Checks

Step Task to do Expected Result(s)

1. Check Date and Time setting Date and Time are correct

2. Check that Location (Hospital Name and 
Department) is correct Location Name is correct

3. Check Language setting Language is proper

4. Check Units setting Units are proper
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Section 4-5
Diagnostics

4-5-1 Service Software Menu
Refer to Section 5-5 - Common Service Platform.

4-5-2 Diagnostics Test Menu
Refer to Section 5-5-5 - Diagnostics.

4-5-3 Utility Menu
Refer to Section 5-5-9 - Utilities.
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Section 4-6
Power Supply

4-6-1 Power Supply Test Procedure
There is no need to perform any special tests on the Power Supplies if there does not seem to be a 
problem that may be related to the Power Supplies.

Refer to Section 6-2 - LV Unit Adjustments (For BT03 or lower) if you appear to have a problem that 
may be related to the Power Supplies.

4-6-2 Power Supply Adjustment
There are no adjustments on the power supplies. The DC Power is self-regulated. If a voltage is outside 
the specified range, it means that something is wrong, either with the power supply itself or with a  unit 
connected to that specific power outlet.
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Section 4-7
Site Log

Table 4-10   Site Log

DATE SERVICE PERSON PROBLEM COMMENTS
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Table 4-10   Site Log

DATE SERVICE PERSON PROBLEM COMMENTS



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
4-32 Section 4-7 - Site Log



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 5-1 - Overview 5-1

Chapter 5
Components and Functions (Theory)

Section 5-1
Overview

This chapter explains LOGIQ™ 7’s system concepts, component arrangement, and subsystem 
function. It also describes the Power Distribution System (PDS) and probes.

Table 5-1    Contents in Chapter 5

Section Description Page Number

5-1 Overview 5-1

5-2 Hardware Compatibility Matrix 5-2

5-4 Block Diagrams and Theory 5-12

5-5 Common Service Platform 5-27

5-6 Password 5-40

5-7 Air Flow Control 5-42

5-8 Monitor Video Specification 5-44
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Section 5-2
Hardware Compatibility Matrix

5-2-1 Hardware Compatibility BT09 or later

5-2-1-1 Monitor

Figure 5-26   Monitor - FRU Compatibility
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2283334-5 P9534WA CRT MONITOR ASSY Y Y* N N
Fixed AKB Issue….Monitor Firm Ver.4.2 or
higher
* Y if CRT console

5117797-2 ? CABLE DUCT ASSY N Y* N N * Y if CRT console
2297882 P9534WL SPEAKER & BRACKET ASSY N N N N Non-compatible for BT03 or lower system

2386616 P9534ZT SPEAKER & BRACKET Y Y* N N
Only for BT03 or higer and upgraded BT03
system
* Y if CRT console

2297050 P9534WK USER SW ASSY OF MONITOR Y Y* N N User Switch assy for CRT
2304171 ? MON-CABLE-ASSY Y Y* N N * Y if CRT console

5169935-2 17inch LCD monitor assy N Y+ N N
Improved Parameter : Contains Front/Rear
Covers and Swtichs (exclude Speaker)
Y+ if LCD monitor

5137744 SWITCH MIC_ASSY LCD_MONITOR N Y+ N N Y+ if LCD monitor
5132576 SPEAKER LCD L7 N Y+ N N Y+ if LCD monitor
5132572 PANEL FRONT LCD L7 N Y+ N N Y+ if LCD monitor
5132573 PANEL REAR LCD L7 N Y+ N N Y+ if LCD monitor
5132574 COVER VESA LCD L7 N Y+ N N Y+ if LCD monitor

5125391 LCD D-SUB CABLE ASSY CSL L7 N N N N
Y+ if LCD monitor / Long BEP-LCD cable
(replaced by 5198733)

5198733 FRU_Parts.LCD_TOP_BOTTOM_DSUB
_CABLE_ASSY N Y+ N N

Y+ if LCD monitor / Two piece BEP-LCD cbl
This part replaces 5125391

5189828 DVI_CABLE_TOP_LCD_L7 N Y+ Y+ N Y+ if LCD monitor / Two piece BEP-LCD cbl
5137743 MIC_SPK CBL CSL_LCD L7 N Y+ N N Y+ if LCD monitor
5132394 AC CABLE LCD ASSY LOGIQ7 N Y+ N N Y+ if LCD monitor

5139307-2 LCD CABLE DUCT ASSY CSL L7 N N N N
Y+ if LCD monitor
(replaced by 5139307-3)

5139307-3 FRU_Parts_LCD_CABLE_DUCT_ASSY N Y+ N N
Y+ if LCD monitor
This part replaces 5139307-2

5309932 FRU_Parts_LCD_CABLE_DUCT_ASSY NO
RGB CABLE N N N Y Only for R8.0.0 or later system

5132571-2 LCD ARM LCD L7 N Y+ N N
Y+ if LCD monitor.  OK to use if updated using
part 5264730

5132571-3 LCD ARM LCD L7 N Y+ N N
Y+ if LCD monitor.  OK to use if updated using
part 5264730

5132571-4 LCD ARM LCD L7 N Y+ N N Y+ if LCD monitor.  Improved rotational force.
5136256 ARM COVER LCD L7 N Y+ N N Y+ if LCD monitor
5136257 ARM JOINT COVER LCD L7 N Y+ N N Y+ if LCD monitor
5137688 Monitor Screws LCD L7 N Y+ N N Y+ if LCD monitor
5212808 19Inch LCD Monitor for LOGIQ N N Y Y Only　19 inch LCD
5199460 L9 19 In. LCD Speaker Assembly N N Y Y Only　19 inch LCD
5248133 COVER VESA ASSY L7 N N Y Y Only　19 inch LCD
5240769 19 LCD LATCH-N-LOK CABLE N N Y Y Only　19 inch LCD
5245143 19inch LCD ARM WITH CABLE ASSY N N Y Y Only　19 inch LCD

5245143-2 19INCH LCD ARM WITH CABLE ASSY LCD L N N Y Y Only　19 inch LCD.  Improved rotational force.
Old part can be updated using part 5264730

5224943 19 LCD DVI HDMI CABLE N N Y Y Only　19 inch LCD
5224944 19 LCD MIC SPK CABLE ASSY N N Y Y Only　19 inch LCD
5224942 19 LCD POWER CABLE N N Y Y Only　19 inch LCD
5248134 19inch AC DC ASSY L7 N N Y Y Only　19 inch LCD
5224941 19 LCD 48V UNIT CABLE N N Y Y Only　19 inch LCD
5240848 DVI-HDMI ADAPTOR N N Y N Only　19 inch LCD Upgraded from 17 inch LCD

FRU Part# Description

FRU compatibility
BT09 ～
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5-2-1-2 Recording Devices

Figure 5-27   Recording Devices- FRU Compatibility
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2388429-5 DVD5 Unit Y Y Y Y
2388429-6 DVD Unit 6 Y Y Y Y
FA200801 PAT. I/O Y Y Y Y
2324098 P9534XE FRONT-IF-ASSY N N N N
5111715-2 LOGIQ7 FRONT CONN2 ASSY N Y Y Y Backward compatible among BT04 system
2355070 P9534ZH 1.3GMOD OPTION Y N N N 1.3G SCSI
5113449 MOD DRIVE LOGIQ7 N Y N N 1.3G  IDE
2302393 P9534XD FRONT CONTROL ASSY Y N N N
5111714 LOGIQ7 REAR CONN2 ASSY N Y N N For Console BT04 / BT06
5174604 LOGIQ7 REAR CONN3 ASSY N N Y Y For Console BT06-2 and later
5314714 SVP REAN4 PANEL N N N Y For BEP4 units (including BEP upgraded to BEP4)
5314713 SVP REAN4 USB CBL N N N Y For BEP4 units (including BEP upgraded to BEP4)

FRU Part# Description

FRU compatibility
BT09 ～
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5-2-1-3 OP Panel and Keyboard

Figure 5-28   OP Panel and Keyboard- FRU Compatibility
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2267259-2 P9534XA KEYBOARD ASSY Y N N N

2299453 P9536AG OP PANEL A/N KEYBOARD
ASSY Depends N N N Replaceable only on KBD 2267259 and

2267259-2

2306274 P9536AR OP PANEL KEY
ACCESSORY SET Depends N N N Replaceable only on KBD 2267259 and

2267259-2

2299448 P9536AB OP PANEL ENCODER
ASSY Depends N N N Replaceable only on KBD 2267259 and

2267259-2

2306270 P9536AP OP PANEL CONTROL Depends N N N Replaceable only on KBD 2267259 and
2267259-2

2299447 P9536AA OP PANEL LCD UNIT Depends N N N Replaceable only on KBD 2267259 and
2267259-2

2306273 P9536AQ OP PANEL KEY SWITCH Depends N N N Replaceable only on KBD 2267259 and
2267259-2

2299452 P9536AF OP PANEL TGC ASSY Depends N N N Replaceable only on KBD 2267259 and
2267259-2

2299451 P9536AE OP PANEL TRACKBALL
ASSY Depends N N N Replaceable on any KBD

2344632-2 P9534XK KEYBOARD ASSY Y N N N

2369818 P9536BG A/N KBD ASSY Depends Y Y Y Replaceable only on KBD 2344632,

2344632-2,5138507, 5138507-2

2369816 P9536BR KEY ACCESSORY Depends Y Y Y

Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2  Contains

A/N Key Tops
Clear Caps

Labels for clear caps
Knobs for rotally encoders

TGS Slid Caps

2369816-2 P9536BR KEY ACCESSORY Depends Y Y Y

Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2  Contains

A/N Key Tops
Clear Caps

Labels for clear caps incl.4D
Knobs for rotally encoders incl.4D

TGS Slid Caps

2369826 P9536BB ROTARY ENCODER ASSY Depends Y Y Y Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2

2369817 P9536BP I/F BOARD ASSY Depends Y Y Y Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2

2369825 P9536BA LCD UNIT N N N N Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2

2369815 P9536BQ SW BOARD ASSY v Y Y Y Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2

2369822 P9536BF TGC ASSY Depends Y Y Y Replaceable only on KBD 2344632,
2344632-2,5138507, 5138507-2

2369823 P9536BE TRACKBALL ASSY Depends Y Y Y Replaceable on any KBD

2344632-3 P9534XK KEYBOARD ASSY Y Y N N 2369825(TouchPanel) cannot be
assembled on 2344632-3.

5138507-3 SVC KEYBOARD LOGIQ7 Y Y Y Y Cost reduction from previous KBD

2301857 P9536SD LAMP ASSY Y N N N
5117796 LAMP STAY ASSY OPA L7 N Y Y Y
2301853-4 P9536RB TASK LAMP ASSY Y Y Y Y
2357676 P9536RK LIGHT BULB Y Y Y Y Light Bulb only (lower level of 2301853-4)
5117485 ?FCON Cable Assy N Y Y Y
5117795 ?FOOT SW Bracket ASSY N Y Y Y

FRU Part# Description

FRU compatibility
BT09 ～
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5-2-1-4 Front End

Figure 5-29   Front End- FRU Compatibility
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2357804-2 P9536CA DDBF SVC N N N N 32ch
2399312 P9535CL DDBF64 ASSY Y Y Y N 64ch
5182379 DDBF128 ASSY CSL L7 N N N Y 128ch/use with EBUS4
2315492 P9538JD NEST BD JIG Y Y Y Y
2264606-2 P9535AU MDBRG ASSY N N N N
2264606-3 P9535AU MDBRG ASSY N N N N Noise reduction on BT04

2264606-4 P9535AU MDBRG ASSY Y Y+ N N +Y if upgraded from BT04~BT06 but not BT06-2

2264606-5 P9535AU MDBRG ASSY Y Y+ N N +Y see comment above
6T Issue solved from -4 or lower version

5145999 MDBRG2S ASSY CSL L7 N Y* Y Y MDBRG2S only on BT06-2 console  (MDBRG2S
= MDBRG+SINANO2,  Insert to SINANO2 slot )
*Y if upgraded from BT06-2

5145999-2 MDBRG2S ASSY CSL L7 N Y* Y Y Improvement for Memory Test false fail.  Previous
parts can still be used as FRU

2271702-2 P9535BA EBUS ASSY N N N N
2399317 P9535FA EBUS2 ASSY Y N N N Only for Upgraded BT04 from BT01/02/03
5111348 EBUS3T ASSY CSL LOGIQ7 N Y Y N Upper
5112465 EBUS3B ASSY CSL LOGIQ7 N Y Y N Bottom
5182215 EBUS4T ASSY CSL L7 N N N Y
5182757 EBUS4B ASSY CSL L7 N N N Y
2273295 P9535BC MDCON ASSY N N N N No need in BT04system
2264608-3 P9535AY MOTHER ASSY N N N N
5111345-2 MOTHER2 ASSY CSL LOGIQ7 N Y Y Y
2264596-2 P9535AE PREA ASSY N N N N 32ch
5119039 PREA2F ASSY CSL LOGIQ7 N Y Y Y 64ch
2393853 PREA2H ASSY CSL LOGIQ7 Y N N N Only for Upgraded BT04 from BT01/02/03
2264604-2 P9535AS PROMP ASSY N N N N No need in BT04/BT06system
2304617-5 P9538HW QCON ASSY Y Y Y Y Noise reduction on BT04
2264602-3 P9535AQ SINANO ASSY N N N N
2374744 P9535BQ SINANO2 ASSY Y Y N N
2277244-4 P9535AG STCW ASSY Y Y Y Y
2268026 P9535BY TERMINATOR ASSY Y Y Y Y
2323353-4 P9535BJ TRAP2 ASSY N N N N 32ch

5118342-3 BTRAPHV   ASSY N Y N N 64ch.  Countermeasured against HVL current
control with full heigh HVPS.

5154321 BTRAPP5AHV Assy Y N Y Y P5A  64ch.

2323450-4 P9535GA TRAPCW ASSY N N N N TRAP + TXCW
5111346 LOGIQ7 BTXCW ASSY Y Y Y Y BTXCW only (piggy board)
5244917 MOTHER2A ASSY CSL LOGIQ7 N N N N
2305111-3 ?TX CABLE ASSY Y Y Y Y

FRU Part# Description

FRU compatibility
BT09 ～
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5-2-1-5 Backend

Figure 5-30   Backend - FRU Compatibility
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5119906-2 BCOMPSW3 SVC CSL L7
(w/o Video Card) Y Y N N

No Video card mounted. Need to reuse Video Card
when BECOMP3 replace to this new one.     Pentium 4
(BEP3)  PCMother +CPU+PC2IPB+ATX
+Ethernet+HDD+Chasis +Memory+ MiscParts

5119906-3 BCOMPSW3 SVC CSL L7
(w/o Video Card / PC2IP) Y Y Y N

No Video card/PC2IP/FALCON mounted. Need to
reuse Video Card / PC2IP/FALCON when BECOMP3
replace to this new one.     Pentium 4 (BEP3)
PCMother +CPU+ATX +Ethernet+HDD+Chasis
+Memory+ MiscParts +BaseImageCD

5119906-4 BCOMPSW3 SVC CSL L7
(w/o Video Card / PC2IP) Y Y Y N

No Video card/PC2IP/FALCON mounted. Need to
reuse Video Card / PC2IP/FALCON when BECOMP3
replace to this new one.     Pentium 4 (BEP3)
PCMother +CPU+ATX +Ethernet+HDD+Chasis
+Memory+ MiscParts +BaseImageCD

5308149 SVP-BECOMP4-L7 N N N Y

No Video card/PC2IP/FALCON mounted. Need to
reuse Video Card / PC2IP/FALCON when BECOMP4
replace to this new one.    Core2 DUO (BEP4)
PCMother +CPU+ATX +Ethernet+HDD+Chasis
+Memory+ MiscParts

5316350 SVP BECOMP4 PARTS N N N Y
Misc. parts for BEP4.  Parts include SATA
signal/power cable for HDD, DVI-VGA connector,
BEP4 internal USB cables and BEP4 Label

2304809-2 P9536RH BATTERY PACK Y Y Y Y
5118511 Extended MEMORY3 LOGIQ7 Y Y Y N Never be used on BEP2/BEP4
5306528 DDR2 MEMORY4 1GB N N N Y
5118510 HD LOGIQ7 Y Y Y N 80GB PATA
5306526 SATA HDD 160GB N N N Y 160GB SATA type.  To be used with BEP4
5179643 HDD For Consip L7 Console N N N N 160GB PATA type

FC200656 PC2IP II B Y Y* N N Only supported by BECOMPSW3
*Y if BT04/BT06 / N if BT06-2/V65x/BT07~

FC200755 PC2IP 3 N N Y Y PC2IP3 need R620 application

2362887 P9536TK AGP BOARD ASSY Y Y+ N N G550 Video Card AGP Type for CRT console
'+Y if CRT console

5111298 DUAL DVI AGP N Y$ Y N SONO64 Video Card AGP Type : Only for LCD System
'Y$ if LCD console

5121039 PCI VGA N Y$ Y N G450 Video Card PCI Type : Only for LCD System
5306525 PCI Express Graphic board N N N Y Matrox P690 Video Card for PCI-E slot
5142743 BECOMP3 Rear Fan Assy Y Y Y Y Common for BEP3/BEP4

TBD SCSI Card Y N N N Mounted only on Upgraded BT04/BT06 system in
BECOMP3 for MOD Connection

5147460 FALCON Capture Board N Y% Y Y
VideoCapture Board directly from REAN3 on BT06-2
console
Y% if upgraded from BT06-2/V65x~ (with REAN3)

5169391 ? YC Cable (S-Video) N Y% Y Y
Cable that connects VideoCapture Board between REAN3

on BT06-2 console
Y% if upgraded from BT06-2/V65x~ (with REAN3)

2384944 P9536CE DGPCIO/VIC_SVC N N N N Only suppoted by BEP2. Even if BEP2 mounted, if PCVIC
is mounted, order PC2IO/VIC for BT01 console.

5133526 DGPCIO VIC 2-A ASSY Y Y Y N Updated for LCD
2389075 ? PCI CABLE Y Y Y Y
5301220-2 PCI-DGVIC2 Assembly N N N Y
5257226 BulkHead for L7 and LS6 N N N Y
5257231 Cable13 for BulkHead N N N Y
5257233 Cable25 for BulkHead N N N Y

FRU Part# Description

FRU compatibility
BT09 ～
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5-2-1-6 Power Units

Figure 5-31   Power Units- FRU Compatibility
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D

R
8.0.X (B

EP4)
comment

2304538-4 P9534WP AC POWER BOX 200V Y N N N Include AC BOX, AC Code, and extention cable

2384371 P9534XL AC POWER BOX ASSY JPN Y N N N
Include AC BOX, AC Code, and extention cable
(Only for Japan)

2384370 P9534XP AC POWER BOX ASSY 100V Y N N N
Include AC BOX, AC Code, and extention cable
(not for Japan)

2304624 P9538JC CONSOLE FAN SSY N N N N
5117493 CONSOLE FAN ASSY 2 CSL L7 N Y Y Y
5122614 CONSOLE FAN ASSY-A UPG L7 Y N N N Only for Upgraded BT04 from BT01/02/03
2372387 P9534XH L7HV-SVC Y Y Y Y
2334197 P9534WU LV-2 SERVICE UNIT Y N N N Compatible with 2283531 (LV)
2292209 P9534WF SSR PANEL Y N N N
2315585 P9534WR FUSE FOR SSR PANEL Y N N N
2283530 P9534WB MAIN TRANS Y N N N
2373331-2 MAIN TRANS2 ASSY CSL L7 Y Y Y Y
5117721 LV-04 UNIT MAIN PS L7 N Y Y Y
5118824-2 LV-04 UNIT with Cables  N Y Y Y Noise Improvement
5117723 NF INLET ASSY MAIN PS L7 N Y Y Y
5117724 AC IN OUT 100V MAIN PS L7 N Y Y Y
5117725 AC IN OUT 200V MAIN PS L7 N Y Y Y
5118052 AC IN200 OUT100 ASSY MAIN PS L7 N Y Y Y Only for Korea System
5117726 SSR PCB ASSY MAIN PS L7 N Y Y Y
5117727 FUSE HOLDER MAIN PS L7 N Y Y Y
5117728-3 CONN ASSY MAIN PS L7 N Y Y Y
5119119 SSR-HLV CABLE N Y Y Y
5119120 SSR-AC PANEL CABLE N Y Y Y
5119121 VOLTAGE SEL CABLE N Y Y Y
2301858-3 ? PW SW ASSY N Y Y Y
5117493 CONSOLE FAN ASSY2 N Y Y Y
5117491 FAN CABLE BRAKET ASSY N Y Y Y

FRU Part# Description

FRU compatibility
BT09 ～
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5-2-2 Hardware Identification Tip

5-2-2-1 LCD Monitor Differences
The flowchart below describes how to differentiate LCD monitor type.

Figure 5-32   LCD monitor- How to Differentiate

GPN Identification Mark
(Bottom of LCD monitor)
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5-2-2-1 LCD Monitor Differences (cont’d)
LCD Variation Tips:

• Bezel Shape
- Curvy for 17 inch
- Straight for 19 inch

• GE Logo
- Silver for 17 inch
- Silver on black background for 19 inch

Figure 5-33   LCD Variation Tips
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5-2-2-2 BT09_SV_BEP4 Configuration Variationos

Figure 5-34   BT09 Configuration Variations
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Section 5-3
Peripheral Compatibility

NOTE: For SONY D21MD (or D23MD) color printer ONLY:
The D21MD (or D23MD) printer contains the L-sized ribbon cassette and paper as a standard. 
However, the S-sized paper is recommended for LOGIQ 7 system. If the S-sized paper is used 
with the L-sized ribbon cassette, “Incorrect paper size setting” error occurs with no print.
So, when using the S-sized paper, change the ribbon cassette to the S-sized.

Figure 5-35   Peripheral Compatibility
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Section 5-4
Block Diagrams and Theory

5-4-1 Block Diagram (R7.5.x or later, 19 inch LCD model)

Figure 5-36    System Block Diagram (R7.5.x or later)
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5-4-2 General Information
• LOGIQ™ 7 is a phased and linear array ultrasound imaging scanner. It has provisions for analog 

input sources like ECG and phono. A dedicated Doppler probe may also be connected and used. 
• The system can be used for: 

- 2D Black and White imaging 
- 2D Color Flow 
- M-Mode Black and White imaging 
- Color M-Mode 
- Doppler
- a number of combinations of the above

• LOGIQ™ 7 is a digital beam forming system that can handle up to 192 element linear probes 
through multiplexing.

• Signal flow from the Probe Connector Panel to the Front End, to the Mid Processors and Back End 
Processor and finally to the monitor and peripherals. 

• System configuration is stored on a hard disk and all necessary software is loaded from the hard 
disk on power up.



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
5-14 Section 5-4 - Block Diagrams and Theory

5-4-3 CPU/Back End Processor (For BEP4 for BT09 or later)

5-4-3-1 BEP4 Signal Connections

Figure 5-37   BEP4 Signal Cable Connection

CPU

PW2
Keyboard, Mouse

( Not Used )

VGA ( Not Used )

USB Ports (2 ports)

MIC,  Line in/out

OPMA Conn ( Not Used )

PCI-Express slot - Graphics Card

PCI Slot  - PCIDGVIC2

PCI-Express slot (Not Used )

PCI Slot  - FALCON

PCI Slot  - PC2IP3

PCI Slot   ( Not Used )

FDD / IDE

( Not Used )

USB 4

USB5         USB6          USB3

CPU Fan

Fan2

( Not Used )

Fan 6

Fan 4

( Not Used )

SATA

LAN (one of three is used)

PW1

Memory DIMM1

DIMM2

DIMM3

DIMM4

Not Used

Not Used

SATA  HDDBulk Head

Extended USB Ports (2 ports)

Pin Header

( Power SW,

Reset SW,

HDD LED,

Power LED )

Connector Panel

ECG unit

[ Signal Cable connection in BECOMP4 for L7 ]

Extended USB Ports (2 ports)

Extended USB Ports (4 ports)

USB Ports (2 ports)

Fan 5

Fan 3

( Not Used )
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5-4-3-2 BEP4 Devices/Connectors

Figure 5-38   BEP4 Physical Configuration

Figure 5-39   BEP4 Components

Memory : 1GB (1/4bank)

PCI-Express
Graphics Card

PCI-DGVIC2

CPU : Core2 DUO

Mechanical “bracket” to 
keep boards in place

SATA 160GB HDD

USB Header (2 ch)

USB Header (2 ch)
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Mouse
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CPU Fan
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P690 Graphics BoardPCI-E1

USB Ext. (4Ch)USB5/6

USB Ext. (2Ch, Top)USB4
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4 pin CPU Power ConnPW1

DescriptionDevice/Connector

Connects to CPU FanCPU Fan

PC2IP3 Comm BoardPCI-Slot 2

Falcon Video CapturePCI-Slot 3

PCI-DGVIC2PCI-Slot 4

P690 Graphics BoardPCI-E1

USB Ext. (4Ch)USB5/6

USB Ext. (2Ch, Top)USB4

USB Ext. (2Ch, Bottom)USB3

Connects to ATX PowerPW2

Connects to 160GB HDDSATA

1GB DDR2 at DIMM1 slotMemory

4 pin CPU Power ConnPW1

DescriptionDevice/Connector

PW1

BEP4 Motherboard
- Internal Connector Locations

Memory
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DIMM2

DIMM3

DIMM4

Memory
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DIMM2

DIMM3

DIMM4

Legend
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USB 4
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5-4-3-3 BEP4 Power Connections

Figure 5-40   BEP4 AC line and DC line connection 
Connections
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5-4-3-4 BEP4 BIOS Default Values

TAB Top Menu Sub Menu1 Sub Menu2 Sub Menu3
GEYMS Custom 
Setting Ver.7008

Main

System Time -

System Date -

Legacy Diskette A: Disabled

STAT Port 1

Type Auto

Multi-Sector Transfers 16Sector (gray out)

LBA Mode Control Enable (gray out)

32 Bit I/O

Transfer Mode FPIO4/DMA2 (gray 
out)

Ultra DMA Mode Mode5 (gray out)

STAT Port 2 -

STAT Port 3 -

STAT Port 4 -

STAT Port 5 -

STAT Port 6 -

Ext. Primary Master -

Ext. Primary Slave -

Memory Cache

Cache System BIOS 
area Write Protect

Cache Video BIOS 
area Write Protect

Cache Base 0-512k Write Back

Cache Base 512k-
640k Write Back

Cache Extended 
Memory Area Write Back

Cache A000 - AFFF Disabled

Cache B000 - BFFF Disabled

Cache C800 - CBFF Disabled

Cache CC00 - CFFF Disabled

Cache D000 - D3FF Disabled

Cache D400 - D7FF Disabled

Cache D800 - DBFF Disabled

Cache DC00 - DFFF Disabled

Cache E000 - E3FF Write Protect

Cache E400 - E7FF Write Protect

Cache E800 - EBFF Write Protect

Cache EC00 - EFFF Write Protect

Boot Features

Floppy check Disabled

Halt on Errors ALL Errors

Keyboard Error Report Enabled

Summary screen Disabled

Boot-time Diagnostic 
Screen Disabled

QuickBoot Mode Enabled

Extended Memory 
Testing Just zero it
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Advanced

Advanced Chipset 
Control

Integrated Device 
Control Sub-Menu

LAN Control Sub-
Menu

LAN1 Enabled

LAN1 Option ROM 
Scan Disabled

LAN2 Disabled

LAN2 Option ROM 
Scan

USB Dev #29 Fun #0,1,2,3,7

USB Dev #26 Fun #0,1,7

PCI Express Sub-
Menu

PCI-E1 Sub-Menu PCI Express Graphics 
Port Auto

PCI-E2 Sub-Menu PCI -E Port 1 Auto

WatchDog Mode Disable

Memory Raclaiming Enabled

Default Primary Video 
Adapter Auto

IGD -Device 2: Auto

IDG - Device 2, 
Function 1: Auto

DVMT 4.0 Mode: Auto

Azalia Audio Auto

Enable Multimedia 
Timer No

Serial ATA Enabled

  Native Mode 
Operation Auto

    SATA RAID Enable Disabled

    SATA AHCI Enable Disabled

Advanced Processor 
Options

Core Multi-Processing Enabled

Machine Checking Enabled

Compatible FPU Code Disabled

Thermal Management 
2 Enabled

Set Max Ext CPUID = 3 Disabled

C1 Enhanced Mode Disabled

PECI Interface Enabled

No Execute Mode 
Mem Protection Enabled

Processor Power 
Management GV1/GV3 Only

I/O Device 
Configuration

Floppy disk controller Enable

Serial Port A: Enable

  Base I/O address: 3F8

  Interrupt: IRQ 4

Serial Port B: Enable

  Mode: Normal

  Base I/O address: 2F8

  Interrupt: IRQ 3

TAB Top Menu Sub Menu1 Sub Menu2 Sub Menu3
GEYMS Custom 
Setting Ver.7008
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Advanced 
(Cont’d)

DMI Event Logging

View DMI event log -

Event Logging Enabled

Mark DMI events as 
read -

Clear all DMI event 
logs No

Reset Configuration 
Data No

Large Disk Access 
Mode Dos

Legacy USB Support Enabled

Hardware Monitor

(Fan Rotation number 
and CPU temperature, 
etc., appears on the 
screen.)

-

Voltage Monitoring -

FAN Fail LED Indicator Disabled

Auto Fan Control Enabled

Console Redirection

Com Port Address Disabled

Baud Rate 19.2K

Console Type PC ANSI

Flow Control CTS/RTS

Console Donnection Direct

Continue C.R. after 
POST Off

Security

Set Supervisor 
Password Set

Set User Password Clear

Diskette access: Supervisor

Fixed disk boot sector: Normal

Password on boot: Disable

Power

(Blank) S1

Resume On Time Off

Resume Time 0:00:00

Chassis Intrusion 
Detect No

Power On By PCI Disabled

After Power Failur Stay Off

Boot

Boot priority order -

1 USB CDROM

2 IDE CD

3 SATA 1

4 -

5 -

6 -

7 -

8 -

TAB Top Menu Sub Menu1 Sub Menu2 Sub Menu3
GEYMS Custom 
Setting Ver.7008
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Exit

Exit Saving Changes -

Exit Discarding 
Changes -

Load Setup Defaults -

Discard Changes -

Save Changes -

TAB Top Menu Sub Menu1 Sub Menu2 Sub Menu3
GEYMS Custom 
Setting Ver.7008
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5-4-4 CPU/Back End Processor (For BT06-2 or later)

Figure 5-41   CPU/Backend Processor (BT06-2 or later, CRT)
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5-4-4 CPU/Back End Processor (For BT06-2 or later) (cont’d)

The Back End Processor grabs the data from the Image Port, stores it in a memory, performs scan 
conversion to pixel domain and drives the system RGB monitor. 

Storing Devices:

• Hard Disk Drive (HD Drive) (In the PC box)
• DVD Drive (Available from front of scanner).
• Optional Magneto Optical Drive (MO Drive) (Available from front of scanner).

Figure 5-42   CPU/Backend Processor (BT06-2 or later, LCD)
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5-4-5 Patient I/O (Option)
The optional Patient I/O is mounted at the front of the scanner with its connector panel.

Available inputs:

• PCG
• ECG
• AUX1
• AUX2

5-4-6 Top Console
The Top Console includes a Stand By/On switch, a keyboard, different controls for manipulating the 
picture quality, controls for use in Measure & Analyze (M&A), and loudspeakers for stereo sound output 
(used during Doppler scanning, inside the CRT monitor cover).

5-4-7 External I/O (Rear Panel)
The External I/O is the interface between the scanner and all external items, located at the rear side of 
the scanner.

Examples: InSite, TCP/IP network, Printer, etc.

5-4-8 Peripherals
A VCR, a Black & White Video Printer and a Color Printer may be installed onboard the scanner. These 
devices are connected to the External I/O (Rear Panel).
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5-4-9 Interconnect Cabling (BT09 or later)

Figure 5-43   Interconnect cable connection (BT09 or 
later)
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5-4-9 Interconnect Cabling (BT09 or later) (cont’d)

Figure 5-44   USB Connection (BT09 or later)
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5-4-10 Difference points between BT07 (or later) and BT06 (or earlier) Systems for 
R7.5.x 17" to 19" LCD Monitor Upgrade

For BT06 or earlier system, the DVI cable is connected directly to the monitor from the BECOMP3 via 
the DVI-HDMI adapter.

Figure 5-45   R7.5.x 17” to 19” LCD Monitor Upgrade (For 
BT07 or later)

Figure 5-46   R7.5.x 17” to 19” LCD Monitor Upgrade (For 
BT06 or earlier)
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Section 5-5
Common Service Platform

5-5-1 Introduction
The Service Platform contains a set of software modules that are common to all PC backend ultrasound 
and cardiology systems. This web-enabled technology provides linkage to e-Services, e-Commerce, 
and the iCenter, making GE’s scanners more e-enabled than ever. The Common Service Platform will 
increase service productivity and reduce training and service costs.

5-5-2 Global Service User Interface (GSUI)
GSUI is the pattern for the user interface. This interface standard will be followed by all modalities to 
achieve a common look-and-feel for service software across all GEMS products.

5-5-2-1 Internationalization
The user interfaces provided by the service platform are designed for GE personnel and as such are in 
English only. At this time there is no multi-lingual capability built into the Common Service Interface.

5-5-2-2 Service Login

5-5-2-2-1 For BT04 or later

1.) Touch Utility > Service. It will take about ten (10) seconds for activating.
2.) Make sure that CAPS is OFF (should be released or dimmed) for password entry performed later.
3.) The Service Login window for Service Platform will be shown on the monitor display.

Figure 5-47   Service Login

CAUTION If the Login window for Service Platform is not displayed on the monitor, the installation of the 
Service Platform has failed. Reload the application software or Base System Software (OS) + 
application software.  Contact a Technical Support for details.

OFF ON
OFF
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5-5-2-2 Service Login (cont’d)
4.) Select GE Service at the “Select User Level” field. 
5.) Enter the password for the Service Platform.
6.) Click on Okay.

5-5-2-2-2 For BT03 or lower:

Click on the button with the wrench icon  in the status bar at the bottom of the scanner console. This button links 
the user or the Field Engineer (FE) to the service login screen.

5-5-2-3 Access / Security
The service interface has different access and security user levels. Users are only granted access to 
the tools they are authorized to use.

NOTE: *For a GE Field Engineer, the password changes at specific intervals.

Except for iLinq, all access to the service interface is via the Network port. A modem on the scanner is 
specifically intended for iLinq use. 

Every access request, whether successful or not, will be logged into a service access log that is 
viewable to authorized users.

Figure 5-48   User Level

Table 5-2   User Level

User Level Access Authorization

Operator These service tools are normally used in-house and are protected with a special scanner configuration 
that is not allowed to leave the facility.

Administrator Use the OnLine Center access method provided by iLinq.

External Service Required for a external Service other than GE FE.

GE Service Requires a network connection and knowledge of a password.*
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5-5-3 Service Home Page
When the Common Service Desktop is started, the Service Home Page appears. The Home Page 
contains the software revision along with the hardware inventory and the results of the latest System 
Health Information. The navigation bar at the top of the screen allows the user to select from several 
tools and applications.

NOTE: When using the Common Service Desktop do NOT iconify any of the Common Service Desktop 
windows. If you iconify them they end up in the lower left-hand corner of the screen behind the Service 
Desktop Manager window and cannot be restored. Resize the windows with the mouse and move them 
as needed to make room for other windows.

Figure 5-49   Service Home Page

For BT07 or later

For BT06 or lower
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5-5-4 Error Logs Page
From the Error Logs page the Log Viewer displays five categories with pull-down sub-menus. The 
Service Interface has a log viewing tool driven by the following high-level requirements.

• Simple filtering of the scanner log(s) with filtering capabilities being a function of login access 
permissions.

• Logs are viewable by all service modes.
• Allow for multiple instances of the log viewer.
• Color-coded log entries for severity levels:

* Severity 1 - Color coded Green
* Severity 2 - Color coded Yellow
* Severity 3 - Color coded Red

• Support the transfer of logs to local and/or remote destinations

Figure 5-50   Log Page



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 5-5 - Common Service Platform 5-31

5-5-4-1 Logs
The six sub-menus of the Logs category are System, Power, Temperature, Probe, Board, and DICOM.

Figure 5-51   Log Sub-Menus (System)

Logs Descriptions

System Software bug information for software engineering to debug the software.

Power Not used for LOGIQ 7.

Infomatics Exam informations. Whenever the New patient or End Current Patient is pressed, they are reported as a log.



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
5-32 Section 5-5 - Common Service Platform

Temperature

Error (!!)

The error occurred in the temperature with “!!” mark. In the time when the error occurred, the 
message “Temp is above safe limit. Check air-filter! Shutdown in #seconds.” appears in the status 
bar and the system is automatically shut down.
The temperature which the error occurs:

• 75 degrees or higher for Rack Temperature (1)
• 65 degrees or higher for Rack Temperature (2)
• 65 degrees or higher for HV Temperature

Warning (@@)

The warning occurred in the temperature with “@@” mark. In the time when the warning occurred, 
the message “This system is overheated! Check air-filter!” appears in the status bar.
The temperature which the warning occurs:

• 70 degrees or higher for Rack Temperature (1)
• 60 degrees or higher for Rack Temperature (2)
• 60 degrees or higher for HV Temperature

Info (^^)

The information occurred in the temperature with “^^” mark to call attention. In the time when the 
information occurred, the message “Approaching the overheat limit! Check air-filter!” appears in the 
status bar.
The temperature which the information occurs:

• 65 degrees or higher for Rack Temperature (1)
• 50 degrees or higher for Rack Temperature (2)
• 50 degrees or higher for HV Temperature

Others Temperature information

Probe Displays the probe name and connector #.

Board Displays the Part #, Board #, and Dip switch revision.

DICOM Whenever DICOM data are sent, logs are reported. An error log is reported in an error status and an information log is 
reported in a normal status. (The log is command or status information specified by DICOM statement.)

Logs Descriptions
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5-5-4-1-1 Log Viewing
The Service Platform has a log viewing tool driven by the following high-level requirements.

• Simple filtering of the scanner log(s) with filtering capabilities being a function of login access 
permissions.

• Logs are viewable by all service modes.
• Allow for multiple instances of the log viewer.
• Color-coded log entries for severity levels:

* Severity 1 - Color coded Green
* Severity 2 - Color coded Blue
* Severity 3 - Color coded Red

• Support the transfer of logs to local and/or remote destinations

5-5-4-1-2 Informatics
Informatics is the ability to collect and upload usage information logged on the scanner. The Service 
Platform is used to report the logged data via the log viewing feature.

5-5-4-2 Utilities
The two sub-menu of the Utilities category are Plot Log and Plot Page.

5-5-4-3 Search
On the Text Search sub-menu of the Search category, users enter case-sensitive text they wish to filter.

Figure 5-52   Utilities Category

Figure 5-53   Search Category
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5-5-4-4 Filter
Click on he sub-menu, System Logs, to enter Filter menu. Filtering is used to extract select data from 
the Error Logs. There are four different error levels and 11 packages that can be filtered.

5-5-4-5 Exit
The sub-menu, Exit Log Viewer, returns the user to the Common Service Desktop home page.

Figure 5-54   Filter Category

Figure 5-55   Exit Category

BT04/BT06/BT06-2
or later
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5-5-5 Diagnostics
The Diagnostic page includes various diagnostic tests for troubleshooting.

5-5-5-1 Diagnostic Reports
Diagnostic tests return a report to the Service Platform. The platform retains the report and allows for 
future viewing of the diagnostic logs.

5-5-5-2 Proactive Diagnostics
A system of self-monitoring is largely supported with the integration of iLinq. The scheduler, executive, 
user interfaces, and some of the proactive diagnostic functions are provided by iLinq. Other tasks will 
need to be provided by the product team.

Figure 5-56   Diagnostic Page
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5-5-6 Image Quality
Field is not yet populated.

The Image Quality page contains tools for troubleshooting image quality issues.

5-5-7 Calibration
Field is not yet populated.

The Calibration page is used to calibrate the system.

5-5-8 Configuration
Field is not yet populated.

The Configuration page is used to setup various configuration files on the system.

The Service Platform is used as the access and authorization control for remote access to the 
configuration subsystem.

Figure 5-57   Image Quality Page

Figure 5-58   Calibration Page

Figure 5-59   Configuration Page
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5-5-9 Utilities
The Utilities page contains several miscellaneous tools. These includes access to the problem/solution 
database at the Online center.

5-5-10 Replacement
Field is not yet populated.

Figure 5-60   Utilities Page

Figure 5-61   Part Replacement Page
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5-5-11 PM
Field is not yet populated.

Run the Planned/Preventive/Proactive Maintenance tools during such PM visits as running error logs 
and deleting old test files.

5-5-12 Remote Software/Option Installation and Updates 
The Common Service Platform provides for remote software downloads including A11 downloads to the 
scanner. Any file transferred to the scanner will be in the form of an installation package. The actual 
content of the installation package is dependent on each product. The Service Platform downloads the 
software module into an appropriate directory and executes the product-specific installer executive.

Software installation is simple and automated with a Graphic User Interface (GUI), where applicable.

• Supports software upload via remote transmission
• Supports software upload via Service Platform
• Supports partial upgrades
• Supports de-installs of the latest partial upgrade
• Supports remote activation/installation of software options
• Options can be activated permanently
• Options can be activated for a timed period
• Options can be limited to a number of uses
• Options that expire must give notice to the user that the option has expired

5-5-12-1 Remote System Shutdown and Restart
The Service Platform provides the ability to restart the system as per standard shutdown/startup 
procedures. Remote shutdown will only be provided if a software-controlled shutdown exists on the 
scanner. Scanner system restart is always accessible from the OLC.

5-5-12-2 File and/or Image Transfer
The Service Platform supports file transfers and archived image transfers to the OnLine Center. The 
Service Platform provides interfaces of the displayed images for transfer to the OLC.

Figure 5-62   Planned Maintenance Page
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5-5-13 InSite II Configuration

5-5-13-1 InSite II Setting (Supported from BT07)
Select Service Platform > Configuration > Questra Agent Configuraion. Then enter the followings:

NOTE: Refer to Section 8-14 - InSite II Installation for details.

Figure 5-63   

Table 5-3   InSite II Entry

Item Descriptions Modifiable?

Device Name Should be set to Dongle ID. DO NOT MODIFY.

CRM No. FE/OLC Field to enter device identifier. Modifiable

Display Name FE/OLC Field to enter descriptive name. Modifiable

Address/Proxy Contact OLC for contents. Modifiable
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Section 5-6
Password

The following windows request entry of Password. This allows you to be entered into Utility function or 
Service function with different access and security use levels.

5-6-1 For Operator Login Window
When you login the LOGIQ7 application with a different user level, this window is open.
You can modify the user level and password without restraint using one of the Utility function (Utility > 
Admin > Users).

5-6-2 For Service Login Window
When you access the Common Service Desktop, this window is open.
The user level and password are preset. They can NOT be modified.

Figure 5-64   Operator Login window

Table 5-4   Password to enter common service desktop

User Level Password

Operator uls

Administrator uls

External Service gogems

GE Service The password must change at specific intervals. (every six month)
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5-6-2 For Service Login Window (cont’d)

5-6-3 For Maintenance Access Window
When you login Windows desktop for maintenance access, this window is open.
The user name and password are preset. They can NOT be modified..

Figure 5-65   Service Login window

Table 5-5   Password to enter windows desktop

Username Password

No entry Access is protected with the Service Dongle and a password. 
The password must change at specific intervals. (every six month) 

Figure 5-66   Windows desktop Login Window
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Section 5-7
Air Flow Control

5-7-1 Air Flow Distribution

The four air flow pathes allow the scanner to be cooled down as shown in the figure above.

• Path A (Front lower left > Filter > PC Box > Rear upper left) for PC Box cooling.
• Path B (Front lower left > Filter > LV unit > Rear lower left) for LV unit cooling.
• Path C (Bottom right > Filter > NEST Assy > Rear upper right) for NEST Assy cooling.
• Path D (Rear bottom right > Filter > HV unit > Rear upper right) for HV unit cooling.

5-7-2 Filters
The scanner contains the three filters located at:

- Front lower left for air flow of the LV unit and PC box.
- Bottom right for air flow of the NEST Assy.
- Rear bottom right for air flow of the HV unit.

Figure 5-67   Air Flow Inside the Scanner
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5-7-3 Fans

The scanner contains the eight fans at the following positions for producing an air flow.

- Two fans: Inside the LV unit for air flow path A and B
- One fan: On the PC Box for air flow path A
- Four fans: At the bottom of the NEST Assy for air flow path C
- One fan: On the HV unit for air flow path D

Figure 5-68   Fans

Fan for HV unit Fan for PC Box Fans for LV unit

Fans for NEST Assy

Example: For BT03 or lower
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Section 5-8
Monitor Video Specification

5-8-1 Input

5-8-2 Outputs

5-8-2-1 SVGA

5-8-2-2 TV Format

5-8-2-3 PAL BDGHI

Standard Format Signal Sync DDC Termination

SVGA 800 x 600 / 75 Hz RGB: 0 - 700 mV H: TTL
V: TTL

VESA DDC2 
signals 75 ohms

Standard Format Signal Sync DDC Termination

SVGA 800 x 600 / 75 Hz RGB: 0 - 700 mV H: TTL
V: TTL

VESA DDC2 
signals 75 ohms

Type Standards Termination

SVHS NTSC EIA and 
PAL BDGHI 75 ohms

Composite 
Video

NTSC EIA and 
PAL BDGHI 75 ohms

RGB NTSC EIA and 
PAL BDGHI 75 ohms

B&W NTSC EIA and 
PAL BDGHI 75 ohms

General SVHS-luma SVHS-croma Composite RGB B&W

Line/field: 625/50
FH: 15625 Hz

FV: 50 Hz
Bandwidth: 6MHz 

(luma)

Signal: 100 IRE 
100% amplitude

Sync: 43 IRE

Burst amplitude: 
+/- 21.5 IRE, 10 

cycles
Fsc: 4.43361875 

MHz 100% 
saturation

Summed luma 
and croma

Signal: 0-700 
mV 

Comp sync/H 
sync/ V sync: 0.3 

- 4 Vpp

SVHS luma
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5-8-2-4 NTSC EIA

5-8-3 SVHS and Composite Video

5-8-3-1 Basic DC Parameters

General SVHS-luma SVHS-croma Composite RGB B&W

Line/field: 525/60
FH: 15734 Hz
FV: 59.94 Hz

Bandwidth: Min. 
4.2MHz (luma)

Signal: 92.5 IRE 
(from black level) 
100% amplitude
Blanking setup: 

7.5 IRE
Sync: 40 IRE

Burst amplitude: 
+/- 20 IRE, 9 

cycles
Fsc: 3.579545 

MHz 100% 
saturation

Summed luma 
and croma

Signal: 0-700 
mV 

Comp sync/H 
sync/ V sync: 0.3 

- 4 Vpp

SVHS luma

Parameters NTSC PAL

White relative to blank 714 +/- 7 mV 700 +/- 7 mV

Black relative to blank 54 +/- 7 mV 0

Sync relative to blank -286 +/- 7 mV -300 +/- 7 mV

Burst amplitude (nominal, p-p) 286 +/- 7 mV 300 +/- 7 mV
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Chapter 6
Service Adjustments

Section 6-1
Overview

6-1-1 Purpose of this chapter 6
This section describes how to test and adjust the scanner. These tests are optional. You may use them 
to check the system for errors.

Table 6-1   Contents in chapter 

Section Description Page Number

6-1 Overview 6-1

6-2 LV Unit Adjustments (For BT03 or lower) 6-2

6-3 Caster Brake/Swivel Function Adjustments 6-4

6-4 Reloading the Probe Data 6-9

6-5 Monitor and LCD Adjustments 6-10

6-6 BW Printer Setting / Adjustment 6-27

6-7 Cleaning the Trackball 6-33

6-8 Jumper and Dip Switch Setting 6-37
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Section 6-2
LV Unit Adjustments (For BT03 or lower)

This system contains three power supply modules; LV unit. The LV unit for BT04 or later can not be 
adjusted.

6-2-1 Access to Adjustments
1.) Remove the LV unit:

a.) Remove the left side cover.
b.) Remove the LV unit cover.
c.) Remove the bracket, then pull out the LV unit Assy with the cables connected.

Figure 6-1   LV Unit Assy
LV Unit Assy
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6-2-2 Adjustments Procedures
1.) Using the following VRs, DC output can be adjusted.

Table 6-2   DC Output Specification for LV Unit

VR Specifications

VR1 3.4V +/- 34mV

VR2 5V +/- 50mV

VR3 6V +/- 60mV

VR4 -6 V +/- 60mV

VR5 12V +/- 120mV

VR6 -12V +/- 120mV

Figure 6-2   VRs for Adjusting DC Output

VR4 for -6V VR2 for +5V VR3 for +6V VR6 for -12V

VR1 for +3.4V

VR5 for +12V

OR

-6V +12V

+5V -12V
+3.3V

+6V
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Section 6-3
Caster Brake/Swivel Function Adjustments

6-3-1 Brake Function Adjustment
The LOGIQ 7 contains front and rear brake lock adjusters. They are separately adjusted using the 
similar method.

Figure 6-3   Locations of Brake Lock Adjusters

Front Brake Lock Adjuster Rear Brake Lock Adjuster
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6-3-1 Brake Function Adjustment (cont’d)

1.) Locate the adjuster nut on the caster linkage joint.

2.) Rotate the adjuster until the caster lock lever comes center as shown.
Figure 6-4   Adjuster Nut Location

Figure 6-5   Rotating Adjuster

Adjuster Nut

Center lock lever
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6-3-1 Brake Function Adjustment (cont’d)

3.) After completion of adjustment, press on the brake and check its function and location of the boss, 
connected to the caster lock arm.

Figure 6-6   Brake Function Check

Example: GOOD
Boss of the front caster in place, and brake 
properly adjusted.

Example: NO GOOD
Boss of the front caster NOT in place, and brake 
NOT properly adjusted.



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 6-3 - Caster Brake/Swivel Function Adjustments 6-7

6-3-1 Brake Function Adjustment (cont’d)

4.) Adjuster of the rear caster is also located on the caster linkage joint as shown.

5.) Turn the adjuster so that the caster lock lever is in the ceter position, as same as the front caster, 
and the link is securely in place.

Figure 6-7   Rear Caster Adjuster Location

Adjuster Nut Link

Rear Caster
Lock Arm

Boss
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6-3-2 Swivel Function Adjustment
The LOGIQ 7 contains one swivel lock adjuster. It can be adjusted using the similar method as brake 
function adjustment described above.

Figure 6-8   Locations of Swivel Lock Adjuster

Swivel Lock Adjuster
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Section 6-4
Reloading the Probe Data

This procedure will be used for troubleshooting when a image sensitivity is NOT recovered. For details, 
refer to Section 7, Troubleshooting.

This rewrites the probe data (probe delay data for beam forming) saved on the flash memories of DDBF 
and TRAP boards.

1.) Insert the Service Dongle into the USB port, located at the rear panel of the scanner.

2.) Power ON the scanner.
3.) Refer to 4-2-2-3 Entering Maintenance Mode to enter the windows desktop.
4.) Windows Desktop screen is displayed. 
5.) Erase the file, “D:\Pegasus\target\resources\Pegasus\ProbeInfo.res.”
6.) Erase the above file completely from Recycle bin, then restart the scanner.

Figure 6-9   Inserting the Service Dongle

Service Dongle

Re
c/

Ex
po
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VGA

S-Video
Out

Insite

Ethernet

VCR2 VCR1 Service

Camera
B/WColor
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For BT04 or later
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Section 6-5
Monitor and LCD Adjustments

6-5-1 CRT Monitor Contrast and Brightness Adjustment
Before calibrate the Monitor, check your PCVIC or DGVIC Part Number on the Utility Screen. The typical 
setting value changes with its Part Number.
(To enter this screen, select Utility > System > About > Additional About Information.)

To adjust the contrast and brightness:

1.) Select Calibration from the Test Pattern Utility Touch Panel. The test pattern consists of a small 
box inside a larger box.

Figure 6-10   PCVIC/DGVIC Part Number Check

Figure 6-11   Calibration
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6-5-1 CRT Monitor Contrast and Brightness Adjustment (cont’d)

2.) Press the Toggle button (1) for contrast and brightness. Confirm that the contrast (or 
brightness) indicator is displayed on the monitor. If the brightness is displayed, press the toggle 
button again.

3.) Set the Contrast according to the table below.
4.) Set the Brightness at 100. Then slowly decrease the Brightness until the inner box is no longer 

visible. Please note that the monitor response to this adjustment logs behind the button push.

Record the final brightness and contrast settings and leave this information withe the system. Generally 
speaking, do not change the controls once they have been set, the display becomes the reference for 
the hard copy device(s).

NOTE: After readjusting the monitor’s Contrast and Brightness, readjust all preset and peripheral 
settings.

Figure 6-12   Monitor Adjustment buttons

Table 6-3   Contrast Recommended Setting

Room Condition

Monitor Adjustment

Contrast
for PCVIC other than 

2349225
Contrast

for PCVIC 2349225
Contrast for DGVIC 
2349225-2 or later

Dark room for Radiology/
Cardiology

50 45 50

Dim room for Radiology/
Cardiology

60 55 60

Bright room for OB 70 65 70

Dark room for Cardiology 60 55 60

12 3
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6-5-2 19 inch LCD Monitor Brightness Adjustment
To adjust the brightness:

1.) Press the Toggle button (2) or (3) Once for brightness adjustment.

a.) Verify that Brightness is 80.
If it is not, increase brightness to press the adjustment button (3).
If it is not, decrease brightness to press the adjustment button (2).

b.) Press the button (1) Once. The brightness display disappears.

NOTE: 19 inch LCD is ONLY a brightness adjustment.

Figure 6-13   19 inch LCD Monitor Adjustment buttons

12 3



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 6-5 - Monitor and LCD Adjustments 6-13

6-5-3 17 inch LCD Monitor Contrast and Brightness Adjustment
To adjust the contrast and brightness:

1.) Press the Toggle button (1) Once for brightness adjustment.

a.) Verify that Brightness is 55.
If it is not, increase brightness to press the adjustment button (3).

b.) Press the button (1) again for confirmation.
2.) Press the Toggle button (1) Twice for contrast adjustment.

a.) Verify that Contrast is 90.
If it is not, increase contrast to press the adjustment button (3).

b.) Press the button (1) again for confirmation.
3.) Press and hold the button (1) for 30 second or more for temperature and gamma adjustment. The 

advance menu appears.

a.) Press the button (3) Once. The second item changes in pink.
b.) Press the button (1) Twice to select the temperature menu.
c.) Verify that Temperature is 15000.

If it is not, increase or decrease temperature to press the adjustment button (3) or (2).
d.) Press the button (1) again for confirmation.
e.) Press the button (3) Once. The second item changes in pink.
f.) Press the button (1) Once to select the gamma menu.
g.) Verify that Gamma is 2.6.

If it is not, increase or decrease gamma to press the adjustment button (3) or (2).
h.) Press the button (1) again for confirmation.
i.) Press the button (3) repeatedly to turn the Return in pink.
j.) Press the button (1) Once to return to the advance menu.
k.) Press the button (3) repeatedly to turn the Exit in pink.
l.) Press the button (1) Once to exit from adjustment menu.

4.) Record the final brightness, contrast, temperature, and gamma settings and leave this information 
with the system. Generally speaking, do not change the controls once they have been set, the 
display becomes the reference for the hard copy device(s).

NOTE: After readjusting the monitor’s Contrast and Brightness, readjust all preset and peripheral 
settings.

Figure 6-14   17 inch LCD Monitor Adjustment buttons

12 3



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
6-14 Section 6-5 - Monitor and LCD Adjustments

6-5-4 LCD Monitor Resolution
Should one encounter “small screen” on the LCD monitor, screen resolution must be adjusted in order 
to view full size.

1.) From the touch panel, select Utility > System > About.
2.) Click Additional About Info.
3.) Select High Resolution.

6-5-5 LCD Touch Panel Adjustment
There are two types of the touch panel LCD in LOGIQ 7 (manufactured by Gaudi or Technart).  
Depending on the LCD type on the system, adjustment procedure is slightly different.  Some models of 
LOGIQ 7 have the LCD with the cover plate.  Open the key board and remove those plate to identify the 
content:

This adjustment must be performed when always replacing:

- PC Box Assy
- Keyboard Assy
- Cable between LCD unit and PC Box

Figure 6-15   LOGO Location

Gaudi Logo Technart Logo
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6-5-5-1 For Gaudi LCD

1.) Refer to 4-2-2-3 Entering Maintenance Mode to enter the windows desktop.
2.) The following screen should appear when exiting to Windows.

3.) Check the followings:
- Proper balance of the LCD display as shown in Figure 6-17
- No Jitter (Phenomenon that a character does not move sideways)

NOTE: If the location of the LCD screen is appropriately set in center, do not proceed this adjustment 
procedures.

4.) Open the OP Panel, and hold the OP Panel using maintenance service rod. Refer to Replacement 
Procedure in chapter 8 for the procedures.

Figure 6-16   Start-up Screen

Figure 6-17   Example of LCD Bad balance

NOTICE Only when the windows desktop appears in the 17 inch CRT monitor or 17 inch LCD monitor, you can 
use Auto Adjust function. Also 640 x 480 dots pictures must be displayed on the LCD monitor to function 
Auto Adjust correctly.

Dislocation
Example

LCD Display

Display
Screen
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6-5-5-1 For Gaudi LCD (cont’d)
5.) Find out the notch to access OSD Switch located at backside of the LCD as shown in Figure 6-18.

Press the switch inside of the notch.

NOTE: Be careful not to cut fingers with notch.

6.) OSD menu is shown on the LCD display.
7.) Remove the maintenance rod, and re-install the OP Panel temporarily to use the LCD touch panel. 

Refer to Replacement Procedure in chapter 8 for the procedures.
8.) Using SELECT button, select AUTO ADJUST. The letters will be blue when it is selected.

9.) Make sure that the AUTO ADJUST is selected, then touch ENTER.
10.)LCD display Auto Adjustment procedures will be started automatically.

Figure 6-18   Switch Location

NOTICE Never select AUTO CONTRAST in this menu. Selecting AUTO CONTRAST might occur in an improper 
contrast.

Figure 6-19   OSD Softmenu 1

Notch
to access
OSD SW

10A5V1.0
MANUAL ADJUST
AUTO ADJUST
AUTO CONTRAST
EXIT

SELECT     ENTER
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6-5-5-1 For Gaudi LCD (cont’d)
11.)After finishing the Auto Adjustment procedures, the following menu is displayed on the LCD.

12.)Make sure that the LCD position is fixed and shown at the center location.
13.)If it is fixed appropriately, select OK then touch ENTER to go on to the next step.

If the display is not adjusted yet, select CANCEL then touch ENTER to repeat the adjustment 
procedures form step 6.

14.)The first screen is shown on the display. Touch SELECT three times to select EXIT. Refer to Figure 
6-19.

15.)Touch ENTER button. OSD menu will be finished, and go back to regular display.

Figure 6-20   OSD Softment 2

10A5V1.0
FINISHED
OK
CANCEL

SELECT     ENTER
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6-5-5-2 For Technart

6-5-5-2-1 Auto Adjustment

1.) Refer to 4-2-2-3 Entering Maintenance Mode to enter the windows desktop.
2.) The following screen should appear when exiting to Windows.

3.) Press the AUTO button once on the LCD touch panel board.
Figure 6-21   Start-up Screen

Figure 6-22   Auto Button

Auto Button
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6-5-5-2 For Technart (cont’d)
4.) “AutoAdjust OK” message will appear. If it does not appear. press AUTO button again.

Figure 6-23   AutoAdjust OK message

Figure 6-24   Auto Button

Auto Button
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6-5-5-2 For Technart (cont’d)
5.) Display the LCD monitor menu and visually check if auto adjustment succeeds.

- If no character blurring exits, auto adjustment succeeds. Go to 6-5-5-2-3 Completing 
adjustment.

- If character blurring exits, auto adjustment fails. Perform 6-5-5-2-2 Manual Deblurring (For 
Technart ONLY).

Figure 6-25   Blurring/No Blurring

Blurring at the right side of the character

Example: Blurring Example: No blurring
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6-5-5-2-2 Manual Deblurring (For Technart ONLY)
Perform manual deblurring only when auto adjustment fails.

1.) Refer to 4-2-2-3 Entering Maintenance Mode to enter the windows desktop.
2.) Select Program > Accessories > Paint to run the paint software.

3.) Phase Check:

a.) Drag and drop the paint screen on the touch panel screen.

b.) Click on square symbol at the top right corner of the paint screen to maximize the screen.

Figure 6-26   Paint Software

Figure 6-27   Moving Paint Screen
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6-5-5-2 For Technart (cont’d)
c.) Click on the line icon and select the thinest line.

d.) Draw a vertical line at the right side of the screen below and check if it has no deblurring.

- If deblurring exists, go to next step.
- If no deblurring exists, go to step 4- HTotal Check

Figure 6-28   Line

Figure 6-29   Drawing Line
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6-5-5-2 For Technart (cont’d)
e.) Display the LCD monitor menu and press the MENU button once. The following menu appears.

f.) Repeat to press the MENU button until the “Phase” blinks.
g.) Repeat to press the PLUS button to find the value with no character blurring. For example, this 

value is X.

h.) Set the value (X + 14) to Phase.
i.) Press the AUTO button once to save the setting.
j.) Repeat to press the MENU button until the “Exit” blinks
k.) Press the AUTO button once to exit from the menu.

Figure 6-30   Menu Screen

NOTICE You can select the number from 0-62. Values with deblurring cause are continuous seven or eight 
values. So, tips for searching the best value is to avoid such a group. This depends on video card or 
VGA cable of your scanner.
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6-5-5-2 For Technart (cont’d)
4.) Htotal Check:

a.) Display the LCD monitor menu and press the MENU button once. The following menu appears.
b.) Check HTotal value:
- If it is 16, go to step5 - Hposition/VPosition check
- If it is NOT 16, go to next step.

c.) Repeat to press the MENU button until the “HTotal” blinks.
d.) Repeat to press the PLUS or MINUS button to set 16.
e.) Press the AUTO button once to save the setting.
f.) Repeat to press the MENU button until the “Exit” blinks
g.) Press the AUTO button once to exit from the menu.

5.) Hposition/VPosition Check:

a.) Close the paint software and display windows desktop.

Figure 6-31   H Total

Figure 6-32   Start-up Screen
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6-5-5-2 For Technart (cont’d)
b.) Check the upper, lower, left, and right edge of the screen. They should be centered evenly in 

the monitor.
- If they are vertically out of alignment, adjust VPosition.
- If they are horizontally out of alignment, adjust HPosition.
c.) Display the LCD monitor menu and press the MENU button once. The following menu appears.

d.) Repeat to press the MENU button until the “HPosition” or “VPosition” blinks.
e.) Repeat to press the PLUS or MINUS button until the screen should be centered evenly in the 

monitor.
f.) Press the AUTO button once to save the setting.
g.) Repeat to press the MENU button until the “Exit” blinks
h.) Press the AUTO button once to exit from the menu.

6.) Go to 6-5-5-2-3 Completing adjustment.

Figure 6-33   H Position or V Position
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6-5-5-2-3 Completing adjustment

1.) Display the LCD monitor menu and press the left button (MENU). The following menu appears.
2.) Verify that:

- Contrast: 210
- ContrastRed: 145
- ContrastGrn: 130
- ContrastBlu: 160

3.) Verify that:
- The display does not move up, down, or sideways.
- All menu are shown in the LCD display.
- Turning the brightness knob clockwise fades in and turning it counterclockwise fades out.

Figure 6-34   Contrast

210

37

145
130
160
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Section 6-6
BW Printer Setting / Adjustment

6-6-1 Parameters for UP-D897
1.) When system started, Go to Utility > System >Peripherals, then hit Printers button in the Setup 

group.
2.) Click SONY UP-D897 in the Printer List, then right click and select "Properties".
3.) Select "General" tab, then hit "Printing Preferences ..." 
4.) Select "Layout" tab, then ...

- Set "1920x1280" into "Paper"
- Check  off into "Enlarge to Paper"
- Set "Bilinear" into "Interpolation Method"
- Set "Landscape" into "Orientation"

Figure 6-35   Printing Preferences

Bilinear
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6-6-1 Parameters for UP-D897 (cont’d)

5.) Select "Density Adjust" tab, then ...
- Set "TONE1" into "GAMMA"
- Set 7 into "Sharpness"

Figure 6-36   Printing Preferences
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6-6-2 Parameters for UP-D895
1.) When system started, Go to Utility > System >Peripherals, then hit Printers button in the Setup 

group.
2.) Click SONY UP-D895 in the Printer List, then right click and select "Properties".
3.) Select "General" tab, then hit "Printing Preferences ..." 
4.) Set "Landscape" into "Orientation", then click on Advanced...

5.) Set "1920x1280" into "Paper"
Figure 6-37   Landscape

Figure 6-38   Paper
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6-6-2 Parameters for UP-D895 (cont’d)

6.) Click on Scaling..., then check  off into "Enlarge to Paper" and set "Bilinear" into "Interpolation 
Method".

7.) Click on Density Adjust..., set "TONE1" into "GAMMA" and set 7 into "Sharpness".

6-6-3 Service Tips - Print Quality
When printer is set to “Nearest Neighbor” interepolation method, comments and body pattern may 
become hard to read.  Re-adjust interpolation method to “Bi-Linear” to avoid this situation.

Figure 6-39   Scaling

Figure 6-40   Density Adjust

Bilinear
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6-6-4 Service Tips - Print Speed

1.) Make sure that the UP-D897 is switched ON. (The back light of the LCD light is in green.) If not, 
press the ON/OFF switch.

2.) Confirm that “READY” is displayed on the LCD, then press the jog dial.
The UP-D897 enters the menu mode. When you perform a menu operation for the first time 
after you purchase the unit , the top item of the “BEEP” menu will be displayed. If you already 
have performed a menu operation, the items that you set last is displayed.

NOTICE Problem:
Compared to the UP-D895, it takes a few seconds longer for the UP-D897 to receive data from L7 
system. All that time, an user cannot operate the L7 system and must wait until the UP-D897 finished 
receiving data from the L7.

Cause:
This is due to driver software difference between UP-D895 and UP-D897. It seems the UP-D897 driver 
software has been modified from the UP-D895.

Solution:
The following actions must be required:

• UP-D897 printer: Change from UP-D897 to UP-D895 on “COMD” menu using the printer jog 
dial. This solution allows the UP-D897 to be configured to use the UP-D895 interface and driver. 
When the “COMD” is selected to “CO:895”, the response time becomes the same as the UP-
D895. Perform this section.

• LOGIQ7: Change from UP-D897 to UD-D895 using Connectivity > Service > BW Printer to 
use UP-D895 driver software.

Jog Dial
(PRESS)

READY



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
6-32 Section 6-6 - BW Printer Setting / Adjustment

6-6-4 Service Tips - Print Speed (cont’d)

3.) Turn the jog dial up or down until “COMD” is displayed on the LCD.
4.) Press the jog dial. “CO:897” is displayed.

The UP-D897 enters the mode in which you can select the driver setting. "CO:897", which is 
the driver setting for D897, is displayed on the LCD. You need to change to "CO:895" which 
is the driver setting for the D895.

5.) Turn the jog dial up or down until “CO:895” is displayed on the LCD.
6.) Press the jog dial. The LCD display changes to “COMD”. The UP-D897 completes to be set to the 

UP-D895 mode.

Notice:
With setting the UP-D897 COMD to UP-D895, the following items cannot be selected or operated from 
the jog dial.

Item No. Items Descriptions
1 GAMMA TONE4(VERY SOFT) cannot be selected.

2 GAMMA

Cannot be selected from jog dial.  It can change only from Properties of UP-D895 menu.
Corresponding type of GAMMA between UP-D895 and UP-D897 is as follows:
UP-D897 -> UP-D895
TONE1 -> SOFT (TONE3)
TONE2 -> NORMAL (TONE2)
TONE3 -> HARD (TONE1)
TONE4 (VERY SOFT) -> Not Supported

3 QTY Cannot be selected from jog dial.  It can change only from Properties of UP-D895 menu.

4 RSIZE Cannot be selected from jog dial.  It can change only from Properties of UP-D895 menu.

5 SHARP Cannot be selected from jog dial.  It can change only from Properties of UP-D895 menu.

Jog Dial

COMD

Jog Dial

CO:895
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Section 6-7
Cleaning the Trackball

1.) Power OFF the scanner.
2.) Place your fingers onto the notches of the trackball retainer ring.
3.) Rotate the retainer ring counterclockwise until it can be removed from the keyboard.

4.) Lift off the inner retainer and trackball from the keyboard.
Figure 6-41   Rotating the Retainer Ring

Figure 6-42   Removing Inner Retainer and Trackball

Retainer Ring

Inner Retainer Trackball
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Section 6-7      Cleaning the Trackball (cont’d)

5.) Wipe off any oil or dust from the trackball using a cleaner or dry cloth.
6.) Wipe off any oil or dust from the trackball housing, rollers, and small ball, using a cleaner or cotton 

bud.

NOTICE When cleaning the trackball housing, make sure not to spill or spray any liquid into the trackball housing 
(Keyboard or system). 
Avoid organic solvents that may damage the mechanical parts of the trackball assembly.
Do not apply much force to the small ball.

Figure 6-43   Cleaning TrackBall and Housing

Trackbal Housing

Cotton Bud

Roller

Roller

Small Ball
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Section 6-7      Cleaning the Trackball (cont’d)

7.) Wipe off any oil or dust from the two rollers using a cleaner or cotton bud.

NOTICE When cleaning the roller, make sure not to spill or spray any liquid into the trackball housing (Keyboard 
or system). Use either ethanol, isopropyl alcohol or VCR head cleaner to clean the trackball assembly.
Avoid other solvents that may damage the mechanical parts of the trackball assembly.

Figure 6-44   Cleaning Rollers

Rollers

Cotton Bud
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Section 6-7      Cleaning the Trackball (cont’d)

8.) Insert the trackball into the housing.
9.) Place the trackball and inner retainer into the housing with its stopper facing down.Lift off the inner 

retainer and trackball from the keyboard.

10.)Install the trackball retainer ring onto the inner retainer, then rotate it clockwise until its notches are 
set in the horizontal position.

Figure 6-45   Removing Inner Retainer and Trackball

Figure 6-46   Rotating the Retainer Ring

Inner Retainer Trackball

Inner Retainer

Stopper

Retainer Ring Notches (Set Horizontally)
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Section 6-8
Jumper and Dip Switch Setting

6-8-1 Dip Switch Setting
Normally the dip switches shall not be adjusted. In case of special needs, such as scanner upgrade, 
refer to each instructions/documentations for proper setting.

The dip switch must be set properly according to the table below. The value in the table (Dip Switch 
setting) represents the bit location as shown.

Figure 6-47   Dip Switch Setting

Figure 6-48   Bit Setting (1 to 4)

4 (lower 4 bits)

E (Upper 4 bits)

Example: “E4 (h)” is set as shown.
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6-8-1 Dip Switch Setting (cont’d)

Figure 6-49   Bit Settings (5 to 8)
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6-8-2 Jumper Setting

6-8-2-1 HDD
Always set the jumper between MASTER pins.

6-8-3 Printer Dip Switch Setting

6-8-3-1 Mitsubishi MD-3000 VCR Dip Switch Setting
This section describes Mitsubishi MD-3000 VCR communication setting.  Field Service Engineer (FSE) 
is not allowed to modify dip switch setting.  Following setting is documented for purpose of 
troubleshooting by FSE.

Figure 6-50   HDD Jumper

Figure 6-51   MD-3000 Dip Switch

Master

1 2 3 4 5 6 7 8 

ON 

OFF 

SW5001 

1 2 3 4 5 6 7 8 

ON 

OFF 

SW5001 

Serial Communicatiton USB Communicatiton 
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6-8-3-2 Accessing Dip Switch Module for inspection

1.) Remove the two screws of RS232C board plate.

2.) Remove the RS232C board from the VCR to access the dip switch.
Figure 6-52   Opening Board Plate

Figure 6-53   Removing Board

Screws

RS232C board plate

Dip Switch

RS232C Board
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6-8-3-3 CP30D Dip Switch Setting

This section describes CP30D Dip Switch setting.  Field Service Engineer (FSE) is not allowed to modify 
dip switch setting.  Following setting is documented for purpose of troubleshooting by FSE.

NOTICE
D

Do NOT change the DIP SW setting!!

Figure 6-54   CP30D Dip Switch (All OFF)

1 2 3 4 5 6 7 8 

ON 

OFF 



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
6-42 Section 6-8 - Jumper and Dip Switch Setting



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 7-1 - Overview 7-1

Chapter 7
Diagnostics/Troubleshooting

Section 7-1
Overview

7-1-1 Purpose of Chapter 7
This section describes how to setup and run the tools and software that help maintain image quality and 
system operation. Very basic host, system and board level diagnostics are run whenever power is 
applied. Some Service Tools may be run at the application level. However most software tests are 
required.

Table 7-1   Contents in Chapter 7

Section Description Page Number

7-1 Overview 7-1
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7-1-2 Diagnostic Procedure Summary
Although Diagnostics can be run in any order, the Bottom-up Confidence-Building Order outlined in this 
section:

- Provides a framework from which overall diagnostic testability can be discussed.
- Provides a top-level model that describes the confidence-building aspect of the diagnostics.
- Provides a logical step-by-step approach to system check-out and fault isolation.

There are two levels of diagnostic: board-level and system level. 

- Board-level diagnostics are intended to test functionality of a single circuit board.
- System-level diagnostics are intended to test functionary on more than one circuit board.

Unused system components (board or signals) for each diagnostic test are drawn in gray (ghosted).

NOTE: In this document, the Host includes all hardware upstream of the PCI cable. The diagnostics in this 
chapter do NOT test anything upstream of the PCI cable. Therefore, any upstream hardware or software 
must be functional before running these diagnostics.
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Chapter 8
Replacement Procedures

Section 8-1
Overview

8-1-1 Purpose of Chapter 8
This chapter describes replacement procedures for the following modules and subsystems.

8-1-2 Returning/Shipping Probes and Repair Parts
Equipment being returned must be clean and free of blood and other infectious substances.

GEMS policy states that body fluids must be properly removed from any part or equipment prior to 
shipment. GEMS employees, as well as customers, are responsible for ensuring that parts/equipment 
have been properly decontaminated prior to shipment. Under no circumstance should a part or 
equipment with visible body fluids be taken or shipped from a clinic or site (for example, body coils or 
an ultrasound probe).

The purpose of the regulation is to protect employees in the transportation industry, as well as the 
people who will receive or open this package.

NOTE: The US Department of Transportation (DOT) has ruled that “items that were saturated and/or 
dripping with human blood that are now caked with dried blood; or which were used or intended 
for use in patient care” are “regulated medical waste” for transportation purposes and must be 
transported as a hazardous material.

Table 8-1   Contents in Chapter 8

Section Description Page Number

8-1 Overview 8-1

8-2 Software Loading Procedures for BT09 (R8.x.x or later) 8-3
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Section 8-2
Software Loading Procedures for BT09 (R8.x.x or later)

8-2-1 General
This describes software loading procedures for BT09 System with BEP4 only.  For the consoles 
upgraded BT09 systems (contains BEP3 inside), follow procedure in Section 8-7 Software Loading 
Procedures (R7.5.x or later).

Also, do not attempt to apply this procedure if you are upgrading older BTs to BT09/R8.x.x.

NOTE: Be sure no images are in the clipboard or opened exams before loading base image software.

NOTE: Before loading base image software, if you are troubleshooting loss of image or patient data, 
review troubleshooting to collect information for future analysis.

8-2-2 Parts Required
- LOGIQ 7 R8.x.x Application CD
- LOGIQ7 Ghost DVD for BECOMP4: 5305206-x

8-2-3 Time Required
Approximately 1 hour

CAUTION This software can be installed for the system with software version R8.x.x.

CAUTION ILoading R8.x.x application software procedures requires basically C drives to be ghosted. In 
this case, patient image data, preset parameters, and customer data will be kept. However , in 
case full ghost will be required,  you MUST back up before starting this procedure as follows. 
For customer data safe, we recommend you to back up even for the C ghost only.
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8-2-4 Software Loading Work-flow and Check-list
This check sheet is prepared to assist a FE during software loading.

Customer Name Customer Contact 

Console # Unit ID

Unit Type

Section Item Check Parameter Result

5-2-2-2
BT09_SV_BEP4
Configuration Varia-
tionos

Check current system version before ghost/application
loading

Should be R8.x.x or later Ver.

8-2-6-1 - Disabling
USB Devices

Check if all USB printers are OFF.
Check if SCSI UP-D50 is ON.

Should be OFF. � OK     � N/A

8-2-6-2 - Save Cus-
tomer Data / Setting

Save Customer Setting User and Password � OK     � N/A

Save Customer Setting Connectivity Parameter � OK     � N/A

Save Customer Setting Option Key String � OK     � N/A

Regional Preset � OK     � N/A

8-2-7 - Install Base
System

Install Base System Select fullghost or C ghost � Full   � C only

8-2-8 - Modify Sys-
tem/Windows Set-
tings

UPS Setting Run UPSSETUP.reg � OK     � NG

Drive Letter setting CD/DVD to be Drive ‘G’ � OK     � NG

Hardware Divice � OK     � NG

LAN Parameter � OK     � NG

TCP/IP Setting Verify � OK     � NG

Date/Time Setting Verify � OK     � NG

8-2-9 - Installing
R8.x.x Application
Software

Application CD correctly recognized App loading � OK     � NG
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8-2-10 - System Set-
tings

Software Version expected version R8.x.x ver.

Check Local Data Flow Local Archive – Int.HDD � OK     � NG

Computer Name and connectivity Set parameters � OK     � NG

Software Options Check � OK     � NG

Set VCR parameters Set parameters � OK     � N/A

Set Language Set Language options � OK     � N/A

Printer Registration Set printer � OK     � N/A

Report Template Set user template � OK     � N/A

Regional Preset Set Regional Preset. � OK     � N/A

Analog Peripheral Set analog peripheral
parameters.

� OK     � N/A

UP-D897 Set UP-D897 parameter. � OK     � N/A

8-2-11 - Functional
Check

Service Platform Be able to enter SV platform � OK     � NG

Probe Recognition No artifacts or no problem’ � OK     � NG

Section Item Check Parameter Result
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8-2-5 Software Loading Steering Guide
This section and the following pages should provide detailed guide of the system and application installation 
procedures.

Figure 8-55   BT07 Software Loading Procedures

8-2-6 - PRE-INSTALLATION 
PROCEDURES

8-2-7 - INSTALL BASE SYSTEM

OS + Application
Installing

8-2-10 - SYSTEM SETTINGS

8-2-11 - FUNCTIONAL CHECK

8-2-9 - INSTALLING R8.X.X 
APPLICATION SOFTWARE

8-2-8 - MODIFY SYSTEM/
WINDOWS SETTINGS
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8-2-5-1 Processes prior to R8.x.x Installation

8-2-5-2 Processes to install R8.x.x

Figure 8-56   Pre-installation Procedures

NOTICE *1: Loading R8.x.x application software procedures requires, at minimum, C: Drives to be ghosted (as 
opposed to full ghost).  In such case, patient image data, preset parameters, and customer data will be 
maintained.  Nonetheless, for safe-keeping customer data, it is recommended to back up all data prior 
to R8.x.x installation.
In case of Full Ghost, customer data/setting must be saved for restoration after the process.

Figure 8-57   Software Loading Procedures

NOTICE *1: Do not power ON the peripherals when installing base system image.  Disconnecting LAN is also 
recommended procedure to ensure stable process.
*2: Press the N key at start of process should FE wish to abort installation process.
Pop-up window may appear to notify process in progress - FE does not have to click OK as it 
disappears automatically.
Do NOT operate mouse or keyboard during process.  It may cause abnormal system shutdown during 
installation.
The system will shut down and restart automatically during process of application loading.

 Caution Item
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POWER 
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8-2-5-3 After installation of R8.x.x

Figure 8-58   Post Installation Procedures

NOTICE *1: Verify that Probes are not connected to the scanner. Other peripheral devices such as printers 
should be turned ON at this time.
*2: If Operator logon window appears, select "adm"(administrator) and enter the password that is         
configured already (default value is no password ? just press "enter" key).
*3: If FE cannot see login window for Service Platform, then installation of the platform have failed.  FE 
must double check the installation setting, and repeat ghost/appli load procedure.
For entering password, make sure CAPS (lock) is OFF.
*4: Each computer name is unique.  Check the scanner serial number printed on the label located at 
the rear lower side of the scanner.  For example, if 123456YM1 is printed, then enter L7-123456YM1.
Regional Preset, Analog Peripheral, and UP-D897 setting must be required.
Make sure to press "Save Setting" before exiting scanner setup window, or otherwise operator cannot 
enter the new patient screen.
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8-2-6 Pre-installation Procedures

The following section describes activities necessary before system and application installation.

8-2-6-1 Disabling USB Devices

1.) Turn OFF all USB peripherals connected to the scanner.

8-2-6-2 Save Customer Data / Setting
Save the following user data.

- Patient image data (Refer to operation manual.)
Please confirm the user if the user has the Media (CD/DVD-R) that is not finalized on the system. 
You should finalize the Media before R8.x.x Upgrade.

Because once the system is upgraded to R8.x.x, The system never recognizes the no-finalized 
media (CD/DVD-R).

8-2-6-3 Operator Login Password
The Operator Login Password will be deleted even if the BECOMP is not replaced. So, write down the 
password if necessary.

CAUTION Loading R8.x.x application software procedures requires basically C drives to be ghosted. In 
this case, patient image data, preset parameters, and customer data will be kept. However , in 
case full ghost will be required,  you MUST back up before starting this procedure as follows. 
For customer data safe, we recommend you to back up even for the C ghost only.

Figure 8-59   Login Password

Parameters Descriptions

Operator Login Password

Table 8-2   Login Password
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8-2-6-4 Saving Connectivity
Before starting upgrading, write down the Connectivity Setting for back-up.

1.) Touch Utility > Connectivity on the touch panel and click the TCP/IP tab.
2.) Write down the following parameters:

Figure 8-60   TCP/IP

Parameters Descriptions (Entry for Stand-Alone System)

Computer Name

Enable DHCP This parameter must NOT be selected.

IP-Address (192.168.1.2)

Subnet Mask (255.255.255.0)

Default Gateway (192.168.1.1)

Note : For a stand-alone system, preset values of IP adress, subnet mask, and default gateway, shown above, 
must entered.

Table 8-3   TCP/IP

Remove the
Check mark.
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8-2-6-5 Software Option

1.) Touch Utility > Admin.
2.) Click on System Admin tab and write down HW Number and Installed Option Keys..

Figure 8-61   System Admin

Items Descriptions

HW Number

Installed Option Key

Table 8-4   System Admin
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8-2-6-6 Regional Preset

1.) Go to Utility > System > About.
2.) Write down the current Preset Region.

Figure 8-62   Preset Region
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8-2-6-7 Printer Registration

1.) Select Utility > Connectivity > Button.
2.) Write down the printer names which are registered to Print1 through Print4.
3.) Click on >> to add Printflow View.

Figure 8-63   Printer Registration

Button Active Image Printer

Print1

Print2

Print3

Print4

Table 8-5   Printer Registration

Select Print x 
button to 
display the 
printer name 
here.
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8-2-7 Install Base System

1.) Power OFF the scanner, wait more than 5 seconds, then power ON the scanner.
2.) Open the DVD drive and set the Ghost DVD.

DVD drive reads Ghost DVD automatically and go to next step.
3.) After loading software, when the following screen appears, press the Enter key.

NOTICE Before starting to install base system, all printer must be disconnected from the system.

Figure 8-64   Enter
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8-2-7 Install Base System (cont’d)

4.) The following screen appears. Press B then Enter to initialize the C drive

5.) Check if the message appears as reloading C: partition only, then press Enter key.
If the message appears as reloading the entire disk, press CTRL-ALT-DEL to reboot the sysytem 
and retry from procedures described in previous page.

Figure 8-65   Select B

CAUTION If you select [A], all the archive would be lost.

Figure 8-66   Enter
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8-2-7 Install Base System (cont’d)

6.) If the following screen appears, verify that OK buttton is selected, then press Enter key. (If it is not 
selected, select OK button using the arrow keys then press Enter key.)

7.) Approx. fifteen minutes later, the following screen appears. Eject the Base System Software Load 
Image DVD from the drive.

8.) To restart the system, press Ctrl + Alt + DEL key at the same time. 

Figure 8-67   OK

Figure 8-68   Ejecting DVD

NOTICE The Base System Software Load Image DVD must be stored onto the PC box cover.
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8-2-8 Modify System/Windows Settings
After Base System is successfully installed, various parameters must be properly set before proceeding to Application 
load.  The below outlines necessary system/windows setting.

8-2-8-1 UPS Setting
UPS automatically setup by Ghost. You do not need to setup it manually. You can see the message 
below on the desktop.

Please choose OK.

Table 8-6   System/Windows Settings

Item Method Proper Value

UPS Setting Automatic Setting (n/a – just load)

(Restart System)

Avance AC97 Audio Load from c:\windows\system32\drivers (n/a – just load)

(Restart System)

Drive Letter Automatic Setting but check desktop icon if not. DVD Drive = G

HW Device My Computer
  \  Properties

Various

LAN Desktop
  \  My Network Places
      \  Properties
           \  Local Area Connection Double Click to activate

TCP/IP Setting Desktop
  \  My Network Places
      \  Properties
          \  Local Area Connection
              \  Internet Protocol (TCP/IP)
                  \  Properties
                      \  Advanced
                          \  Options
                              \  TCP/IP Filter Values in ‘Permit Only’

Date/Time Start
  \  Settings
      \  Control Panel
           \  Date and Time

Proper Time Zone
Accurate Date / Time

Figure 8-69   UPS Setting
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8-2-8-2 Drive Letter Setting
If you CANNOT see this dialog at the first boot up, this dialog appears at 2nd boot up.

Please choose OK.

You should check the Drive Letter manually by Windows Explorer for double check.

- DVD Drive should be assigned to G:

If Drive letter is wrong, please double-click Remap Drive Letter icon on the desktop.

8-2-8-3 Hardware Device Check:

1.) On the windows desktop, left-click on My Computer, then right-click on Properties.

Figure 8-70   OK

CAUTION Drive F: (Swap) Letter is removed on R7.0.0EZ. (This is correct.)

Figure 8-71   Properties
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2.) The System Properties window appears. Select Hardware > Divice Manager...
3.) Verify that X or ! is not displayed.

Figure 8-72   Divice Manager

NOTICE The Eusc (Mlultifunction adapters > Eusc) might contain “!” mark, but it is no problem. Skip any of 
device driver installation procedures described below.

“!” mark on Eusc is no problem.
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8-2-8-3 Hardware Device Check: (cont’d)
4.) If X or ! is displayed:

- Left-click on the device with x mark, then rigtht-click on Enable.
- Left-click on the device with ! mark, then rigtht-click on Properties to perform the device driver 

reconfiguration. When some files are required, designate the file in the directories of 
C:\WINDOWS\SYSTEM32 or C:\WINDOWS\SYSTEM32\DRIVERS. If they are not found, 
search them using a windows search function.

5.) Close the window.
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8-2-8-4 LAN Parameter Setting

1.) On the desktop, left-click on My Network Places, then right-click on Properties...
2.) Verify that two network icons appears. (If “Local Area Connection” icon does not appear, the 

hardware failure might occur.)

3.) Using the right trackball button, double-click on Local Area Connection.
4.) When the following window appears, it will be automatically closed later.

5.) When the following window appears, right-click on Cancel.

6.) Close all windows.

Figure 8-73   Properties

Figure 8-74   Local Area Connection

Figure 8-75   Cancel
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8-2-8-5 TCP/IP Filter Setup

1.) On the desktop, left-click on My Network Places, then right-click on Properties...
2.) Double-click Local Area Connection or Local Area Connection #2 (if you do NOT find "Local 

Area Connection").

3.)  Select Internet Protocol (TCP/IP) , then click Properties button.
Figure 8-76   Local Area Connection

Figure 8-77   Internet Protocol (TCP/IP)
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8-2-8-5 TCP/IP Filter Setup (cont’d)
4.) Click Advanced... button.

5.)  Click Options tab.
Figure 8-78   Advanced

Figure 8-79   Options
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8-2-8-5 TCP/IP Filter Setup (cont’d)
6.) Select TCP/IP Filtering, then click Properties button.

Figure 8-80   TCP/IP Filtering
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8-2-8-5 TCP/IP Filter Setup (cont’d)
7.) If your system has no TCP port numbers as follows, perform these procedure to add the TCP port 

numbers. If the TCP port already have been set, skip these procedures.  (This depends on the 
network card installed in the PC box.)

* At first check mark Enable TCP/IP Filtering (All adapters).
* Check mark Permit Only in TCP ports box
* Click Add... button.
* Enter 21 (port number) as the TCP Port ,then click OK button to apply it.
* Repeat these procedures to register 21, 23, 80, 104, 512, 3003, 5800, 5801, 5900, and 

5901 for TCP ports.

Figure 8-81   TCP port number

NOTICE UDP Ports and IP Protocols must be kept default settings.

The TCP port numbers, 21, 23, 80, 104, 512, 3003,
5800, 5801, 5900, and 5901, have been set.

No TCP port number is set. They must
be set.
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8-2-8-5 TCP/IP Filter Setup (cont’d)
8.) Verify that the proper TCP port numbers are entered in TCP Ports box, then click OK buttons for all 

opened window to complete the TCP/IP Filter Setup.

9.) The following dialog box appears. Click No to proceed the other settings. (After completion of all 
system checks, the system is shut down.)

Figure 8-82   TCP/IP Filter Setup

Figure 8-83   No

NOTICE In case the last dialog box to restart the computer does NOT appear, check the TCP/IP Filter setup 
again.
Connectivity check will be performed in 8-2-10 System Settings.
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8-2-8-6 Date and Time Setting

1.) Select Start > Settings > Control Panel > Date and Time.I
2.) Click on Time Zone tab.

3.) Select the appropriate time zone.  Then click on Apply.
4.) Then click on Date & Time tab.

Figure 8-84   Date and Time

Figure 8-85   Time Zone
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8-2-8-6 Date and Time Setting (cont’d)
5.) Set the current date and time.
6.) Click on Apply.

7.) Click on OK to close the Date and Time window.
8.) Select Start > Shutdown > OK to power OFF the scanner.

Figure 8-86   Date & Time

Month and Year

Day

Time
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8-2-9 Installing R8.x.x Application Software

8-2-9-1 Installing R8.x.x Application Software

1.) Power ON the scanner. The windows desktop appears. 

2.) Insert the Application Software CD-ROM into the DVD drive. 

NOTICE You must install BT09 Base image before Application Software installation. If not, Application shows the 
error message, “Service platform is out of date. You must reghost the C drive and reinstall the software.”

NOTICE If you are attempting to install only application software, you MUST first check current Regional Preset 
Value.  Press Utility > System > About (Details in 4-2-6 - Archiving and Loading Presets for BT07 
(Including R7.5.x)).

Figure 8-87   Desktop

NOTICE At this time, the DVD writing software screen appears, but you can ignore the screen.

NOTICE Wait approx. 20 seconds until the disk can be read.
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8-2-9-1 Installing R8.x.x Application Software (cont’d)
3.) Double-click on LoadSoftware.bat.

4.) The Installation program will start, and the command prompt screen will be shown on the monitor 
as shown.

5.) Select TYPE A - BT09 with BEP4 does not have PRO version available.

Figure 8-88   LoadSoftware.bat

NOTICE 1.If wrong application software installed, the system will not work properly. 
2.You will ask confirmation twice as below. If you select wrong system (A or B) , please select "N" at the 
confirmation.
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8-2-9-1 Installing R8.x.x Application Software (cont’d)
6.) Type Y key.

NOTE: Press the N key to cancel this procedures and to power OFF the system.

NOTE: When the Information Window appears asking you to select OK, do nothing. This window will 
disappear automatically.

7.) The installation procedures will start automatically. It will take 10 minutes.

8.) After the installation procedures are completed, the system will power OFF automatically.

Figure 8-89   Y

NOTICE Do not operate with using mouse or keyboard during installation 
procedures!!! The system shall be restarted automatically during 
installation.
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8-2-10 System Settings
After application is successfully installed, various LOGIQ™ 7 system parameters must be properly set.

Table 8-7   System Settings

Item Method Proper Value

Software Version Utility
  \  System
      \  About

s/w version : R8.x.x

Image Part No. : 5305206-3

Regional Preset Utility
  \  System
      \  About
           \  Additional About Information

For the system other than “NONE”
selected as Regional Preset, resetting
MUST be required.

Computer Name Utility
  \  Connectivity
      \  TCP/IP
           \  Computer Name
           \  Enable DHCP
           \  IP Address
           \  Subnet Mask
           \  Default Gateway

Same as Serial Number
OFF
restore customer setting
restore customer setting
restore customer setting

Patient 
Database Check

Utility
  \  Connectivity
      \  DataFlow
          \  Default Data Flow 

Press Patient (Keyboard or Touch Panel)

Local Archive – Int. HD

(n/a – Automatic)

LCD Monitor Setting Press ‘Toggle Button’ for few seconds (various)

Software Option Utility
  \  Admin
      \  System Admin
           \  HW Number Same as Option Dongle ID

VCR Utility
  \  Peripherals
      \  Video Setting
      \  VCR 

PAL/NTSC-depends on region
(set accordingly)

Language pre-work (For
Japanese Only)

Utility
  \  Regional Option
      \  Language (tab)
          \  Install Files to East Asian Language

(Reboot)

ON / Apply
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Language (For Japanese
Only)

Utility
\ System

\ General
\ Language

\  Regional Option
\  Regional Option (tab)

\  Standard and formats
\  Location

\  Language (tab)
\  Details

\  Settings (tab)
\  Installed Service
\  Default Input Language

\  Advanced (tab)
\  Language

JPN

Japanese
Japan

Japanese Keyboard
Japanese

Japanese

Language (For Russian/
Greek Only)

Utility
\ System

\ General
\ Language

\  Regional Option
\  Regional Option (tab)

\  Standard and formats
\  Location

\  Language (tab)
\  Details

\  Settings (tab)
\  Installed Service
\  Default Input Language

\  Advanced (tab)
\  Language

RUS/GRK

Russian/Greek
Russia/Greece

Rus/Grk Keyboard
Russian/Greek

Russian/Greek

Table 8-7   System Settings

Item Method Proper Value



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
8-34 Section 8-2 - Software Loading Procedures for BT09 (R8.x.x or later)

8-2-10-1 Peripheral Device Connection/Setup

1.) Connect all of the peripheral devices to the scanner.
2.) Power ON all of the peripheral devices.
3.) Verify that the system boots up with no error. (It will take a few minutes.)
4.) Set up customer data saved at 8-2-6 Pre-installation Procedures.

8-2-10-2 Confirmation of the software version

1.) Touch the Utility button on the Touch Panel.

NOTE: The Operator Login window appears. Select adm (Administrator) for the Operator field.
Adm (Administrator) will be shown in the Operator field as default. 
Enter the password which is configured already (or the password might not be necessary).
Then click on Log on.

Figure 8-90   Utility

Figure 8-91   Log on

Press
Utility
button.
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8-2-10-2 Confirmation of the software version (cont’d)
2.) Touch the System button on the Touch Panel.

3.) Click on About tab. The software version will be shown on the monitor as shown. Confirm the 
following:
- Software Version (R8.x.x)
- Preset Resion (Americas, Europe, Asia, Japan, or None)
- Image Part Number (described on the Base System Software Image DVD)

Figure 8-92   System

Figure 8-93   About Tab

Press System
button.

Click on the About tab

Software Version

R 8.x..x

Base System Software CD-ROM
Part Number

xxxxxxx

Preset Region
(See 8-2-10-10 
Regional Preset.)
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8-2-10-3 Computer Name and Connection Settings

1.) Touch Utility > Connectivity.
2.) Click on TCP/IP.
3.) Type Computer Name.

4.) Verify that Enable DHCP has no check mark. If checked, remove the mark.
5.) Check if Computer name, IP Address, Subnet Mask, and Default Gateway are proper ones 

which you wrote down in section 8-2-6-4, Saving Connectivity.

6.) Click on OK for confirmation dialog box.

NOTICE The computer name is unique. Check the scanner serial Number printed on the label located at the rear 
lower side of the scanner. When 123456YM1 (for example) is printed, L7-123456YM1 must be entered 
as a computer name.

Figure 8-94   TCP/IP

NOTICE If the “Save settings” is NOT performed, you can NOT enter the new patient screen!!

Figure 8-95   OK
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8-2-10-3 Computer Name and Connection Settings (cont’d)
7.) Touch Scan on the Touch Panel to return to the scan screen.
8.) Shut down the scanner.
9.) Power ON the scanner, then press Patient key and verify that the following screen appears.

Figure 8-96   Patient 
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8-2-10-4 Check LCD Monitor Hardware Setting

For 19 inch Monitor
To adjust the brightness:

1.) Press the Toggle button (2) or (3) Once for brightness adjustment.

a.) Verify that Brightness is 80 (Dark Room) or 100 (Bright Room).
If it is not, increase brightness to press the adjustment button (3).
If it is not, decrease brightness to press the adjustment button (2).

b.) Press the button (1) Once. The brightness display disappears.

NOTE: 19 inch LCD is ONLY a brightness adjustment.

8-2-10-5 Software Option Check

1.) Touch Utility > Admin.
2.) Click on System Admin tab and verify that HW Number is the same as the Option Dongle ID.

Figure 8-97   19 inch LCD Monitor Adjustment buttons

Figure 8-98   HW Number

12 3
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8-2-10-6 VCR  Parameters Setting (for the VCR-equipped system ONLY)

1.) Touch Utility > System.
2.) Click on Peripherals tab.
3.) Set the proper parameters:

- PAL or NTSC
- VCR type

4.) Shut down the scanner, then restart the scanner.
5.) Verify that the VCR can be properly operated with no error (remote, play...) .

8-2-10-7 Regional Setup (For the system with language other than English ONLY)
For Japanese Languages

You can set up the keyboard for Japanese. If you select Japanese, the following items display or enter 
by Japanese.

• Patient name
• Exam comment in Patient screen and Worksheet
• Report/Direct Report free text, Insert Text
• Annotation, Annotation Library
• Error/Warning message
• DICOM/Worklist, Query/Retrieve, Image Storage, Printer, MPPS

Figure 8-99   Peripherals
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)

1.) Select Utility> System> General>Regional Option Menu,
2.) Click on Languages tab.
3.) Check Install files for East Asian languages.
4.) Click on Apply.
5.) The system requires the re-boot automatically, shut down the system.

Figure 8-100   Regional Option

NOTICE You do not need to change “Language used in menus and dialogs” option. It should be English.

Check

Do not
Change
English.
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
6.) In Utility> System> General, set the Language as JPN. Save this setting, but do not reboot the 

system yet.

7.) Press Regional Options, under Standards and Formats select Japanese, under Location select 
Japan. Press Apply.

Figure 8-101   General

Figure 8-102   Regional Options
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
8.) Select the Language tab, press Details, under Installed Services select the Japanese keyboard, 

under Default input language select Japanese, press Apply, Press OK.

9.) Select the Advanced tab, then select Japanese in the Language for non-Unicode programs pull-
down menu. Press Apply. Answer Yes to use files already loaded on the hard disk, then answer 
No to not reboot the system yet, press OK. Press Save and Exit the Utility screen. 

10.)Reboot the system.

11.)In Utility--> System--> General, press Regional Options. Select Language Tab and press 
Details. Remove English under Installed Services and press Apply and OK.

12.)Select Utility--> System--> About-->Additional Info menu.

Figure 8-103   Language tab

NOTICE To have the settings take effect, you MUST turn off the system and turn it back on. 
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
13.)Select Automatic Setup for Japanese Language button. Then IME configuration shall be 

automatically done.
This configuration shall setup the keyboard assignment (remove 半角かな , etc) in IME.

14.)Reboot the system.

15.)To type Japanese, press Alt+ (right side of the Escape key) to start IME (Input Method Editor).
You can use the following short cut keys.
- F6 key: Hiragana
- F7 key: Katakana
- F9 key: alphameric two-byte character
- F10 key: alphameric one-byte character

Figure 8-104   Automatic Setup for Japanese Language

NOTICE When pressing F6 Key, the following message is displayed at the status bar.
“Select the key which the macro is assigned to.”
You can ignore this message.
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
For Russian or Greek Languages

1.) In Utility--> System--> General, set the Language as Russian or Greek. Save this setting, but do 
not reboot the system yet.

2.) Press Regional Options, under Standards and Formats select Russian or Greek, under Location 
select Russia or Greece. Press Apply.

3.) Select the Language tab, press Details, under Installed Services select the Russian or Greek 
keyboard, under Default input language select Russian - Russian or Greek - Greek, press Apply, 
Press OK.

Figure 8-105   General

Figure 8-106   Regional Options
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
4.) Select the Advanced tab, then select Russian or Greek in the Language for non-Unicode 

programs pull-down menu. Press Apply. Answer Yes to use files already loaded on the hard disk, 
then answer No to not reboot the system yet, press OK. Press Save and Exit the Utility screen.

5.) Reboot the system. When your system restarts, the system appears in the selected language.
6.) To switch between the English and Russian (or Greek) keyboard, press Alt+Shift to change the 

keyboard to the Russian or Greek keyboard. 
7.) Apply the changes by pressing Apply. Press OK TWICE.

Figure 8-107   Advanced tab

NOTICE To have the settings take effect, you MUST turn off the system and turn it back on.
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
For non-Russian / Greek Languages

1.) Press Regional Options, select the Language tab, press Details, and comfirm default input 
Languarge to English (United States) International.

NOTICE If the system is used at U.S., press Regional Options > Language tab, press details, change default 
input Languarge to "US".

Figure 8-108   Text Services and Input Languages
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8-2-10-7 Regional Setup (For the system with language other than English ONLY) (cont’d)
2.) Select the Advanced tab, then select the language in the Language for non-Unicode programs pull-

down menu. Press Apply. Answer Yes to use files already loaded on the hard disk, then answer 
No to not reboot the system yet, press OK. Press Save and Exit the Utility screen.

3.) Reboot the system. When your system restarts, the system appears in the selected language.
4.) To type foreign characters, press Alt+Shift to change the keyboard to the international keyboard, 

then press and hold down the Alt GR+appropriate keyboard key.

Figure 8-109   Advanced tab
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8-2-10-8 Printer Registration

1.) Verify that the power switches of the printer and scanner are turned ON.
2.) Select Utility > Connectivity > Button.
3.) Select the Printer1 button and select the user defined printer which has been recorded in 8-2-6-7 

Printer Registration.
4.) Click on >> to add Printflow View.

Figure 8-110   Printer Registration

1. Select the 
button the 
SONY UP-
D21(or 23)MD 
should be 
assigned.

2. Select the user defined printer. 3. Click on >>.
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8-2-10-8 Printer Registration (cont’d)
5.) Verify that the user defined printer is added in Printflow View.(Example shown: UP-D21(or 23)MD)
6.) For UP-D50 ONLY:

When performing 4 divided frame print in the active image screen, select D50 for Active Image 
Printer.

7.) For UP-D21 or UP-D23:
When upgrading to BT07, updated printer driver may be loaded and assigned. Before assigning 
Print Button to Printer, check 'DEVICE' Tab for multiple UP-D21/23 Printer, and check for active 
printer.

8.) Right-click on Save.

Figure 8-111   Save

1. Verify 
that the 
user 
defined 
printer is 
added.

2. SAVE.

For UP-D50 
ONLY: Select 
D50 for 4 
divided frame 
print.
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8-2-10-9 Report Template (only for BT04 system)
Please setup the user template as it is.

Figure 8-112   Report Template
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8-2-10-10 Regional Preset

9.) Touch Utility > System.
10.)Click About tab.
11.)Click Additional About Information.
12.)Check the region name of Preset Region (Rquires reboot):

If it is None, skip this section.

13.)Click Reload Factory Default button.
14.)Click OK on confirmation dialog box.

This changes Preset Region (Requires reboot) to None.

NOTICE For the system other than "NONE" selected as Regional Preset, resetting MUST be required.

Figure 8-113   Preset Region

Figure 8-114   Reload Factory Default
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8-2-10-10 Regional Preset (cont’d)
15.)Click the button Reload **** Preset corresponding you noted.

16.)Click OK on confirmation dialog box.
Figure 8-115   Reload buttons

Figure 8-116   OK
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8-2-10-10 Regional Preset (cont’d)
17.)Check Preset Region (Requires reboot): is right region you selected.

8-2-10-11 Analog Peripheral
After you update software version to R8.x.x, you may need to adjust peripheral settings.

Figure 8-117   Preset Region
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8-2-10-12 UP-D897 Parameter

1.) When system started, Go to Utility > System >Peripherals, then hit Printers button in the Setup 
group.

2.) Click SONY UP-D897 in the Printer List, then right click and select "Properties".
3.) Select "General" tab, then hit "Printing Preferences ..." 
4.) Select "Layout" tab, then ...

- Set "1920x1280" into "Paper"
- Check  off into "Enlarge to Paper"
- Set "Bilinear" into "Interpolation Method"
- Set "Landscape" into "Orientation"

Figure 8-118   Printing Preferences

Bilinear
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8-2-10-12 UP-D897 Parameter (cont’d)
5.) Select "Density Adjust" tab, then ...

- Set "TONE1" into "GAMMA"
- Set 7 into "Sharpness"

Figure 8-119   Printing Preferences
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8-2-10-13 Setting Report Printer

1.) Press UTILITY > SYSTEM in Touch Panel.
2.) Click PERIPHERAL > Printers.

3.) Find Printer to be used for REPORT, right-click and select Set as Default Printer.

Figure 8-120   Printer Setup

Figure 8-121   Setting Default Printer
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8-2-11 Functional Check

8-2-11-1 Service Platform

1.) Click on Utility > Service. It will take about ten (10) seconds for activating.

Figure 8-122   Service
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8-2-11-1 Service Platform (cont’d)
2.) Make sure that CAPS is OFF (should be dimmed) for password entry performed later.
3.) The Service Login window for Service Platform will be shown on the monitor display.

4.) Select GE Service at the “Select User Level” field. 
5.) Enter the password for the Service Platform.
6.) Click on Okay.

Figure 8-123   Service Login

CAUTION If the Login window for Service Platform is not displayed on the monitor, the installation of the 
Service Platform has failed. Reload the application software or Base System Software (OS) + 
application software.  Contact a Technical Support for details.

Figure 8-124   User Level

OFF ON
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8-2-11-1 Service Platform (cont’d)
7.) Verify that the following screen (Service Platform) is displayed on the monitor.
8.) Verify that Service Platform Version is 2.2.0Q.
9.) Click on x located at the upper right corner of the service platform screen to close the Service 

Platform and return to the scan panel.

8-2-11-2 Functional Checks for Probe Recognition

1.) Touch Scan button on the Touch Panel to return to the scan screen.
2.) Connect each probe to ensure that they are recognized.
3.) Check every probe in the following modes and ensure that no artifacts or no problems are found in:

- B-mode
- Color FLow
- Pulsed Doppler
- M-mode
- CW (option)

4.) Install the removed parts in the reverse order of removal.

8-2-11-3 Calibration and adjustment
No calibration or adjustments are needed after this part replacement.

Figure 8-125   Service Platform

NOTICE When the service platform is NOT displayed, check if CAPS lock is selected.  The CAPS should not be 
selected.
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8-2-11-4 Functional Checks
Perform the following functional tests to confirm the system is operational before returning the system 
to the customer. If all are successful, include the following debrief script:

Table 8-8   Functional Tests

See 
Section Functional Test Debrief Script

4-2-2-1 Power Up LOGIQ 7 Proprietary Service Manual, Direction 
2286865, Rev 14, Section 8-2. Equipment 

passed all required tests and is ready for use.4-2-2-2 Power Up Sequence
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Chapter 9
Renewal Parts

Section 9-1
Overview

9-1-1 Purpose of Chapter 9
This chapter gives you an overview of Renewal Parts for LOGIQ™ 7.

Section 9-2
List of Abbreviations

• Assy - Assembly
• Ctrl - Control
• FRU 1 - Replacement part available in part hub
• FRU 2 - Replacement part available from the manufacturer (lead time involved)
• Int - Internal
• I/O - Input/Output
• KB - Keyboard
• LCD - Liquid Crystal Display
• MON - Monitor
• PAT. - Patient
• PC - Personal Computer (Back End Processor)

Table 9-1   Contents in Chapter 9

Section Description Page Number

9-1 Overview 9-1

9-2 List of Abbreviations 9-1

9-3 Renewal Parts List For BT09 9-2

9-4 Renewal Parts List For R7.5.x 9-5

9-5 Renewal Parts List For BT07 9-8

9-6 Renewal Parts List For V65x 9-13

9-7 Renewal Parts List For BT06-2 or later 9-17

9-8 Renewal Parts List For BT06-2 CONSIP (SOI) 9-23

9-9 Renewal Parts List For BT04 and BT06 9-25

9-10 Renewal Parts List for BT03 or lower 9-57
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Section 9-3
Renewal Parts List For BT09

This section describes the BT09 system FRU.

9-3-1 BT09, 19inch LCD: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-2   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5309921 1 100V, NTSC

OPERATOR CONSOLE ASSY 5309922 1 1 120V, NTSC

OPERATOR CONSOLE ASSY 5309923 1 1 220V, PAL

OPERATOR CONSOLE ASSY 5309924 1 220V, NTSC

LOGIQ7 R8.0.0 Application Software CD 5311031-3 1 1 1 1 1 1

LOGIQ7 Ghost DVD for BECOMP4 5305206-3 1 1 1 1 1 1

LOGIQ7 BT09 eDoc CD 5307396-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1

MSDS FOR KAO ACOUSTIC GEL 2384010 1

GEL AQUASONIC GEL U0403BD 1 1 1 1 1

PARKER AQUASONIC100 2384142 1 1 1 1 1

CD-R Media 700MB 5118386 1 1 1 1 1 1

DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1

KEY LABEL2 2360321 1 1 1 1 1 1

LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1

WARRANTY CARD P9889AH 1

L7 Tempu-Bunsho for R6.5.X 5182547 1

AIUM Safety Pamphlet 5118349 1

AIUM Safety Pamphlet License 5123992 1

AC CORD 100V JPN 2371416 1

AC CORD 100V USA 2371417 1 1

AC CORD 200V EU 2371418 1 1

AC CORD 200V CHIN 2371415-2 1

P9538UA POWER CABLE TAG 2304574 1 1

SFDA LABEL L7 5149899 1

CAUTION TEL LABEL L7 2290996-3 1 1 1 1 1

CAUTION TEL LABEL CHINA L7 2290996-4 1

P9524QE ETL.ETL-C LABEL 2135339 1 1 1 1

SONIC AuthorScript Data SDK Software 
License

5178485 1 1 1 1 1 1

CrossBeam Option 2394377 1 1 1 1 1 1

SRI Option 5119471 1 1 1 1 1 1

Caution sheet for Power cables - US 5180867 1

CHINA RoHS EFUP 20 LABEL 5196197 1

LOGIQ 7 Ceritification of Quality 
Inspection for China

5229809 1

L7 L7P LS6 Addendum for Guidance and 
manufacturer's declaration

5197395 1 1 1 1 1 1

VERMONT HG LABEL 5241494 3 3 3 3 3 3

LOGIQ7 V750 STYLE_J LCD JPN (5304556)

LOGIQ7 V750 STYLE_J LCD USA (5304556-2)

LOGIQ7 V750 STYLE_J LCD EU (5304556-3)

LOGIQ7 V750 STYLE_J LCD KOREA (5304556-4)

LOGIQ7 V750 STYLE_J LCD ASIA120(5304556-5)

LOGIQ7 V750 STYLE_J LCD ASIA220(5304556-6)
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9-3-2 BT09 Parts
The following parts are new for BT09 but other parts are common with BT06. For Common Parts not 
listed here, refer to Section 9-4 - Renewal Parts List For R7.5.x.

Figure 9-1 BT09 Parts

Table 9-3   BT09 Parts

Item Part Name Part Number Description Qty FRU

1 SVP-BECOMP4-L7 5308149 Device cards and UPS batteries not included 1 1

2 DDR2 MEMORY4 1GB 5306528 DDR-2 667 (1GBx1) 1 1

3 SATA HDD 160GB 5306526 Serial ATA interface (both Signal and Power 
connectors are SATA) 1 1

4 PCI Express Graphic board 5306525 Matrox P690  PCI-Express Slot 1 1

- SVP BECOMP4 PARTS 5316350 Small parts collection for BEP4 1 1

5 PCI-DGVIC2 Assembly 5301220-2 Video/Signal Interface 1 1

6 BulkHead for L7 and LS6 5257226 3 connectors in sheet metal 1 1

2 3

5

4 11 12 13

9
14 16

10

1 7

8

6

15 17 18

1
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7 Cable13 for BulkHead 5257231 Internal 26pin flat cable -between PCI-DGVIC2/
Bulkhead 1 1

8 Cable25 for BulkHead 5257233 Internal 50pin flat cable -between PCI-DGVIC2/
Bulkhead 1 1

9 SVP REAN4 PANEL 5314714 Metal plate with PCB board 1 1

10 SVP REAN4 USB CBL 5314713 USB Cables with metal plate 1 1

- FRU Part LCD CABLE DUCT ASSY L7. 
No RGB Cable 5309932

Main duct cable.  This part same as previous duct 
cable FRU 5117797 but without Analog RGB 

signal BNC cables
1 1

11 DDBF128 ASSY CSL L7 5182379-2 1 1

12 EBUS4T ASSY CSL L7 5182215 1 1

13 EBUS4B ASSY CSL L7 5182757 1 1

14 Mitsubishi CP30DW COLOR PRINTER 5310492 For market globally 1 1

15 Mitsubishi CP30D COLOR PRINTER for 
Japan 5310491 For use in Japan only 1 1

16 VCR MD-3000 JPN NTSC USB Control 5212446 For use in Japan only 1 1

17 VCR MD-3000 EURO PAL USB Control 5199397 For use in EU (or other areas with PAL system) 1 1

18 VCR MD-3000 USA NTSC USB Control 5213259 For use in USA Only (or other areas with NTSC 
120V In/Out) 1 1

- R8.0.0 Application Software CD 5311031-3 R800 common software for both upgraded BT09 
and pure BT09 1 1

- Ghost DVD for BEP4 5305206-3 Base image (Ghost) for pure BT09 (BEP4 system) 
only 1 1

- Ghost DVD for BEP3 5191839-3 Base image (Ghost) for upgraded BT09 (BEP3 
system) 1 1

Table 9-3   BT09 Parts

Item Part Name Part Number Description Qty FRU
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Section 9-4
Renewal Parts List For R7.5.x

This section describes the R7.5.x system FRU.

9-4-1 R7.5.x, 19inch LCD: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-4   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5244924 1 100V, NTSC

OPERATOR CONSOLE ASSY 5244925 1 1 120V, NTSC

OPERATOR CONSOLE ASSY 5244926 1 1 220V, PAL

OPERATOR CONSOLE ASSY 5244927 1 220V, NTSC

LOGIQ7 Application Software CD R7.5.1 5252012-4 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, R7.0.0 5191839-2 1 1 1 1 1 1

L7/L7 PRO R7.5.0 eDoc CD 5257469-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1

MSDS FOR KAO ACOUSTIC GEL 2384010 1

GEL AQUASONIC GEL U0403BD 1 1 1 1 1

PARKER AQUASONIC100 2384142 1 1 1 1 1

CD-R Media 700MB 5118386 1 1 1 1 1 1

DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1

KEY LABEL2 2360321 1 1 1 1 1 1

LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1

WARRANTY CARD P9889AH 1

L7 Tempu-Bunsho for R6.5.X 5182547 1

AIUM Safety Pamphlet 5118349 1

AIUM Safety Pamphlet License 5123992 1

AC CORD 100V JPN 2371416 1

AC CORD 100V USA 2371417 1 1

AC CORD 200V EU 2371418 1 1

AC CORD 200V CHIN 2371415-2 1

P9538UA POWER CABLE TAG 2304574 1 1

SFDA LABEL L7 5149899 1

CAUTION TEL LABEL L7 2290996-3 1 1 1 1 1

CAUTION TEL LABEL CHINA L7 2290996-4 1

P9524QE ETL.ETL-C LABEL 2135339 1 1 1 1

SONIC AuthorScript Data SDK Software License 5178485 1 1 1 1 1 1

CrossBeam Option 2394377 1 1 1 1 1 1

SRI Option 5119471 1 1 1 1 1 1

Caution sheet for Power cables - US 5180867 1

CHINA RoHS EFUP 20 LABEL 5196197 1

LOGIQ 7 Ceritification of Quality Inspection for China 5229809 1

L7 L7P LS6 Addendum for Guidance and manufacturer's declaration 5197395 1 1 1 1 1 1

VERMONT HG LABEL 5241494 3 3 3 3 3 3

LOGIQ7 V750 STYLE_I LCD JPN (5244919)

LOGIQ7 V750 STYLE_I LCD USA (5244919-2)

LOGIQ7 V750 STYLE_I LCD EU (5244919-3)

LOGIQ7 V750 STYLE_I LCD KOREA (5244919-4)

LOGIQ7 V750 STYLE_I LCD ASIA120(5244919-5)

LOGIQ7 V750 STYLE_I LCD ASIA220(5244919-6)
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9-4-2 R7.5.x Parts
The following parts are new for R7.5.x but other parts are common with BT06. For Common Parts not 
listed here, refer to Section 9-5 - Renewal Parts List For BT07.

Figure 9-1 R7.5.x Parts

Table 9-5   V75x Parts

Item Part Name Part Number Description Qty FRU

- LOGIQ7 R7.5.0 Application Software CD 5252012-3 Application software in CD. This part never went to 
circulation. - -

1 LOGIQ7 R7.5.1 Application Software CD 5252012-4 Application software in CD 1 1

2 19Inch LCD Monitor for LOGIQ 5212808 19inch LCD Monitor/ Front & Rear Panel 1 1

3 L9 19 In. LCD Speaker Assembly 5199460 L/R Speakers and Bracket 1 1

4 COVER VESA ASSY L7 5248133 LCD Rear cover & Label 1 1

5 19 LCD LATCH-N-LOK CABLE 5240769 3pin to Powered USB conversion 1 1

2 3 4 5

6 7 8 9

10 11 12 13

14
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6 DVI-HDMI ADAPTOR 5240848 DVI to HDMI conversion (For Upgraded Version 
only) 1 1

- 19inch LCD ARM WITH CABLE ASSY 5245143 Obsolete.  Use FRU 5264730 to upgrade this part 
to -2 if stock remains. - -

7 19inch LCD ARM WITH CABLE ASSY 5245143-2
LCD arm with Cables assy.  Improved rotational 

limiter plate. For Korea console, Arm Joint (12(b)) 
must be re-used.

1 1

8 19 LCD DVI HDMI CABLE 5224943 Display Cable 1 1

9 19 LCD MIC SPK CABLE ASSY 5224944 Mic/Spk Cable 1 1

10 19 LCD POWER CABLE 5224942 48V Power Cable 1 1

11 ARM COVER LCD L7 5136256 Arm plastic cover / top 1 1

12 ARM JOINT COVER LCD L7 5136257 Arm plastic cover / joint.  Common part between 
17” and 19” LCD Monitor arm. 1 1

12 
(b)

FRU ARM JOINT COVER LCD L7 FOR 
KOREA 5271234 Physically the same as 5136257, but caution label 

in Korean Lanugage. 1 1

13 19inch AC DC ASSY L7 5248134 48V Power Supply (Denotes ‘Returnable’) 1 1

14 19 LCD 48V UNIT CABLE 5224941 FCON2->48V Power Supply 1 1

Table 9-5   V75x Parts

Item Part Name Part Number Description Qty FRU
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Section 9-5
Renewal Parts List For BT07

This section describes the BT07 system FRU.

9-5-1 BT07, CRT: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-6   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5191090 1 100V, NTSC
OPERATOR CONSOLE ASSY 5191824 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5191341 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5191701 1 220V, NTSC

LOGIQ7 Application Software CD 
R7.0.0

5191939-4 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R7.0.0

5191839-2 1 1 1 1 1 1

L7/L7 PRO R7.0.0 eDoc CD 5181486-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7 VER7 STYLE_H CRT JPN (5192526)
LOGIQ7 VER7 STYLE_H CRT USA (5192526-2)
LOGIQ7 VER7 STYLE_H CRT EU (5192526-3)
LOGIQ7 VER7 STYLE_H CRT KOREA (5192526-4)
LOGIQ7 VER7 STYLE_H CRT ASIA120 (5192526-5)
LOGIQ7 VER7 STYLE_H CRT ASIA220 (5192526-6)
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9-5-2 BT07, LCD: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-7   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5191499 1 100V, NTSC
OPERATOR CONSOLE ASSY 5191946 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5191853 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5191441 1 220V, NTSC

LOGIQ7 Application Software CD 
R7.0.0

5191939-4 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R7.0.0

5191839-2 1 1 1 1 1 1

L7/L7 PRO R7.0.0 eDoc CD 5181486-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7 VER7 STYLE_H LCD JPN (5193147)
LOGIQ7 VER7 STYLE_H LCD USA (5193147-2)
LOGIQ7 VER7 STYLE_H LCD EU (5193147-3)
LOGIQ7 VER7 STYLE_H LCD KOREA (5193147-4)
LOGIQ7 VER7 STYLE_H LCD ASIA120 (5193147-5)
LOGIQ7 VER7 STYLE_H LCD ASIA220 (5193147-6)
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9-5-3 BT07 PRO: Equipment Models Covered in this Chapter (LOGIQ 7 PRO)

Table 9-8   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5191006 1 100V, NTSC
OPERATOR CONSOLE ASSY 5191258 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5191436 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5191259 1 220V, NTSC

LOGIQ7 Application Software CD 
R7.0.0

5191939-4 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R7.0.0

5191839-2 1 1 1 1 1 1

L7/L7 PRO R7.0.0 eDoc CD 5181486-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7PRO 5149900 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7PRO VER7 STYLE_H JPN (5193151)
LOGIQ7PRO VER7 STYLE_H USA (5193151-2)
LOGIQ7PRO VER7 STYLE_H EU (5193151-3)
LOGIQ7PRO VER7 STYLE_H KOREA (5193151-4)
LOGIQ7PRO VER7 STYLE_H ASIA120 (5193151-5)
LOGIQ7PRO VER7 STYLE_H ASIA220 (5193151-6)
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9-5-4 BT07 Parts
The following parts are new for BT07, but other parts are common with BT06. For Common Parts not 
listed here, refer to Section 9-6 - Renewal Parts List For V65x.

Figure 9-2 BT07 Parts

Table 9-9   V65x Parts

Item Part Name Part Number Description Qty FRU

1 LOGIQ7 Base System Software Load 
Image for R7.0.0 5191839-2 Ghost image in DVD 1 1

2 LOGIQ7 Application Software R7.0.0 5191939-4 Application software in CD 1 1

3 FRU_Parts_LCD_CABLE_DUCT_ASSY 5139307-3 LCDPart / Compatible to BT04 1 1

4 FRU_Parts.LCD_TOP_BOTTOM_DSUB
_CABLE_ASSY 5198733 LCDPart / Compatible to BT04 ; replaces  

5125391 1 1

5 DVI_CABLE_TOP_LCD_L7 5189828 LCDPart / Compatible to BT04 1 1

3 5
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Section 9-6
Renewal Parts List For V65x

This section describes the V65x system FRU.

9-6-1 V65x, CRT: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-10   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5183269 1 100V, NTSC
OPERATOR CONSOLE ASSY 5183237 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5183396 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5183304 1 220V, NTSC

LOGIQ7 Application Software CD 
R6.5.0

5181894 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.5.0

5182424 1 1 1 1 1 1

L7/L7 PRO R6.5.x eDoc CD 5183312-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7 VER6.5 STYLE_G CRT JPN (5183206)
LOGIQ7 VER6.5 STYLE_G CRT USA (5183206-2)
LOGIQ7 VER6.5 STYLE_G CRT EU (5183206-3)
LOGIQ7 VER6.5 STYLE_G CRT KOREA (5183206-4)
LOGIQ7 VER6.5 STYLE_G CRT ASIA120 (5183206-5)
LOGIQ7 VER6.5 STYLE_G CRT ASIA220 (5183206-6)
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9-6-2 V65x, LCD: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-11   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5183330 1 100V, NTSC
OPERATOR CONSOLE ASSY 5183410 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5183412 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5183190 1 220V, NTSC

LOGIQ7 Application Software CD 
R6.5.0

5181894 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.5.0

5182424 1 1 1 1 1 1

L7/L7 PRO R6.5.x eDoc CD 5183312-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7 VER6.5 STYLE_G LCD JPN (5183291)
LOGIQ7 VER6.5 STYLE_G LCD USA (5183291-2)
LOGIQ7 VER6.5 STYLE_G LCD EU (5183291-3)
LOGIQ7 VER6.5 STYLE_G LCD KOREA (5183291-4)
LOGIQ7 VER6.5 STYLE_G LCD ASIA120 (5183291-5)
LOGIQ7 VER6.5 STYLE_G LCD ASIA220 (5183291-6)
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9-6-3 V65x PRO: Equipment Models Covered in this Chapter (LOGIQ 7 PRO)

Table 9-12   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5183352 1 100V, NTSC
OPERATOR CONSOLE ASSY 5183136 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5183125 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5183515 1 220V, NTSC

LOGIQ7 Application Software CD 
R6.5.0

5181894 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.5.0

5182424 1 1 1 1 1 1

L7/L7 PRO R6.5.x eDoc CD 5183312-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7PRO 5149900 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7PRO VER6.5 STYLE_G JPN (5183556)
LOGIQ7PRO VER6.5 STYLE_G USA (5183556-2)
LOGIQ7PRO VER6.5 STYLE_G EU (5183556-3)
LOGIQ7PRO VER6.5 STYLE_G KOREA (5183556-4)
LOGIQ7PRO VER6.5 STYLE_G ASIA120 (5183556-5)
LOGIQ7PRO VER6.5 STYLE_G ASIA220 (5183556-6)
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9-6-4 V65x Parts
The following parts are new for V65x, but other parts are common with BT06. For Common Parts not 
listed here, refer to Section 9-9 - Renewal Parts List For BT04 and BT06.

NOTE: For BECOMP3 replacement, the following parts must be reused:

• Extended Memory
• PC2IP3
• UPS
• DGVIC
• Video Card

- G550 for CRT
- G450 for LCD
- SONO64 for LCD

• Video Capture Board

Table 9-13   V65x Parts

Item Part Name Part Number Description Qty FRU

1 PRINTER BRACKET T.B.D. Short type, BW printer bay bracket 1 2
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Section 9-7
Renewal Parts List For BT06-2 or later

This section describes the BT06-2 or later system FRU.

9-7-1 BT06-2, CRT: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-14   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5176232 1 100V, NTSC
OPERATOR CONSOLE ASSY 5176567 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5176948 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5176508 1 220V, NTSC

LOGIQ7 Application Software CD 
R6.2.0

5174576 (Obsolete) 0 0 0 0 0 0

LOGIQ7 Application Software CD 
R6.2.2

5195941 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.2.0

5174668-2 1 1 1 1 1 1

L7 BT06-2 eDoc CD 5177295-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7 VER6 STYLE_F CRT JPN (5148046)
LOGIQ7 VER6 STYLE_F CRT USA (5148046-2)
LOGIQ7 VER6 STYLE_F CRT EU (5148046-3)
LOGIQ7 VER6 STYLE_F CRT KOREA (5148046-4)
LOGIQ7 VER6 STYLE_F CRT ASIA120 (5148046-5)
LOGIQ7 VER6 STYLE_F CRT ASIA220 (5148046-6)
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9-7-2 BT06-2, LCD: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-15   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5176713 1 100V, NTSC
OPERATOR CONSOLE ASSY 5176888 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5176300 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5176380 1 220V, NTSC

LOGIQ7 Application Software CD 
R6.2.0

5174576 (Obsolete) 0 0 0 0 0 0

LOGIQ7 Application Software CD 
R6.2.2

5195941 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.2.0

5174668-2 1 1 1 1 1 1

L7 BT06-2 eDoc CD 5177295-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7 VER6 STYLE_F LCD JPN (5148051)
LOGIQ7 VER6 STYLE_F LCD USA (5148051-2)
LOGIQ7 VER6 STYLE_F LCD EU (5148051-3)
LOGIQ7 VER6 STYLE_F LCD KOREA (5148051-4)
LOGIQ7 VER6 STYLE_F LCD ASIA120 (5148051-5)
LOGIQ7 VER6 STYLE_F LCD ASIA220 (5148051-6)
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9-7-3 BT06-2 PRO: Equipment Models Covered in this Chapter (LOGIQ 7 PRO)

Table 9-16   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5176619 1 100V, NTSC
OPERATOR CONSOLE ASSY 5176454 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5176439 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5176774 1 220V, NTSC

LOGIQ7 Application Software CD 
R6.2.0

5174576 (Obsolete) 0 0 0 0 0 0

LOGIQ7 Application Software CD 
R6.2.2

5195941 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.2.0

5174668-2 1 1 1 1 1 1

L7 BT06-2 eDoc CD 5177295-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7PRO 5149900 1

AC CORD 100V JPN 2371416 1
AC CORD 100V USA 2371417 1 1
AC CORD 200V EU 2371418 1 1
AC CORD 200V CHIN 2371415-2 1

LOGIQ7PRO VER6 STYLE_F JPN (5148056)
LOGIQ7PRO VER6 STYLE_F USA (5148056-2)
LOGIQ7PRO VER6 STYLE_F EU (5148056-3)
LOGIQ7PRO VER6 STYLE_F KOREA (5148056-4)
LOGIQ7PRO VER6 STYLE_F ASIA120 (5148056-5)
LOGIQ7PRO VER6 STYLE_F ASIA220 (5148056-6)
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9-7-4 BT06-2 Parts
The following parts are new for BT06-2, but other parts are common with BT06. Parts not listed here 
are common with BT06. For BT06-2 Parts, refer to Section 9-9 - Renewal Parts List For BT04 and BT06.

NOTE: Software R6.2.x and later is required to support the hardware listed above.

NOTE: For BECOMP3 replacement, the following parts must be reused:

• Extended Memory
• PC2IP3
• UPS
• DGVIC

Figure 9-3 BT06-2 Parts

Table 9-17   Monitor

Item Part Name Part Number Description Qty FRU

1 MDBRG2S 5145999 1 1

2 Capture Board 5147460 1 1

3 Rear Panel 5174604 1 1

4 YC Cable (S-Video) 5169391 1 1

5 BECOMP3 5119906-3 or 
5119906-4 Refer to 9-9-13 - HDD and Battery. 1 1

- PC2IP3 FC200755 Obsolete. Acceptable to use the part if remained in 
stock. - -

6 PC2IP3 FD200033 New PC2IP3. Fully compatible to FC200755. 1 1

7 4D Motor Controller Option 1 1

2

5 64

 1 3
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9-7-4 BT06-2 Parts (cont’d)

• Video Card
- G550 for CRT
- G450 for LCD
- SONO64 for LCD

• Video Capture Board
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Section 9-8
Renewal Parts List For BT06-2 CONSIP (SOI)

This section describes the BT06-2 CONSIP (SOI) system FRU.

The BT06-2 CONSIP (SOI) is delivered to the special ordered customer as simply configured:

• LOGIQ 7PRO (BT06-2, 220V/PAL) with LCD monitor
• Special size of HDD inside the PC box

9-8-1 BT06-2 CONSIP: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-18   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5179605 1 220V, PAL, PRO with LCD

LOGIQ7 Application Software CD 
R6.3.0 for Italy

5177651 1

LOGIQ7 Ghost3 CD for BEP3, 
R6.2.0

5174668-2 1

GEL AQUASONIC GEL U0403BD 1
PARKER AQUASONIC100 2384142 1
CD-R Media 700MB 5118386 1
DVD-R 4.7GB 8 x Speed media 5160800-2 1
KEY LABEL2 2360321 1
LOGIQ 7 WEEE instruction 5143413 1

AC CORD 200V EU 2371418
MSDS for PAKER AQUASONIC 
100

2384142 1

LOGIQ7 VER6 STYLE_F LCD Italy (5179274)
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9-8-2 BT06-2 CONSIP Parts
The following parts are unique to BT06-2 CONSIP, but other parts are common with BT06-2. Parts not 
listed here are common with BT06-2. For BT06-2 CONSIP Parts, refer to Section 9-7 - Renewal Parts 
List For BT06-2 or later and Section 9-9 - Renewal Parts List For BT04 and BT06.

NOTE: Software R6.3.x application with base image is required to support this CONSIP Console.

NOTE: For BECOMP3 replacement, the following parts must be reused:

• Extended Memory
• PC2IP3
• UPS
• DGVIC
• Video Card

- G550 for CRT
- G450 for LCD
- SONO64 for LCD

• Video Capture Board
• HDD

Figure 9-4 BT06-2 CONSIP Parts

Table 9-19   Monitor

Item Part Name Part Number Description Qty FRU

1 HDD for L7 CONSIP 5179643 HDD 160GB only for CONSIP Console 1 1

2 BECOMPSW3SVC 5119906-4
This BECOMP part contains 80GB HDD.  FE must 
either reuse HDD, or order 160GB HDD (5179643) for 
use with this part.

1 1

1
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Section 9-9
Renewal Parts List For BT04 and BT06

This section describes the BT04 and BT06 system FRU.

9-9-1 BT06, CRT: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-20   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5148047 1 100V, NTSC
OPERATOR CONSOLE ASSY 5148048 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5148049 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5148050 1 220V, NTSC

LOGIQ7 Application Software CD 
R5.0.0

5146099 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R5.0.0

5146100 1 1 1 1 1 1

L7 BT06 eDoc CD 5120980-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R Media 4.7GB 5118392 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

LOGIQ7 VER5 STYLE_E CRT JPN (5148046)
LOGIQ7 VER5 STYLE_E CRT USA (5148046-2)
LOGIQ7 VER5 STYLE_E CRT EU (5148046-3)
LOGIQ7 VER5 STYLE_E CRT KOREA (5148046-4)
LOGIQ7 VER5 STYLE_E CRT ASIA120 (5148046-5)
LOGIQ7 VER5 STYLE_E CRT ASIA220 (5148046-6)
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9-9-2 BT06, LCD: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-21   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5148052 1 100V, NTSC
OPERATOR CONSOLE ASSY 5148053 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5148054 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5148055 1 220V, NTSC

LOGIQ7 Application Software CD 
R5.0.0

5146099 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R5.0.0

5146100 1 1 1 1 1 1

L7 BT06 eDoc CD 5120980-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R Media 4.7GB 5118392 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7 5149899 1

LOGIQ7 VER5 STYLE_E LCD JPN (5148051)
LOGIQ7 VER5 STYLE_E LCD USA (5148051-2)
LOGIQ7 VER5 STYLE_E LCD EU (5148051-3)
LOGIQ7 VER5 STYLE_E LCD KOREA (5148051-4)
LOGIQ7 VER5 STYLE_E LCD ASIA120 (5148051-5)
LOGIQ7 VER5 STYLE_E LCD ASIA220 (5148051-6)
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9-9-3 BT06: Equipment Models Covered in this Chapter (LOGIQ 7 PRO)

Table 9-22   Material List

Part Name Part Number Quantity Description

OPERATOR CONSOLE ASSY 5148057 1 100V, NTSC
OPERATOR CONSOLE ASSY 5148058 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5148059 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5148060 1 220V, NTSC

LOGIQ7 Application Software CD 
R5.0.0

5146099 1 1 1 1 1 1

LOGIQ7 Ghost3 CD for BEP3, 
R5.0.0

5146100 1 1 1 1 1 1

L7 BT06 eDoc CD 5120980-200 1 1 1 1 1 1

LOGIQLEAN MIDDLE 2369384 1
MSDS FOR KAO ACOUSTIC GEL 2384010 1
GEL AQUASONIC GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
CD-R Media 700MB 5118386 1 1 1 1 1 1
DVD-R Media 4.7GB 5118392 1 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
LOGIQ 7 WEEE instruction 5143413 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SAFETY PAMPHLET License 5123992 1
SFDA LABEL L7PRO 5149900 1

LOGIQ7PRO VER5 STYLE_E JPN (5148056)
LOGIQ7PRO VER5 STYLE_E USA (5148056-2)
LOGIQ7PRO VER5 STYLE_E EU (5148056-3)
LOGIQ7PRO VER5 STYLE_E KOREA (5148056-4)
LOGIQ7PRO VER5 STYLE_E ASIA120 (5148056-5)
LOGIQ7PRO VER5 STYLE_E ASIA220 (5148056-6)
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9-9-4 BT04: Equipment Models Covered in this Chapter (LOGIQ 7)

Table 9-23   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5118054 1 100V, NTSC
OPERATOR CONSOLE ASSY 5118056 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5118057 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5118058 1 220V, NTSC
OPERATOR CONSOLE ASSY 5118059 1 STYLE D

TASK LAMP 2301853-4 1 1 1 1 1 1 1
LOGIQLEAN MIDDLE 2369384 1 1
GEL 2384010 1 1
GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
WARRANTY CARD P9889AH 1 1
HIGHLIGHT DOC 5141402 1 1
SAFETY PAMPHLET 5118349 1
SDA LABEL 2341927 1

APPLICATION CD 5118352 1 1 1 1 1 1 1
GHOST CD 5118353-3 1 1 1 1 1 1 1

DVD-R MEDIA 4.7GB 5118392 1 1 1 1 1 1 1
CD-R MEDIA 700MB 5118386 1 1 1 1 1 1 1

JAPAN (5118054)
USA (5118054-2)
EUROPE (5118054-3)
KOREA (5118054-4)
ASIA 120V(5118054-5)
ASIA 220V(5118054-6) JAPAN STYLE D (5118054-7)
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9-9-5 BT04: Equipment Models Covered in this Chapter (LOGIQ 7 PRO)

Table 9-24   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 5132215 1 100V, NTSC
OPERATOR CONSOLE ASSY 5132216 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 5132217 1 1 220V, PAL
OPERATOR CONSOLE ASSY 5132218 1 220V, NTSC

LOGIQLEAN MIDDLE 2369384 1
GEL 2384010 1
GEL U0403BD 1 1 1 1 1
PARKER AQUASONIC100 2384142 1 1 1 1 1
KEY LABEL2 2360321 1 1 1 1 1 1
WARRANTY CARD P9889AH 1
HIGHLIGHT DOC 5141402 1
SAFETY PAMPHLET 5118349 1
SDA LABEL 2341927 1

APPLICATION CD 5132139 1 1 1 1 1 1 R4.2.0 Pro
GHOST CD 5118353-3 1 1 1 1 1 1

DVD-R MEDIA 4.7GB 5118392 1 1 1 1 1 1
CD-R MEDIA 700MB 5118386 1 1 1 1 1 1

JAPAN (5132194)
USA (5132194-2)
EUROPE (5132194-3)
KOREA (5132194-4)
ASIA 120V(5132194-5)
ASIA 220V(5132194-6)
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9-9-6 Monitor

Figure 9-5 Monitor

Table 9-25   Monitor

Item Part Name Part Number Description Qty FRU

101 CRT MONITOR ASSY 2283334-5 Monitor, not inclucing the following parts (102 ~ 113) 1 1

102 MON-REAR-WSP-ASSY 2303930 Rear cover of monitor use for globally except for 
China and Korea. 1 2

102 
(b)

FRU MON-REAR-WSP-ASSY FOR 
CHINA 5264592 Physically the same as 2303930, but with Chinese 

caution Label. 1 2

102 
(c)

FRU MON-REAR-WSP-ASSY FOR 
KOREA 5271314 Physically the same as 2303930, but with Korean 

caution Label. 1 2

103 MON-CAP-ASSY 2303932 cap to cover screws 1 2

104 MON-FRONT-ASSY 2303929-3 front cover of monitor 1 2

105 NECK ASSY 2347387 1 2

106 SPEAKER & BRACKET ASSY 23866616 2 2

107 USER SW ASSY OF MONITOR 2297050 microphone and switch 1 2

109 NECH-BASE-ASSY 2303933 mechanical 1 2

Note: The gas spring Assy
includes the frame block and
release cable.

101

102 103

104

105

106

107

109

110

111 112

113
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110 GAS-SPRING-ASSY 5117495 Gas spring including release cable and mechanical.
Not used for LCD monitor system. 1 2

111 Grill, Left 2279675 1 2

112 Grill, Right 2279676 1 2

113 MON-Cable-Assy 2304171 cable 1 2

Table 9-25   Monitor

Item Part Name Part Number Description Qty FRU
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9-9-7 Casters and Pedals

Figure 9-6 Casters and Pedals

Table 9-26   Casters and Pedals

Item Part Name Part Number Description Qty FRU

201 CASTER LINK ASSY 2304800 entire brake mechanism 1 2

- CASTER SWIVEL 2379694-2 Obsolete. Do not use these parts. - -

202 CASTER SWIVEL 5233773 swivel, rear right. Improved rubber type (anti-stain). 1 2

- CASTER LOCK 2379695 Obsolete. Do not use these parts. - -

203 CASTER LOCK 5233774 lock, front right and rear left. Improved rubber type 
(anti-stain). 2 2

- CASTER FREE 2379693-2 Obsolete. Do not use these parts. - -

204 CASTER FREE 5233772 free, front left. Improved rubber type (anti-stain). 1 2

205 FRONT-BUMPER-ASSY 2315419 front bumper, left and right 1 2

207 PEDAL-R 2291870 rubber pedal for brake caster lock 1 2

208 PEDAL-L 2291869 rubber pedal for brake caster lock 1 2

209 PEDAL CENTER 2291871 rubber pedal for brake caster lock 1 2

210 PEDAL-REAR-REL 2304908 rear pedal 1 2

201

202
203

204

205

207208 209

210211
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211 PEDAL-REAR-SWL 2304909 rear pedal 1 2

- CASTER SET 2381035 Obsolete. Do not use these parts. - -

- CASTER SET 2381035-2 Obsolete. Do not use these parts. - -

- CASTER SET 2381035-3
This part contains one free caster, one swivel lock 

caster, and two total lock caster with bolts. Improved 
rubber type (anti-stain).

1 2

Table 9-26   Casters and Pedals

Item Part Name Part Number Description Qty FRU
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9-9-8 Plastic Covers

Figure 9-7 OP Panel and Keys

251
252

253
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255
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9-9-8 Plastic Covers (cont’d)

Table 9-27   OP Panel and Keys

Item Part Name Part Numbers Description Qty FRU

251 KB COVER LEFT 2282547 upper left cover of keyboard (under monitor) 1 2

252 KB COVER RIGHT 2282548 upper right cover of keyboard (under monitor) 1 2

253 COVER-TOP 2315418 top cover 1 2

254 KB COVER BOTTOM 2282546 plastic cover under keyboard 1 2

255 UP/DOWN-KNOB-ASSY 2304820 handle for keyboard up/down, wire 1 2

256 ECG CABLE HOOK 2283028 hook under keyboard 1 2

257 FRONT COVER TOP 2304765-2 upper cover around probe connector 1 2

258 FRONT COVER UNDER 2304766-2 lower cover around probe connector 1 2

259 SIDE COVER L ASSY 2304769 plastic cover, including bracket 1 2

260 SIDE COVER R ASSY 2304770 plastic cover, including bracket 1 2

261 SIDE-POCKET 2291872 cover of peripheral room with pocket 1 2

262 SIDE-FRINGE 2303896 cover of peripheral room without pocket 1 2

- REAR COVER ASSY 2304767-2 Obsolete.  This plastic cover is acceptable to use if 
stock remains - -

263 REAR COVER ASSY 5150568-3
Plastic cover.  Physically the same as ?2, but caution 
marks are of updated color scheme.  Exclamation and 

lightning are in yellow background.
1 2

263 
(b)

FRU REAR COVER ASSY L7 FOR 
KOREA 5261040 Plastic cover.  Physically the same as 5150568-3, but 

with Korean Caution. 1 2

- REAR COVER ASSY L7 FOR CHINA 5191392 Part for China RoHS compliance. Do NOT use it for 
other countries. 1 2

264 REAR DOOR ASSY 2304768 door for peripherals connector, including latch 1 2

265 HANDLE 2309857 rear handle 1 2

266 REAR CONN ASSY 5111714 rear connector for peripherals 1 2

267 KB BUMPER 2283014 Operation panel bumper 1 2

268 KB BLIND REAR Assy 2304780 Lower cover at Neck portion 1 2

270 KB Rear Assy 2304776 1 2

271 BK Cover Top 2282549 1 2
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9-9-9 Recording Devices

Figure 9-8 Recording Devices

Table 9-28   Recording Devices

Item Part Name Part Number Description Qty FRU

301 MOD 5113449 Not supported for the models after V65x. 1 1

303 FCON2 ASSY 5111715-2 front connector for peripherals (FCON) 1 1

304 QCON ASSY 2304617-5 PCON+PSEL+bracket 1 2

305 PAT. I/O FA200801 for ecg 1 1

- DVD unit 2388429-5 Obsolete. Acceptable to use the part if remained in 
stock. - -

307 DVD unit 6 2388429-6 1 1

308 Front Device bay Assy 5115606 Without DVD unit 1 2

309 B/W printer bracket 5115690 1 2

310 B/W printer bumper 2301001 1 2

311 Foot SW bracket Assy 5117795 1 2

312 DUMMY CONN ASSY CSL L7PRO 5132196 For L7Pro ONLY: Including Dummy connector and 
four screws 1 2

307309

310

311

301

303

304

305

308

For L7 Pro ONLY:

312



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 9-9 - Renewal Parts List For BT04 and BT06 9-37

9-9-10 Probe Holder

Figure 9-9 Probe Holder

Table 9-29   Probe Holder

Item Part Name Part Number Description Qty FRU

350 PROBE HOLDER R ASSY 2296738 rubber holder with bracket 1 2

351 PROBE HOLDER L1 ASSY 2296736 rubber holder with bracket 1 2

352 TV HOLDER ASSY 2296740 rubber holder for TV 1 2

353 GEL HOLDER R ASSY 2296741 includes bottom 1 2

350 351

352

353
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9-9-11 OP Panel and Keys

Figure 9-10 OP Panel and Keys

Note: The task lamp is wrapped by
 heat-shrinkable tape around its lamp portion.
Do NOT remove it !!!

401

403

404

405

406
407

408

409

410 411 412 413

414

For L7 ONLY:

403
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9-9-11 OP Panel and Keys (cont’d)

Table 9-30   OP Panel and Keys

Item Part Name Part Number Description Qty FRU

401 KEYBOARD ASSY 5138507-2 whole keyboard, this includes next 7 items (Items 403 
~ 409) (Obsolete, Replaced by 5138507-3) 1 1

401 SVC KEYBOARD L7 5138507-3 whole keyboard, this includes next 7 items (Items 403 
~ 409) 1 1

403 ROTARY ENCODER ASSY 2369826

OBSOLETE
Three rotary encoders with cables. Three groups of 
encoders with cables and metal stay. In total, there 

are 14 encoders in this FRU.

1 1

403 ROTARY ENCODER ASSY 2369826-2

Three rotary encoders with cables. Three groups of 
encoders with cables and metal stay. In total, there 
are 14 encoders in this FRU.  This version contains 
two types of LCD brightness adjustment knob and 

instruction.

1 1

404 TRACKBALL ASSY 2369823 trackball, two cables w/o bracket 1 1

405 TGC ASSY 2369822 TGC PCB Assy, bracket, cable w/o TGC knobs 1 1

406 A/N KBD ASSY 2369818 board of a/n key switch 1 1

407 I/F BOARD ASSY 2369817 I/F PCB ASSY, Mic cable, USB cable 1 1

408 SW BOARD ASSY 2369815 Three SW PCB Assy, rubber sheets, two cables 1 1

409 KEY ACCESSORY SET 2369816 A/N keytops, all encoder knobs, all clear key caps, 
labels (For knob repair, order 2363861 repair kit.) 1 2

410 TASK LAMP ASSY 2301853-4 L7 Pro does not support the task lamp. 1 1

411 LAMP STAY ASSY 5117796 Stay and cable (inside L7) 1 2

412 TASK LAMP KNOB 2304620 knob 1 2

413 LIGHT BULB 2357676 BULB ONLY 1 1

414 CAP 2239428 CAP for Hole 1 2

- KEY LABEL 2360321 Label for clear key top 1 2

- AN KEY TOP NORWEGIAN 5125104 Option 1 2

- AN KEY TOP SWEDISH 5125100 Option 1 2

- AN KEY TOP GREEK 2375160 Option 1 2

- AN KEY TOP RUSSIAN 2375159 Option 1 2



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
9-40 Section 9-9 - Renewal Parts List For BT04 and BT06

9-9-12 Circuit Board Assemblies

Figure 9-11 Circuit Board Assemblies

Table 9-31   OP Panel and Keys

Item Part Name Part Number Description Qty FRU

501 EBUS 3T ASSY 5111348 Upper EBUS for BT04, BT06 1 1

502 EBUS 3B ASSY 5112465 Lower EBUS for BT04, BT06 1 1

502 EBUS2 ASSY 2399317 Both Upper and Lower boards, for Upgrade BT04, 
Upgrade BT06, 2 1

503 TERMINATOR ASSY 2268026 board 1 2

504 PREA2F ASSY 5119039 board in nest, slot 1 for BT04, BT06. 1 1

504 PREA2H ASSY 2393853 for Upgrade BT04, Upgrade BT06. 1 1

505 BTRAPHV Assy 5118342-3 board in nest, slot 3 - 4 for BT04 1 1

505 BTRAPP5AHV Assy 5154321 board in nest, slot 3 - 4 for BT06 1 1

506 BTxCW ASSY 5111346 Installed on the BTRAP (Option) 1 1

507 DDBF64 ASSY 2399312 board in nest, slot 5 - 6 1 1

508 SINANO ASSY 2374744 board in nest, slot 7 1 1

509 MDBRG ASSY 2264606-5 board in nest, slot 9
“-5 or later” must be used for 6T probe. 1 1

510 MOTHER2 ASSY CSL L7 5111345-2 board 1 1

- STCW ASSY 2277244-4 board in nest, slot 2 (option).  Obsolete, but 
acceptable to use if in stock. - -

RIGHT

501

503

506
507 508

509

510
511

502

504

505
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511 STCW ASSY 2277244-5 Compatible with -4.  Minor change due to delay line 
EOL and resistor change. 1 1

- NEST Board JIG Assy 2315492 Tools to remove a board in the NEST Assy 1 2

Table 9-31   OP Panel and Keys

Item Part Name Part Number Description Qty FRU
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9-9-13 HDD and Battery

Figure 9-12 HDD and Battery

Table 9-32   HDD and Battery

Item Part Name Part Number Description Qty FRU

550 BECOMPSW3 SVC CSL L7 5119906-3 Obsolete, Replaced by 5119906-4. Do NOT use this 
parts! 

1 1

550 BECOMPSW3 SVC 5119906-4 See Reuse Parts List below. 1 1

- CPU Battery - Included on the CPU Board.
Type: CR2032, Lifetime: Approx. 10 years 1 N

551 USB MODEM 5120503 USB modem (Option) 1 1

552 UPS BATTERY PACK 2304809-2 battery of ATX power supply 1 1

553 DGPCIO/VIC2-SVC 5133526 1 1

554 EXTENDED MEMORY3 L7 5118511 Option. - 2

555 HD L7 5118510 80GB, Installed in the PC box. 1 1

LEFT

550

551

552553

554
555

556-1

556-2

557
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Reuse Parts List
When replacing the BECOMP SW3 SVC CSL L7, the following parts must be reused.

• Extended Memory
• PC2IP
• UPS
• DGVIC
• Video Card

- G550 for CRT
- G450 for LCD
- SONO64 for LCD

556-
1 BASE SYSTEM SOFTWARE - Ghost CD. Contact your Online center. Part Number 

depends on application version.
1 1

556-
2 APPLICATION SOFTWARE - Ghost CD. Contact your Online center. 1 1

557 PC2IP2B FC200656 Only support BECOMP3 1 1

- G550 Video ard AGP 2362887 For CRT Monitor System 1 1

- BECOMP3 Rear Fan 5142743 1 1

Table 9-32   HDD and Battery

Item Part Name Part Number Description Qty FRU
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9-9-14 Power Units

Figure 9-13 Power Units
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9-9-14 Power Units (cont’d)

Table 9-33   Power Units

Item Part Name Part Number Description Qty FRU

701 SSR ASSY 5117726 SSR + CONNECTOR PCB 1 1

702 FUSE HOLDER ASSY 5117727 Without fuse 1 1

702-
1 FUSE 2315585 F1, 200V, T12V 1 1

- LV -04 UNIT 5118824 Obsolete. Cannot use this part any longer, and the 
parts in stock have been purged. - -

703 LV UNIT ASSY MAIN PS L7 5118824-2 low voltage regulator + Cable 1 1

704 HV UNIT 2372387
high voltage regulator (Half height),

including materials used when changing Full height 
HV unit to the Half height.

1 1

706 AC CORD 100V US 2371417 power cable of 100V, with clamp 1 1

706-
2 AC CORD 100V JPN 2371416 For JAPAN, power cable of 100V, with clamp 1 1

706-
3 AC CORD 200V EU 2371418 power cable of 200V, with clamp 1 1

706-
4 AC CORD 200V China CCC 2371415-2 applied to Chaina CCC specifications 1 1

708 MAIN Transformer 2373331-2 power transformer 1 1

707 NF INLET Assy 5117723 Noise Filter + Inlet PCB 1 1

705-
1 AC IN-OUT 100V 5117724 1 1

705-
2 AC IN-OUT 200V 5117725 1 1

705-
3 AC IN-200V OUT-100V 5118052 For Korea 1 1

711 Connector Assy 5117728 1 1

709 CONSOLE FAN ASSY2 5117493 3 fans for BT04, BT06 1 1

709 CONSOLE FAN ASSY A 5122614 For upgrade BT04, upgrade BT06 1 1

- AIR FILTER A 5112530 UNDER NEST 1 2

- AIR FILTER B 5112531 UNDER PC BOX 1 2

- AIR FILTER C 5115806 UNDER RATING PLATE 1 2

- SSR-HLV CABLE 5119119 CB107 1 1

- SSR-AC PANEL CABLE 5119120 CB109 1 1

- VOLTAGE SEL CABLE 5119121 CB108 1 1

- FAN CABLE BRAKET ASSY 5117491 1 1

- AC Cord UK & Ireland 5151455 1 2

- AC Cord Denmark 5151457 1 2
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- AC Cord India & Africa 5151450 1 2

- AC Cord Australian 5151453 1 1

- AC Cord Argentina 5151454 1 1

- AC Cord Israel 5151451 1 1

- AC Cord Swiss 5151448 1 1

Table 9-33   Power Units

Item Part Name Part Number Description Qty FRU
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9-9-15 Options, Peripherals and Cables

Figure 9-14 Options, Peripherals and Cables 1
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9-9-15 Options, Peripherals and Cables (cont’d)

Figure 9-15 Options, Peripherals and Cables 2
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9-9-15 Options, Peripherals and Cables (cont’d)

Figure 9-16 Options, Peripherals and Cables 3

Table 9-34   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU

- CABLE DUCT ASSY 5117797 Obsolete. Cannot use this part any longer, and the 
parts in stock have been purged. - -

750 CABLE DUCT ASSY CSL L7 5117797-2

Including:
USB LAN CABLE ASSY 
(CB1.CB2.CB3.CB4.CB6.CB9)
DSUB CABLE ASSY 
(CB10.CB13.CB16.CB17.CB22)
DEVIDE CABLE ASSY (CB5.CB15.CB19.CB32)
BW CABLE ASSY (CB7.CB18.CB20.CB31)
AC CABLE ASSY (CB12.CB28.CB33.CB35)
Felite core added for noise reduction

1 2

4 5

13

6

11
12

25
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760 PCI CABLE 2389075 MDBRG <-> PC2IP2 1 2

761 TX CABLE ASSY 2305111-3 QCON <-> TRAP 1 2

765 PW SW ASSY 2301858-3
Power Switch, SW Bracket
CB011 (PC2IP BECOMP <-> MDBRG  )

1 2

770 FCON Cable Assy 5117485

CB36 (FCON <-> DVD )
CB39 (FCON <-> Removable Bay)
CB37 (FCON <-> OP Panel)
CB38 (FCON <-> OP Panel)

1 2

771 LAMP STAY ASSY 5117796
Lamp Stay Bracket
CB41 (OP Panel <-> Lamp Stay)

1 2

772 FOOT SW Bracket ASSY 5117795
FOOT SWITCH BRACKET
CB40 (OP Panel <-> Foot SW Connector)

1 2

- FOOT SWITCH FB200952 Foot Switch (Option) 1 2

- PCG OPTION 2326844 phono microphone (Option) 1 2

- USB SERIALBRIDGE CBL 2304621 Ext. Peripheral <-> L7 1 2

- RS232C CABLE ASSY STRAIGHT 2305549 Ext. Peripheral <-> L7 1 2

- RS232C CABLE ASSY CROSS 2305550-2 Ext. Peripheral <-> L7 1 2

- ECG CBL SHORT 2304616 Ext. Patient <-> L7 1 2

- ECG CBL LONG 2304615 Ext. Patient <-> L7 1 2

- US CABLE FOR PERIPHERAL 
DEVICE 2324360 Ext. Peripheral <-> L7 1 2

- Keyboard Knob Repair kit 2363861 1 2

- Strap with Buckle 5115855 1 2

- Foot for Printer 2318441 1 2

- USB Conversion Adapter 5129258 B Type to A Type in Device room 1 2

- PAT, I/O FA200801 1 2

- MON-CABLE-ASSY 2304171 1 2

4 4D-Mother2 Cable CSL L7 5138724 For 4D Option 1 1

5 4D Box cable Assy CSL L7 5138723 For 4D Option 1 1

6 4D AC cable CSL L7 5147891 For 4D Option 1 1

- Cable Bracket For 4D ECG 5145578 For 4D Option 1 1

- Cable Bracket For 4D non-ECG 5145579 For 4D Option 1 1

- 4D Motor Controller 2372904 For 4D Option 1 1

- Cable, Bracket to Probe 2384183 For 4D Option 1 1

11 Wireless Receiver 5115162 For Voice Scan Option 1 1

Table 9-34   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU
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12 Wireless Transmitter 5116453 For Voice Scan Option 1 1

13 MIcrophone 2383779 For Voice Scan Option,
Over-the-ear style 1 1

- Rechargable Battery Pack for 
Transmitter 5116454 For Voice Scan Option 1 1

- Battery recharger station 5116446 For Voice Scan Option 1 1

22 LOGIQ7 Ghost CD for BEP3, R6.5.0 5182424 Ghost (Base Image) CD for R65x 1 1

23 LOGIQ7 R6.5.0 Application Software 
CD Release 5181894 Initial Release (M3).

Related Ghost CD is 5182424. 1 1

24 LOGIQ7 R6.5.1 Application Software 
CD 5181894-2 Apr . 07 Release (M4) - compatible to 5181894

Related Ghost CD is 5182424. 1 1

25 BW PRINTER SHORT BOX FRU L7 5194980

For consoles V65x and afterward, Printer Box is 
“Short” type.

Consoles with “Standard” type printer box, if not 
equipped with BW printer, can be converted to “Short” 

type using this FRU.

1 1

- LQ-MD800P 5120592 DVD Recorder, 120V AC (PAL/NTSC compatible) 1 1

- LQ-MD800E 5120593 DVD Recorder, 220V AC (PAL/NTSC compatible) 1 1

Table 9-34   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU
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9-9-16 Probes

9-9-16-1 Probes (For the country other than Japan)

Table 9-35   Probes (For the country other than Japan)

Item Part Name Part Number Description Qty FRU

801 3C PROBE (EXP) 2286354 1

802 3.5C PROBE (EXP) 2296158 1

803 5C PROBE (EXP) 2294516 1

804 M7CMIH PROBE (EXP) 2294514 1

805 E8C PROBE (EXP) 2294641 1

806 7L PROBE (EXP) 2294521 1

807 10L PROBE (EXP) 2294523 1

808 M12LMIH PROBE (EXP) 2294511 1

809 3S PROBE (EXP) 2323337 1

810 10S PROBE (EXP) 2298589 1

811 I12L PROBE (EXP) 2264883 1

812 P2D PROBE (EXP) TE100024 PPA adapter is separately required. 1

813 P6D PROBE (EXP) TQ100002 PPA adapter is separately required. 1

814 8C PROBE (EXP) 2348094 1

815 3.5CS PROBE (EXP) 2051858 1

816 6T TEE PROBE (EXP) KN100068 1

817 M3S PROBE (EXP) 2295649 1

818 7S PROBE (EXP) 2347471 1

819 BE9C PROBE (EXP) 2389382 1

820 PPA adapter 2331934-2 1

821 T739 PROBE (EXP) 2259246 1

822 4D10L (EXP) KTZ156836 4D OPTION required. 1

823 4D3C_L (EXP) KTZ195893 4D OPTION required. 1

824 12L PROBE (EXP) 2295377 1

825 4C PROBE (EXP) 5123455 1
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9-9-16-2 Probes for Japan

Table 9-36   Probes for Japan

Item Part Name Part Number Description Qty FRU

851 3C PROBE (JPN) 2286353 1

852 3.5C PROBE (JPN) 2348877 1

853 5C PROBE (JPN) 2294515 1

854 M7CMIH PROBE (JPN) 2294513 1

855 E8C PROBE (JPN) 2294640 1

856 7L PROBE (JPN) 2294520 1

857 10L PROBE (JPN) 2294522 1

858 M12LMIH PROBE (JPN) 2294510 1

859 3S PROBE (JPN) 2348878 1

860 10S PROBE (JPN) 2309478 1

861 I12L PROBE (JPN) 2270556 1

862 8C PROBE 2348093 1

863 3.5CS PROBE 2380854 1

864 6T TEE PROBE 2294534 1

865 M3S PROBE 2293726 1

866 7S PROBE (JPN) 2355698 1

867 BE9C PROBE (JPN) 2389381 1

868 T739 PROBE (JPN) 2259245 1

869 PPA ADAPTER 2331934-2 1

870 4D10L (JPN) 5121651 4D OPTION required. 1

871 4D3C_L (JPN) 5121652 4D OPTION required. 1

872 12L PROBE (JPN) 2295375 1

873 4C PROBE (JPN) 5131944 1
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9-9-17 LCD Option

Figure 9-17 LCD Option
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9-9-17 LCD Option (cont’d)

Table 9-37   LCD Option

Item Part Name Part Number Description Qty FRU

901 17 inch LCD MONITOR ASSY 5169935-2 Monitor, not inclucing the following parts (102, 103, 
and 105) 1 1

902 PANEL FRONT LCD L7 5132572 1 2

903 PANEL REAR LCD L7 5132573 1 2

904 COVER VESA LCD L7 5132574 Rear VESA cover of 17” LCD monitor use for globally 
except for Korea. 1 2

904 
(b)

FRU VESA COVER L7 17INCH FOR 
KOREA 5265097 Physically the same as 5132574, but with Korean 

caution Label. 1 2

905 SWITCH MIC_ASSY LCD_MONITOR 5137744 Set of SWITCH and MIC 1 1

906 SPEAKER SET (L&R) LCD L7 5132576 Including left and right speakers 1 1

907 LCD D-SUB CABLE ASSY CSL L7 5125391 DVI Cable from BECOMP3 to LCD 1 1

908 MIC_SPK CBL CSL_LCD L7 5137743 MIC and SPEAKER Cable from Front Conn2 to LCD 1 1

909 AC CABLE LCD ASSY LOGIQ7 5132394 AC Ccable from FrontConn2 to LCD 1 1

- LCD ARM LCD L7 5132571 Arm assy includes covers (911 and 912). Obsolete, 
Replaced by 5132571-2. Do NOT use this parts! - -

- LCD ARM LCD L7 5132571-2
Arm assy includes covers (911 and 912).  Obsolete.  
Use FRU 5264730 to upgrade this part to -4 if stock 

remains.
- -

- LCD ARM LCD L7 5132571-3
Arm assy includes covers (911 and 912).  Obsolete.  
Use FRU 5264730 to upgrade this part to -4 if stock 

remains.
- -

910 LCD ARM LCD L7 5132571-4
Arm assy includes covers (911 and 912).  Improved 
rotational limiter plate. For Korea console, Arm Joint 

(912(b)) must be re-used.
1 2

911 ARM COVER LCD L7 5136256 1 2

912 ARM JOINT COVER LCD L7 5136257 Arm plastic cover / joint.  Common part between 17” 
and 19” LCD Monitor arm. 1 2

912 
(b)

FRU ARM JOINT COVER LCD L7 FOR 
KOREA 5271234 Physically the same as 5136257, but caution label in 

Korean Lanugage. 1 2

- Monitor Screws LCD L7 5137688 Special screw set used on LCD monitor 1 2

- DUAL DVI AGP 5111298 Video card for LCD monitor in BECOMP3. Obsolete, 
Replaced by 5111298-2. Do NOT use this parts! 1 1

- DUAL DVI AGP 5111298-2 Video card for LCD monitor in BECOMP3 1 1

- PCI VGA 5121039 Video card for Touch panel in BECOMP3 1 1
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Section 9-10
Renewal Parts List for BT03 or lower

This section describes the BT03 or lower system FRU.

9-10-1 Equipment Models Covered in this Chapter

Table 9-38   Material List

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 2287317 1 100V, NTSC
OPERATOR CONSOLE ASSY 2304806 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 2304807 1 1 220V, PAL
OPERATOR CONSOLE ASSY 2304808 1 220V, NTSC

OPERATION MANUAL 2286866-140 1
OPERATION MANUAL 2286866-100 1 1 1
ADV. REFERENCE MANUAL 2291860-140 1
ADV. REFERENCE MANUAL 2291860-100 1 1 1
SERVICE MANUAL 2286865 1 1 1
QUICK GUIDE 2291859-140 1
QUICK GUIDE 2291859-100 1 1

WARRANTY CARD P9889AH 1
TASK LAMP 2301853-4 1 1 1 1
Gel U0403BD 1 1 1 1 1 1

JAPAN (H76002, 2286864)
USA (H44002LA, 2286864-2)
EUROPE (H44002LB, 2286864-3)
KOREA (H44002LC, 2286864-4)
ASIA (H44002LD, 2286864-5)
ASIA (H44002LE, 2286864-6)
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9-10-1 Equipment Models Covered in this Chapter (cont’d)
Table 9-39   Material List (For Style B/Ver.2)

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 2354857 1 100V, NTSC
OPERATOR CONSOLE ASSY 2354858 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 2354859 1 1 220V, PAL
OPERATOR CONSOLE ASSY 2354860 1 220V, NTSC
OPERATOR CONSOLE ASSY 2355589 1 100V, NTSC

OPERATION MANUAL 2286866-140 1 1
OPERATION MANUAL 2286866-100 1 1 1 1
ADV. REFERENCE MANUAL 2291860-140 1 1
ADV. REFERENCE MANUAL 2291860-100 1 1 1 1
SERVICE MANUAL 2286865 1 1 1 1
QUICK GUIDE 2291859-140 1 1
QUICK GUIDE 2291859-100 1 1 1 1
WARRANTY CARD P9889AH 1 1

TASK LAMP 2301853-4 1 1 1 1
Gel U0403BD 1 1 1 1 1 1
B-Flow 2297481 1 1
Application Software CD (R2.1.0) or 2362291 1 1 1 1 1 1 1
Application Software CD (R2.1.1) or 2372267 1 1 1 1 1 1 1
Application Software CD (R2.1.3) 2384238 1 1 1 1 1 1 1

JAPAN (2354838)
USA (2354838-2)
EUROPE (2354838-3)
KOREA (2354838-4)
ASIA100 (2354838-5)
ASIA220 (2354838-6) JAPAN-A (2354838-7)
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9-10-1 Equipment Models Covered in this Chapter (cont’d)

Table 9-40   Material List (For Style C/Ver.3)

Part Name Part Number Quantity Description
OPERATOR CONSOLE ASSY 2389221 1 100V, NTSC
OPERATOR CONSOLE ASSY 2389220 1 1 120V, NTSC
OPERATOR CONSOLE ASSY 2389219 1 1 220V, PAL
OPERATOR CONSOLE ASSY 2389218 1 220V, NTSC
OPERATOR CONSOLE ASSY 2389217 1 100V, NTSC

OPERATION MANUAL 2286866-140 1 1
OPERATION MANUAL 2286866-100 1 1 1 1
ADV. REFERENCE MANUAL 2291860-140 1 1
ADV. REFERENCE MANUAL 2291860-100 1 1 1 1
SERVICE MANUAL 2286865 1 1 1 1 1
QUICK GUIDE 2291859-140 1 1
QUICK GUIDE 2291859-100 1 1 1 1
WARRANTY CARD P9889AH 1 1

RELEASE NOTE 2382150-140 1 1
RELEASE NOTE 2382150-100 1 1 1 1
QUICK CARD 2318541-140 1 1
QUICK CARD 2318541-100 1 1 1 1
L7 HILIGHT DOCUMENT 2363423-140 1 1

Application Software CD (R3.0.2) or 2396166 1 1 1 1 1 1 1
Application Software CD (R3.0.4) or 2400261 1 1 1 1 1 1 1
Application Software CD (R3.0.6) or 2403327 1 1 1 1 1 1 1
Application Software CD (R3.0.8) 5112719 1 1 1 1 1 1 1

JAPAN (2389216)
USA (2389216-2)
EUROPE (2389216-3)
KOREA (2389216-4)
ASIA100 (2389216-5)
ASIA220 (2389216-6) JAPAN-A (2389216-7)
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9-10-2 Monitor

Figure 9-18 Monitor

Table 9-41   Monitor

Item Part Name Part Number Description Qty FRU

101 CRT MONITOR ASSY 2283334-5 Monitor, not inclucing the following parts (102 ~ 113) 1 1

102 MON-REAR-WSP-ASSY 2303930 Rear cover of monitor use for globally except for 
China and Korea. 1 2

102 
(b)

FRU MON-REAR-WSP-ASSY FOR 
CHINA 5264592 Physically the same as 2303930, but with Chinese 

caution Label. 1 2

102 
(c)

FRU MON-REAR-WSP-ASSY FOR 
KOREA 5271314 Physically the same as 2303930, but with Korean 

caution Label. 1 2

103 MON-CAP-ASSY 2303932 cap to cover screws 1 2

104 MON-FRONT-ASSY 2303929-3 front cover of monitor 1 2

105 NECK ASSY 2347387 1 2

106 SPEAKER & BRACKET ASSY 2386616 or 
2297882

2386616 for R3.xx or later software
2297882 for R2.xx or lower software 2 2

107 USER SW ASSY OF MONITOR 2297050 microphone and switch 1 2

109 NECH-BASE-ASSY 2303933 mechanical 1 2

110 GAS-SPRING-ASSY 2304787 gas spring including release cable and mechanical 1 2

Note: The gas spring Assy
includes the frame block and
release cable.
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111 112
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111 Grill, Left 2279675 1 2

112 Grill, Right 2279676 1 2

113 MON-Cable-Assy 2304171 cable 1 2

Table 9-41   Monitor

Item Part Name Part Number Description Qty FRU
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9-10-3 Casters and Pedals

Figure 9-19 Casters and Pedals

Table 9-42   Casters and Pedals

Item Part Name Part Number Description Qty FRU

201 CASTER LINK ASSY 2304800 entire brake mechanism 1 2

- CASTER SWIVEL 2379694-2 or 
2307311 Obsolete. Do not use these parts. - -

202 CASTER SWIVEL 5233773 swivel, rear right. Improved rubber type (anti-stain). 1 2

- CASTER LOCK 2379695 or 
2307312 Obsolete. Do not use these parts. - -

203 CASTER LOCK 5233774 lock, front right and rear left. Improved rubber type 
(anti-stain). 2 2

- CASTER FREE 2379693-2 or 
2307301 Obsolete. Do not use these parts. - -

204 CASTER FREE 5233772 free, front left. Improved rubber type (anti-stain). 1 2

205 FRONT-BUMPER-ASSY 2315419 front bumper, left and right 1 2

207 PEDAL-R 2291870 rubber pedal for brake caster lock 1 2

208 PEDAL-L 2291869 rubber pedal for brake caster lock 1 2

209 PEDAL CENTER 2291871 rubber pedal for brake caster lock 1 2

201

202203

204

205

207208 209

210211
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210 PEDAL-REAR-REL 2304908 rear pedal 1 2

211 PEDAL-REAR-SWL 2304909 rear pedal 1 2

- CASTER SET 2381035 Obsolete. Do not use these parts. - -

- CASTER SET 2381035-2 Obsolete. Do not use these parts. - -

- CASTER SET 2381035-3 See Note. Improved rubber type (anti-stain). 1 2

Table 9-42   Casters and Pedals

Item Part Name Part Number Description Qty FRU
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9-10-3 Casters and Pedals (cont’d)

NOTE: The new type of the Caster already has been released. The differences between old and new types of 
the caster are the shape and attaching hardware as shown.

• If you replace a caster from the old type to the new one:
Order Caster FRU Assy (2381035-x; FRU2). This contains 4 casters (One Free Caster, One 
Swivel Lock Caster, and Two Total Lock Caster) and 16 attaching bolts. This mean that you must 
replace ALL of the four casters as an assembly when replacing a caster.

• If you replace a caster for the system with a new type of the caster installed:
Order Caster (5233772/Free, 5233773/Swivel Lock, or 5233774/Total Lock; FRU2). This is only 
one caster (with no bolt).

Old CasterNew Caster

Socket Bolt Hex Head Bolt
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9-10-4 Plastic Covers

Figure 9-20 OP Panel and Keys
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9-10-4 Plastic Covers (cont’d)

Table 9-43   OP Panel and Keys

Item Part Name Part Numbers Description Qty FRU

251 KB COVER LEFT 2282547 upper left cover of keyboard (under monitor) 1 2

252 KB COVER RIGHT 2282548 upper right cover of keyboard (under monitor) 1 2

253 COVER-TOP 2315418 top cover 1 2

254 KB COVER BOTTOM 2282546 plastic cover under keyboard 1 2

255 UP/DOWN-KNOB-ASSY 2304820 handle for keyboard up/down, wire 1 2

256 ECG CABLE HOOK 2283028 hook under keyboard 1 2

257 FRONT COVER TOP 2304765-2 upper cover around probe connector 1 2

258 FRONT COVER UNDER 2304766-2 lower cover around probe connector 1 2

259 SIDE COVER L ASSY 2304769 plastic cover, including bracket 1 2

260 SIDE COVER R ASSY 2304770 plastic cover, including bracket 1 2

261 SIDE-POCKET 2291872 cover of peripheral room with pocket 1 2

262 SIDE-FRINGE 2303896 cover of peripheral room without pocket 1 2

263 REAR COVER ASSY 2304767-2 plastic cover 1 2

264 REAR DOOR ASSY 2304768 door for peripherals connector, including latch 1 2

265 HANDLE 2309857 rear handle 1 2

266 REAR CONN ASSY 2304618 rear connector for peripherals 1 2

267 REAR CONN 220V ASSY 2304622 rear connector for peripherals 1 2

268 KB BUMPER 2283014 Operation panel bumper 1 2

269 KB BLIND REAR Assy 2304780 Lower cover at Neck portion 1 2

270 KB Rear Assy 2304776 1 2

271 BK Cover Top 2282549 1 2
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9-10-5 Recording Devices

Figure 9-21 Recording Devices

Table 9-44   Recording Devices

Item Part Name Part Number Description Qty FRU

301 MOD Option Kit 2355070 or 
2307450

Either 2355070 (1.3GB drive) or 2307450 (230MB 
drive) are available. 1 1

302 CD-RW-SVC 2375462 (or 
2304918)

cd-r/w drive
2375462 includes CD-RW, Ghost CD, and manual. 1 1

303 FRONT-IF-ASSY 2324098 front connector for peripherals 1 1

303-
2 FRONT CONTROL ASSY 2302393 front connector for peripherals 1 2

304 QCON ASSY 2304617-5 PCON+PSEL+bracket 1 2

305 PAT. I/O FA200801 for ecg 1 1

306 MOD Fixture Kit 2308066 1 2

- DVD unit 2388429-5 Obsolete. Acceptable to use the part if remained in 
stock. - -

301
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303-2

304
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307
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310
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307 DVD unit 6 2388429-6
For R3.xx or later software ONLY

If the system is upgraded from CD-RW to DVD, order 
DVD installation kit (2389332).

1 1

308 5 inch bay Assy 2389204 For installation of the DVD unit ONLY 1 2

309 B/W PRINTER TRAY ASSY 2324611 Including Printer Tray, Inner box, and bumper 1 2

310 B/W PRINTER TRAY 2283002 1 2

311 B/W PRINTER BUMPER 2301001 1 2

Table 9-44   Recording Devices

Item Part Name Part Number Description Qty FRU
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9-10-6 Probe Holder

Figure 9-22 Probe Holder

Table 9-45   Probe Holder

Item Part Name Part Number Description Qty FRU

350 PROBE HOLDER R ASSY 2296738 rubber holder with bracket 1 2

351 PROBE HOLDER L1 ASSY 2296736 rubber holder with bracket 1 2

352 TV HOLDER ASSY 2296740 rubber holder for TV 1 2

353 GEL HOLDER R ASSY 2296741 includes bottom 1 2

350 351

352

353
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9-10-7 OP Panel and Keys

Figure 9-23 OP Panel and Keys

Note: The task lamp is wrapped by
 heat-shrinkable tape around its lamp portion.
Do NOT remove it !!!
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9-10-7 OP Panel and Keys (cont’d)

Table 9-46   OP Panel and Keys

Item Part Name Part Number Description Qty FRU

401 KEYBOARD ASSY 5138507-2 whole keyboard, (Obsolete, Replaced by 5138507-3) 1 1

401 SVC KEYBOARD L7 5138507-3 whole keyboard, this includes sub-items marked (a), 
below

1 1

402 KEYBOARD ASSY 2267259-2
whole keyboard, this includes sub-items marked (b) 
below (Parts no longer supplied.  Replaced by 
5138507-3) 

1 1

403 ROTARY ENCODER ASSY 2369826

OBSOLETE
(a) Three rotary encoders with cables. Three groups 
of encoders with cables and metal stay. In total, there 
are 14 encoders in this FRU.

1 1

403 ROTARY ENCODER ASSY 2369826-2

(a) Three rotary encoders with cables. Three groups 
of encoders with cables and metal stay. In total, there 
are 14 encoders in this FRU.  This version contains 
two types of LCD brightness adjustment knob and 

instruction.

1 1

404 TRACKBALL ASSY 2369823 (a) trackball, two cables w/o bracket 1 1

405 TGC ASSY 2369822 (a) TGC PCB Assy, bracket, cable w/o TGC knobs 1 1

406 A/N KBD ASSY 2369818 (a) board of a/n key switch 1 1

407 I/F BOARD ASSY 2369817 (a) I/F PCB ASSY, Mic cable, USB cable 1 1

408 SW BOARD ASSY 2369815 (a) Three SW PCB Assy, rubber sheets, two cables 1 1

409 KEY ACCESSORY SET 2369816-2 (a) A/N keytops, all encoder knobs, all clear key caps, 
labels (For knob repair, order 2363861 repair kit.)

1 2

410 ROTARY ENCODER ASSY 2299448
(b) Three rotary encoders with cables. Three groups 
of encoders with cable. In total, there are 14 encoders 
in this FRU. (FRU for 2267259-2 keyboard) 

1 1

411 TRACKBALL ASSY 2299451 (b) trackball, two cables w/o bracket (FRU for 
2267259-2 keyboard) 

1 1

412 TGC ASSY 2299452 (b) TGC PCB Assy, bracket, cable w/o TGC knobs 
(FRU for 2267259-2 keyboard) 

1 1

413 A/N KBD ASSY 2299453 (b) board of a/n key switch (FRU for 2267259-2 
keyboard) 

1 1

414 I/F BOARD ASSY 2306270

(b) I/F PCB ASSY, Mic cable, USB cable (FRU for 
2267259-2 keyboard) 
This part no longer available.  Order new SVC 
Keyboard 5138507-3 for repair.

1 1

415 SW BOARD ASSY 2306273 (b) Three SW PCB Assy, rubber sheets, two cables 
(FRU for 2267259-2 keyboard) 

1 1

416 KEY ACCESSORY SET 2306274
(b) A/N keytops, all encoder knobs, all clear key caps, 
labels (For knob repair, order 2363861 repair kit.) 
(FRU for 2267259-2 keyboard) 

1 1

- CLEAR KEYCAP & LABEL 2398354-2 Clear Cap and Label set 1 2
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Note: How to differentiate the keyboards, 2267259-2 and 2344632-xx:

418 TASK LAMP ASSY 2301853-4 task light 1 1

419 LAMP ASSY 2301857 Lampstay and cable (inside the L7) 1 2

420 TASK LAMP KNOB 2304620 knob 1 2

421 LIGHT BULB 2357676 BULB ONLY 1 2

422 CAP 2239428 CAP FOR SCREW HOLE 1 2

- AN KEY RUSSIA 2375159 Only for KBD 5138507-3 1 2

- AN KEY GREEK 2371160 Only for KBD 5138507-3 1 2

Table 9-46   OP Panel and Keys

Item Part Name Part Number Description Qty FRU

Keyboard 2344632-xx Keyboard 2267259-2

The keyboard 2344632-xx “F3” and “F4” contain
“Eject” and “Spooler”.
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9-10-8 Circuit Board Assemblies

Figure 9-24 Circuit Board Assemblies

Table 9-47   OP Panel and Keys

Item Part Name Part Number Description Qty FRU

501 EBUS ASSY 2271702-2 “-2 or later” board must be used for STCW Option. 2 1

502 MDCON ASSY 2273295 board in nest 1 1

503 TERMINATOR ASSY 2268026 board 1 2

504 PREA ASSY 2264596-2 board in nest, slot 1 - 2 1 1

505 TRAP2 Assy
2323353-4

New TRAP board in nest slot 4- 7. When 2264598 
TRAP is discontinued, order this TRAP2 Assy. 

However, for the board inserted into Slot 5 only, the 
TRAP2 Assy MUST be installed. If it is not, the STCW 

option can not be installed later.

1 1

506 TRAPCW ASSY 2323450-4 board in nest, slot 4 - 7 1 1

507 DDBF ASSY 2357804
board in nest, slot 8 - 11

Including DDBF Assy 2264600-4 and “-3” conversion 
kit (ROM + “-3” label + instructions)

1 1

508 SINANO ASSY 2264602-3 board in nest, slot 12 1 1

509 PROMP ASSY 2264604-2 board in nest, slot 13
“-2 or later” must be used for STCW option. 1 1

510 MDBRG ASSY 2264606-5 board in nest, slot 15
“-5 or later” must be used for 6T probe. 1 1

511 MOTHER ASSY 2264608-3 board 1 1

LEFT
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- STCW ASSY 2277244-4 board in nest, slot 2 (option).  Obsolete, but 
acceptable to use if in stock. - -

512 STCW ASSY 2277244-5 Compatible with -4.  Minor change due to delay line 
EOL and resistor change. 1 1

513 NEST Board JIG Assy 2315492 Tools to remove a board in the NEST Assy 1 2

Table 9-47   OP Panel and Keys

Item Part Name Part Number Description Qty FRU
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9-10-9 HDD and Battery

Figure 9-25 HDD and Battery

Table 9-48   HDD and Battery

Item Part Name Part Number Description Qty FRU

550 BECOMPSW2-SVC 2384945-3 PC Box. Refer to the table below for proper selection. 1 1

- BECOMP3 SV Kit for Replacing BEP1/
BEP2 5136903 Refer to the table below for contents. 1 1

- CPU Battery - Included on the CPU Board.
Type: CR2032, Lifetime: Approx. 10 years 1 N

551 GLOBAL MODEM KIT 2245794 global modem (Option) 1 1

552 UPS BATTERY PACK 2304809-2 battery of ATX power supply 1 1

553 DGPCIO/VIC2-SVC 2384944 Refer to the table below for proper selection. 1 1

554 EXTENDED MEMORY2 2373707 Included in the PC box. For R3.xx (OPTION) or later 
software

- 2

555-
1 HDD 2304904 20GB FOR BT01 1 2

LEFT

550
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555-1

555-2
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555-
2 HDD 2304904-3 40GB FOR BT02/BT03 1 2

- G550 VIDEO CARD AGP 2362887 1 2

- BASE SYSTEM SOFTWARE - Ghost for BEP2. Contact OLC for proper P/N for your 
system.

1 2

- BASE SYSTEM SOFTWARE - Ghost for BEP1. Contact OLC for proper P/N for your 
system.

1 2

- APPLICATION SOFTWARE - Contact OLC for proper P/N for your system. 1 2

BECOMPSW2-SVC (2384945), including:

Part Name P/N QTY

For current 
DGPCIO/VIC 
(2352289) or 
PC2IO/VIC 
(2301854-2)

For new 
DGPCIO/VIC2 

(2372503)

1 BECOMPSW2 Assy 
(PC Box 2351328-2 + Ghost CD) 2351329-4 or later 1 Used Used

2 SV PCVIC Bracket - U 2379774 1 Used Not used

3 SV PCVIC Bracket - L 2379773 1 Used Not used

4 Screw N9408HR 8 Used 4 screws Used 

5 DGVIC connector label 2354667 1 Used Not used

6 Velcro tape U0032BA 30 cm Used Not used

7 Heat shrinkable tube 2357134 40 cm Used Not used

8 Tie-wrap U0212AC 2 Used Not used

DGPCIO/VIC2-SVC (2384944), including:

Part Name P/N QTY

For current PC 
Box (2351328 or 

2299702-xx)
For new PC Box 

(2351328-2)

1 DGPCIO/VIC2 Assy 2372503 1 Used Used

2 SV DGVIC bracket 2379772 1 Used Not used

3 Screw N9408HR 8 Used 4 screws Used

4 DGVIC connector label 2354667 1 Used Not used

5 Velcro tape U0032BA 30 cm Not used Used

Table 9-48   HDD and Battery

Item Part Name Part Number Description Qty FRU
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9-10-9 HDD and Battery (cont’d)

DGPCIO/VIC2
(2372503)

DGPCIO/VIC
(2352289)

PC2IO/VIC
(2301854-2)

BECOMPSW2 (2351329-4 or 
later) OK OK OK

BECOMPSW2 (2351329-3 or 
lower)

OK OK OK

BECOMPSW (2316354-3) NG NG OK

BEP3 SV kit (5136903), including:

Part Number Descriptions QTY

5114061 BECOMP3 ASSY LOGIQ7 1

5120441 BECOMP3 UP KIT CABLE ASSY L7 1

5112352 L7 CSL EMC SHILD PL-B 1

5112353 L7 UPG BECOMP3 BASE 1

5112354 L7 UPG BECOMP3 UPR BRKT 1

N9510ZX CAP SCREW 3

N9408HR SCREW (for spare) 6

5122012 HDD Extension Cable1 1

5134920 GHOST CD W2K FOR BEP3 1

5136802 installation instruction (This manual) 1

2367977 DGVIC TRAY2 1

N9306ZX SCREW, HEX SOCKET 3MM, 6MM CAP SCREW 2

U0082AG SPACER MALE/FEMALE 3MM 10 STUD 2

N9306HR SCREW, TP 3X6 2

U0055AG SPACER 2

U0032BA MAGIC TAPE (HOOK) (FOR MODEM) 1 set

U0033BA MAGIC TAPE (LOOP) (FOR MODEM) 1 set

NOTICE For BEP3 SV Kit ONLY:
This kit may need additional parts depending on the L7 system:
5168551 (R2.5.1 application CD if the system SW level is R2.4.1 or lower) or R3.0.12 (Use FMI72265 
if system SW version is still R3.0.8 or lower level on BT03), FMI 72258 DVD Replacement (If CDRW is 
mounted on the system), if replacing a BEP1.
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9-10-10 Power Units

Figure 9-26 Power Units
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9-10-10 Power Units (cont’d)

Table 9-49   Power Units

Item Part Name Part Number Description Qty FRU

701 SSR PANEL 2292209 including 2 SSRs and fuse 1 1

702 FUSE 2315585 F1, 200V, T12A 1 1

703 LV UNIT 2283531 low voltage regulator 1 1

703-
2 LV2 UNIT 2334197 low voltage regulator 1 1

704 HV UNIT 2372387
high voltage regulator (Half height),

including materials used when changing Full height 
HV unit to the Half height.

1 1

705 AC POWER BOX 2384370 inlet unit for 100V, Including cable 1 1

705-
2 AC POWER BOX JPN 2384371 For JAPAN, inlet unit for 100V, Including cable 1 1

705-
3 AC POWER BOX 200V 2304538-4 Inlet unit for 200V 1 1

706 AC CORD 100V US 2371417 power cable of 100V, with clamp 1 1

706-
2 AC CORD 100V JPN 2371416 For JAPAN, power cable of 100V, with clamp 1 1

706-
3 AC CORD 200V EU 2371418 power cable of 200V, with clamp 1 1

706-
4 AC CORD 200V CHINA with Clamp 2379693-2 For China ONLY 1 1

708 MAIN TRANS 2373331-2 power trans 1 1

709 CONSOLE FAN ASSY 2304624 4 fans 1 1

710 BOTTOM AIR FILTER 2304172 air filter for console 1 2

711 LV FILTER 2291083 air filter for LV unit 1 2

712 MF SIDER COVER R 2284345 side cover of power supply 1 2

713 MF SIDE COVER L 2284346 side cover of power supply 1 2

- AC Cord UK & Ireland 5151455 1 2

- AC Cord Denmark 5151457 1 2

- AC Cord India & Africa 5151450 1 2

- AC Cord Australian 5151453 1 1

- AC Cord Argentina 5151454 1 1

- AC Cord Israel 5151451 1 1

- AC Cord Swiss 5151448 1 1
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9-10-11 Options, Peripherals and Cables

Figure 9-27 Options, Peripherals and Cables 1
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9-10-11 Options, Peripherals and Cables (cont’d)

Figure 9-28 Options, Peripherals and Cables 2
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9-10-11 Options, Peripherals and Cables (cont’d)

Table 9-50   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU

757-
1 BW PNL ASSY 2383135

Front panel of BW Printer for OC 238xxxx(Ver3)
BW Printer Conn Plate (USB/BNC/AC)
AC   CB307B (P405 BW PNL <-> Connector P408) 
200mm, GND500mm
BNC/Shutter       CB042B (P041 BW PNL <-> Rear 
PNL P039) 300mm

1 2

757-
2 BW PNL ASSY 2354668

Front panel of BW Printer for OC 235xxxx/238xxxx 
(Ver2/Ver3)
BW Printer Conn Plate (USB/BNC/AC)
AC     CB307B (P405 BW PNL <-> Connector P408) 
200mm, GND400mm
BNC/Shutter CB042B (P041 BW PNL <-> Rear PNL 
P039) 300mm
USB     CB042BB(USB BW PNL <-> BECOMP USB) 
2000mm

1 2

757-
3 BW PNL ASSY 2301856

Front panel of BW Printer for OC 22xxxxx/230xxxx 
(Ver1)
BW Printer Conn Plate (BNC/AC)
AC       CB307B (P405 BW PNL <-> Connector P408) 
200mm, GND400mm
BNC/Shutter   CB042B (P041 BW PNL <-> Rear PNL 
P039) 300mm

1 2

758 PW SW ASSY 2301858-3
Power Switch
SW Bracket
SW&Cable  CB47B (SW <-> MDCON P042) 290mm

1 2

759-
1 DEV ROOM ASSY 2354669-2

AC & shutter panel in device room for OC 235xxxx/
238xxxx (Ver2/Ver3)
Panel (AC/USB/MiniJack)
AC CB306 (P404 DEVroom<-> Rear PNL J407) 
900mm, GND900mm
MiniPlug CB042C (P418 DEVroom <-> Rear PNL 
J417) 200mm
USB CB042CC (USB DEVroom <-> BECOMP 
USB#5) 1000mm

1 2

759-
2 DEV ROOM ASSY 2301859

AC & shutter panel in device room for OC 22xxxxx/
230xxxx (Ver1)
Panel (AC/USB/MiniJack)
AC CB306 (P404 DEVroom<-> Rear PNL J407) 
900mm, GND900mm
MiniPlug CB042C (P418 DEVroom <-> Rear PNL 
J417) 200mm

1 2

760-
1 FSW CONN ASSY 2383136

Connector on front panel for foot switch for 
238xxxx(Ver3)
Panel
CB308A (FSW Conn <-> CB308B P416) 140mm

1 2

760-
2 FSW CONN ASSY 2301860

Connector on front panel for foot switch
Panel
CB308A (FSW Conn <-> CB308B P416) 140mm
CB308B (J416 CB308A <-> OP Pannel J410) 600mm

1 2
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761-
1 MONITOR VGA CABLE ASSY 2333352-4

for OC 235xxxx/238xxxx (Ver2/Ver3), including cable, 
tie-wrap, and screws.
CB031A (J4 DGVIC <-> Int-housing lock under 
monitor CN2) 1820mm
CB031B (CN41 Front Pannel <-> Int-housing lock 
under monitor CN3) 600mm

1 2

761-
2 MONITOR VGA CABLE2 ASSY 2383137

for OC 238xxxx (Ver3)
Speaker CB033A (J7 MDCON <-> Int-housing Lock 
under monitor P032) 2250mm
Video     CB034   (J5 DGVIC <-> Color Printer 
DEVroom R/G/B/Sync) 2500mm
GND       CB311  (GND Monitor <-> MainFrame GND) 
770mm
AC         CB244-1 (SSR2 <-> Monitor AC) 1850mm
BW AC  CB307A (J409 Rear AC <-> BW AC Conn 
CB307B P408(BW PNL ASSY)) 1250mm

1 2

761-
3 MONITOR VGA CABLE2 ASSY 2359765

for OC 235xxxx/238xxxx (Ver2/Ver3)
Speaker CB033A (J7 MDCON <-> Int-housing Lock 
under monitor P032) 2260mm
Video     CB034   (J5 DGVIC <-> Color Printer 
DEVroom R/G/B/Sync) 2500mm
GND       CB311  (GND Monitor <-> MainFrame GND) 
770mm
AC         CB244-1 (SSR2 <-> Monitor AC) 1850mm

1 2

761-
4 MONITOR VGA CABLE ASSY 2298144

2333352 + 2333877 for OC 22xxxxx/230xxxx (Ver1)
CB031 2333352-3
Speaker CB033 (J7 MDCON <-> Int-housing Lock 
under monitor P032) 2360mm
Video     CB034   (J5 DGVIC <-> Color Printer 
DEVroom R/G/B/Sync) 2500mm
GND       CB311  (GND Monitor <-> MainFrame GND) 
800mm
AC         CB244-1 (SSR2 <-> Monitor AC) 1850mm

1 2

762-
1 OP2 CABLE ASSY 2383139

for OC 238xxxx (Ver3)
HDD Lamp      CB26A (P076 BECOMP <-> Int-
housing lock under KBD J014) 1470mm
CB027A (J018 MiniJack BECOMP <->  Int-housing 
lock under KBD J017) 1730mm
CB027C (J020 MDCON <->  Int-housing lock under 
KBD J017) 1930mm
VGA for LCD   CB029A (J022 BECOMP D-Sub <-> 
Int-housing lock under KBD D-Sub P021) 1570mm
Video   CB042A (J040 RearPNL <-> Int-housing lock 
under KBD P039) 1970mm
Shutter CB042A (J040 RearPNL <-> Int-housing lock 
under KBD J417) 650mm
USB      CB025B (USB#1 BECOMP <-> Int-housing 
lock in KB support J011) 1810mm
USB      CB042BB (USB#3 BECOMP <-> BW-PNL 
J420) 1850mm

1 2

Table 9-50   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
9-84 Section 9-10 - Renewal Parts List for BT03 or lower

761-
2 OP2 CABLE ASSY 2359766

for OC 235xxxx/238xxxx (Ver2/Ver3)
HDD Lamp      CB26A (P076 BECOMP <-> Int-
housing lock under KBD J014) 1500mm
CB027A (J018 MiniJack BECOMP <->  Int-housing 
lock under KBD J017) 1750mm
CB027C (J020 MDCON <->  Int-housing lock under 
KBD J017) 2000mm
VGA for LCD   CB029A (J022 BECOMP D-Sub <-> 
Int-housing lock under KBD P021) 1570mm
Video  CB042A (J040 RearPNL <-> Int-housing lock 
under KBD P039) 2100mm
Shutter CB042A (J040 RearPNL <-> Int-housing lock 
under KBD J417) 1600mm

1 2

762 OP CABLE ASSY 2298145

for OC 22xxxxx/230xxxx (Ver1)
USB CB025A (USB BECOMP <-> Int-housing lock 
under KBD J011) 1700mm
HDD Lamp      CB26A (P076 BECOMP <-> Int-
housing lock under KBD J014) 1500mm
CB027A (J018 MiniJack BECOMP <->  Int-housing 
lock under KBD J017) 1700mm
CB027C (J020 MDCON <->  Int-housing lock under 
KBD J017) 2000mm
VGA for LCD   CB029A (J022 BECOMP D-Sub <-> 
Int-housing lock under KBD P021) 1850mm
Video  CB042A (J040 RearPNL <-> Int-housing lock 
under KBD P039) 2100mm
Shutter CB042A (J040 RearPNL <-> Int-housing lock 
under KBD J417) 1600mm

1 2

763 TX CABLE ASSY 2305111-3 QCON <-> TRAP 1 2

764-
1 PC CABLE2 ASSY 2383140

for OC 238xxxx (Ver3)
CB012 (J10 MDCON <-> Int-housing lock in 
BECOMP J006) 480mm
CB012 (J10 MDCON <-> PC2IO D-Sub J2) 620mm
CB014 (J11 MDCON <-> BECOMP Audio mini Jack1 
) 270mm
CB016 (Ethernet BECOMP <-> REAN J10) 480mm
USB   CB018 (USB#2 BECOMP <-> REAN USB Hub) 
700mm
SCSI   CB035 (J1 PC2IO <-> REAN J9) 340mm
Modem CB040(J14 REAN <-> Modem Line) 320mm
CB044 (J12 MDCON <-> REST J10) 270mm w/
Ferrite Core
CB047A (J8 MDCON <-> Int-housing lock J042) 
1100mm/100mm

1 2

Table 9-50   Options, Peripherals and Cables
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764-
2 PC CABLE2 ASSY 2358656

for OC 235xxxx/238xxxx (Ver2/Ver3)
CB012 (J10 MDCON <-> Int-housing lock in 
BECOMP J006) 575mm
CB012 (J10 MDCON <-> PC2IO D-Sub J2) 600mm
CB014 (J11 MDCON <-> BECOMP Audio mini Jack1 
) 540mm
CB015 (RS232 BECOMP <-> Modem RS232 ) 
1000mm
CB016 (Ethernet BECOMP <-> REAN J10) 400mm
USB   CB018 (USB#2 BECOMP <-> REAN USB Hub) 
1000mm
DVI-D CB019A (VGA BECOMP <-> DGVIC J3) 
450mm
UPS    CB020 (RS232 BECOMP <-> UPS RS232) 
500mm
SCSI   CB035 (J1 PC2IO <-> REAN J9) 520mm
Modem CB040(J14 REAN <-> Modem Line) 950mm
CB044 (J12 MDCON <-> REST J10) 270mm
CB047A (J8 MDCON <-> Int-housing lock J042) 
1100mm/100mm

1 2

764-
3 PC CABLE ASSY 2298147

for OC 22xxxxx/230xxxx (Ver1)
CB012 (J10 MDCON <-> Int-housing lock in 
BECOMP J006) 575mm
CB012 (J10 MDCON <-> PC2IO D-Sub J2) 710mm
CB014 (J11 MDCON <-> BECOMP Audio mini Jack1 
) 640mm
CB015 (RS232 BECOMP <-> Modem RS232 ) 
1000mm
CB016 (Ethernet BECOMP <-> REAN J10) 340mm
USB   CB018 (USB#2 BECOMP <-> REAN USB Hub) 
820mm
DVI-D CB019A (VGA BECOMP <-> DGVIC J3) 
410mm
UPS    CB020 (RS232 BECOMP <-> UPS RS232) 
500mm
SCSI   CB035 (J1 PC2IO <-> REAN J9) 570mm
Modem CB040(J14 REAN <-> Modem Line) 890mm
CB044 (J12 MDCON <-> REST J10) 270mm
CB047A (J8 MDCON <-> Int-housing lock J042) 
1100mm/100mm

1 2

Table 9-50   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU
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765-
1 POWER CABLE ASSY 2383142

for OC 238xxxx (Ver3)
CB201 (P2 HV <-> Mother P15, P16, P17) 850mm/
690mm/630mm
CB202 (P1 HV <-> MDCON J18) w/Ferrite Core 
480mm
CB205-1 (+6V/0V LV <-> Mother P3, P4 ) w/Ferrite 
Core 850mm/850mm
CB205-2 (+6V/0V LV <-> Mother P5, P6 ) w/Ferrite 
Core 810mm/810mm
CB206 (-6V/0V LV <-> Mother P7 ) 700mm
CB207 (+5V/0V LV <-> Mother P8 ) 700mm
CB208-1A (+3.3V/0V LV <-> Mother P10 ) 680mm
CB208-2A (+3.3V/0V LV <-> Mother P11 ) 680mm
CB209 (+12V/0V LV <-> Mother P13 ) 700mm
CB210 (-12V/0V LV <-> Mother P12 ) 700mm
CB230-1 (Int-housing lock in KBD <-> Mother P1, P2 
) 520mm/540mm
CB231 (Cooling FAN <-> Mother P14 ) 800mm

1 2

765-
2 POWER CABLE ASSY 2359541

for OC 235xxxx/238xxxx (Ver2/Ver3)
CB201 (P2 HV <-> Mother P15, P16, P17) 950mm/
790mm/720mm
CB202 (P1 HV <-> MDCON J18) 750mm
CB205-1 (+6V/0V LV <-> Mother P3, P4 ) 810mm/
810mm
CB205-2 (+6V/0V LV <-> Mother P5, P6 ) 810mm/
810mm
CB206 (-6V/0V LV <-> Mother P7 ) 700mm
CB207 (+5V/0V LV <-> Mother P8 ) 700mm
CB208-1A (+3.3V/0V LV <-> Mother P10 ) 680mm
CB208-2A (+3.3V/0V LV <-> Mother P11 ) 680mm
CB209 (+12V/0V LV <-> Mother P13 ) 700mm
CB210 (-12V/0V LV <-> Mother P12 ) 700mm
CB230-1 (KBD1 Int-housing lock in KBD <-> Mother 
P1, P2 ) 1920mm/1920mm
CB231 (Cooling FAN <-> Mother P14 ) 850mm

1 2

Table 9-50   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
Section 9-10 - Renewal Parts List for BT03 or lower 9-87

765-
3 POWER CABLE ASSY 2298148

for OC 22xxxxx/230xxxx (Ver1)
CB201 (P2 HV <-> Mother P15, P16, P17) 950mm/
790mm/720mm - non core
CB202 (P1 HV <-> MDCON J18) 750mm
CB205-1 (+6V/0V LV <-> Mother P3, P4 ) 810mm/
810mm
CB205-2 (+6V/0V LV <-> Mother P5, P6 ) 810mm/
810mm
CB206 (-6V/0V LV <-> Mother P7 ) 700mm
CB207 (+5V/0V LV <-> Mother P8 ) 700mm
CB208-1 (+3.3V/0V LV <-> Mother P10 ) 680mm 
Contact 
CB208-2 (+3.3V/0V LV <-> Mother P11 ) 680mm 
Contact
CB209 (+12V/0V LV <-> Mother P13 ) 700mm
CB210 (-12V/0V LV <-> Mother P12 ) 700mm
CB230-1 (Int-housing lock in KBD <-> Mother P1, P2 
) 1920mm/1920mm
CB231 (Cooling FAN <-> Mother P14 ) 850mm

1 2

766-
1 BAY CABLE3 2361023-2 CB302A (P401 ATX PS <-> 5 inch Bay J403/J404 ) 

800mm/220mm 1 2

766-
2 BAY2 CABLE 2401408 CB022A (P001 BECOMP <-> MOD J002) 1500mm 1 2

767-
1 OP2 CABLE2 ASSY 2383141

for OC 238xxxx (Ver3)
CB027B (CN31 OP PNL <-> Int-housing lock under 
KBD P017 ) 1090mm
CB029B (CN18 LCD <-> Int-housing lock under KBD 
D-Sub P021) 950mm
CB230-2 (CN21 OP PNL <-> Int-housing lock under 
KBD Power Cable KBD1) 1000mm
USB CB025A (CN18 OP PNL <-> Int-housing lock in 
KB support Assy P011)
CB026B (P014 Int-housing lock in KB support assy <-
> Int-housing lock under KB TRAY P016+P046)
CB308B (CN23 OP PNL <-> Int-housing lock under 
KB TRAY P416) 690mm
GND CB312 (T210 OP PNL <-> Main Frame T211) 
700mm
CB309B (CN22 OP PNL <-> Int-housing lock KB 
TRAY P407B) 690mm

1 2

767-
2 OP2 CABLE2 ASSY 2359767

for OC 235xxxx/238xxxx (Ver2/Ver3)
CB027B (CN31 OP PNL <-> Int-housing lock under 
KBD P017 ) 1130mm
CB029B (CN18 LCD <-> Int-housing lock under KBD 
P021) 900mm
CB230-2 (CN21 OP PNL <-> Int-housing lock under 
KBD Power Cable KBD1) 1000mm
GND CB312 (T210 OP PNL <-> Main Frame T211) 
700mm

1 2

Table 9-50   Options, Peripherals and Cables
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767-
3 OP CABLE2 ASSY 2302191

for OC 22xxxxx/230xxxx (Ver1)
USB CB025B (CN18 OP PNL <-> Int-housing lock 
under KBD P011) 1000mm
CB027B (CN31 OP PNL <-> Int-housing lock under 
KBD P017 ) 1000mm
CB029B (CN18 LCD <-> Int-housing lock under KBD 
P021) 900mm
CB230-2 (CN21 OP PNL <-> Int-housing lock under 
KBD Power Cable KBD1) 1000mm
GND CB312 (T210 OP PNL <-> Main Frame T211) 
700mm

1 2

768 OP CABLE3 ASSY 2304610-2

CB026C (P016+P046 Int-housing lock under KB 
TRAY <-> Front PNL CN44) 130mm
CB026C (P016+P046 Int-housing lock under KB 
TRAY <-> Front PNL CN42) 130mm
CB031B (Int-housing lock under Monitor P030 <-> 
Front PNL CN41) 620mm

1 2

769 PC2IO/IPCABLE ASSY 2304611
for OC 22xxxxx/230xxxx (Ver1)
CB301 (PC2IO <-> PC2IP ) 400mm

1 2

770 SYS AC CABLE ASSY 2304612 CB307A (J408 Int-housing lock under KBD <-> Rear 
J409) 1200mm 1 2

771-
1 PWR AC CABLE ASSY 2383138

for OC 238xxxx (Ver3)
CB203 (TB3 SSR <-> HV AC in ) 1050mm
CB212 ( TB3 SSR <-> LV AC in) 1700mm
CB225 (TB2 SSR <-> ATX AC in) 970mm

1 2

771-
2 PWR AC CABLE ASSY 2304613

for OC 22xxxxx/230xxxx/235xxxx/238xxxx (Ver1/
Ver2/Ver3)
CB203 (TB3 SSR <-> HV AC in ) 1050mm
CB212 ( TB3 SSR <-> LV AC in) 1700mm
CB225 (TB2 SSR <-> ATX AC in) 970mm
CB305 (TB3 SSR <-> Modem AC in)  1150mm

1 2

772 PC BOX INTERNALCABLE ASSY 2304797

for OC 235xxxx/238xxxx (Ver2/Ver3)
CB101 (J005 BECOMP Mother P-Seq-Jumper <-> 
Int-housing lock in PC P006) 500mm
CB102 (J105/J045 BECOMP Mother (Reset/HDD) <-
> Int-housing lock as PC BOX J076) 500mm

1 2

- USB CABLE 2358659-2 CB025AA (USB1 BECOMP <-> OP PNL CN18 ) 
2600mm 1 2

- USB DEV CABLE FOR PERIPHERAL 
DEVICE 2388600-2

DVD unit - PC Box
CB100 (USB4 BECOMP <-> DVD Drive 5 inch bay 
USB ) 1250mm

1 2

778 ECG INT CABLE ASSY 2360884-2 CB030A (Patient I/O <-> DGVIC J8 ) 850mm 1 2

779 PCI CABLE 2389075 CB011 (PC2IP BECOMP <-> MDBRG) 1 2

751 FOOT SWITCH FB200952 Foot Switch (Option) 1 2

756 PCG OPTION 2326844 phono microphone (Option) 1 2

773 USB SERIALBRIDGE CBL 2304621 Ext. Peripheral <-> L7 1 2

774 RS232C CABLE ASSY STRAIGHT 2305549 Ext. Peripheral <-> L7 1 2

Table 9-50   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU
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775 RS232C CABLE ASSY CROSS 2305550-2 Ext. Peripheral <-> L7 1 2

776 ECG CBL SHORT 2304616 Ext. Patient <-> L7 1 2

777 ECG CBL LONG 2304615 Ext. Patient <-> L7 1 2

- US CABLE FOR PERIPHERAL 
DEVICE 2324360 Ext. Peripheral <-> L7 1 2

- Keyboard Knob Repair kit 2363861 1 2

- Strap with Buckle 5115855 1 2

- Foot for peripheral 2318441 1 2

- MON-CABLE-ASSY 2304171 1 2

- Loopback Connector 2116343 Loopback Connector for Diagnostics (46-330081P3) 1 2

Table 9-50   Options, Peripherals and Cables

Item Part Name Part Number Description Qty FRU
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9-10-12 Probes

9-10-12-1 Probes for Country other than JAPAN

Table 9-51   Probes for Country other than JAPAN

Item Part Name Part Number Description Qty FRU

801 3C PROBE (EXP) 2286354 1

802 3.5C PROBE (EXP) 2050357 1

803 5C PROBE (EXP) 2294516 1

804 M7CMIH PROBE (EXP) 2294514 1

805 E8C PROBE (EXP) 2294641 1

806 7L PROBE (EXP) 2294521 1

807 10L PROBE (EXP) 2294523 1

808 M12LMIH PROBE (EXP) 2294511 1

809 3S PROBE (EXP) 2323337 1

810 10S PROBE (EXP) 2298589 1

811 I12L PROBE (EXP) 2264883 1

812 P2D PROBE (EXP) TE100024 PPA adapter is separately required. 1

813 P6D PROBE (EXP) TQ100002 PPA adapter is separately required. 1

814 8C PROBE (EXP) 2348094 1

815 3.5CS PROBE (EXP) 2051858 1

816 6T TEE PROBE (EXP) KN100092 1

817 M3S PROBE (EXP) 2378099 1

818 PPA ADAPTER 2331934-2 1
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9-10-12-2 Probes for Japan

Table 9-52   Probes for Japan

Item Part Name Part Number Description Qty FRU

851 3C PROBE (JPN) 2286353 1

852 3.5C PROBE (JPN) 2348877 1

853 5C PROBE (JPN) 2294515 1

854 M7CMIH PROBE (JPN) 2294513 1

855 E8C PROBE (JPN) 2294640 1

856 7L PROBE (JPN) 2294520 1

857 10L PROBE (JPN) 2294522 1

858 M12LMIH PROBE (JPN) 2294510 1

859 3S PROBE (JPN) 2348878 1

860 10S PROBE (JPN) 2309478 1

861 I12L PROBE (JPN) 2270556 1

862 8C PROBE 2348093 1

863 3.5CS PROBE 2380854 1

864 6T TEE PROBE 5131947 1

865 M3S PROBE 2293726 1

866 PPA ADAPTER 2331934-2 1
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Chapter 10
Periodic Maintenance

Section 10-1 
Overview

10-1-1 Purpose of Chapter 10
This chapter describes Periodic Maintenance (PM) on the scanner and its peripherals. These PM 
procedures are intended to maintain the quality of the ultrasound systems performance. Read this 
chapter completely and familiarize yourself with the procedures before starting a PM.

CONTENTS IN CHAPTER 10
 

    

Table 10-1   Contents in Chapter 10

Section Description Page Number

10-1 Overview 10-1

10-2 Why do Periodic Maintenance 10-2

10-3 Periodic Maintenance Schedule 10-2

10-4 Tools Required 10-4

10-5 System Periodic Maintenance 10-7

10-6 Using a Phantom 10-11

10-7 Electrical Safety Tests 10-12

10-1 When There's Too Much Leakage Current... 10-31

PM Inspection Certificate 10-29

CAUTION Practice good ESD prevention. Wear an anti–static strap when handling electronic parts and 
even when disconnecting/connecting cables.

DANGER THERE ARE SEVERAL PLACES ON THE BACKPLANE, THE AC DISTRIBUTION, 
AND DC DISTRIBUTION THAT ARE DANGEROUS. BE SURE TO DISCONNECT 
THE SYSTEM POWER PLUG AND OPEN THE MAIN CIRCUIT BREAKER 
BEFORE YOU REMOVE ANY PARTS. BE CAUTIOUS WHENEVER POWER IS 
STILL ON AND COVERS ARE REMOVED.

CAUTION Do not pull out or insert circuit boards while power is ON.

CAUTION Do not operate this unit unless all board covers and frame panels are securely in place. System 
performance and cooling require this.

CAUTION
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Section 10-2
Why do Periodic Maintenance

10-2-1 Keeping Records
It is good business practice that ultrasound facilities maintain records of periodic and corrective 
maintenance. The Ultrasound Periodic Maintenance Inspection Certificate provides the customer with 
documentation that the ultrasound scanner is maintained on a periodic basis.

A copy of the Ultrasound Periodic Maintenance Inspection Certificate should be kept in the same room 
or near the scanner.

10-2-2 Quality Assurance
In order to gain accreditation from organizations such as the American College of Radiology (USA), it 
is the customer’s responsibility to have a quality assurance program in place for each scanner. The 
program must be directed by a medical physicists, the supervising radiologist/physician or appropriate 
designee.

Routine quality control testing must occur regularly. The same tests are performed during each period 
so that changes can be monitored over time and effective corrective action can be taken.

Testing results, corrective action and the effects of corrective action must be documented and 
maintained on the site.

Your GE service representative can help you with establishing, performing and maintaining records for 
a quality assurance program.

Section 10-3
Periodic Maintenance Schedule

10-3-1 How often should PMs be performed?
The Periodic Maintenance Schedule specifies how often your LOGIQ™ 7 should be serviced and what 
items need attention. It is important you have your LOGIQ™ 7 serviced as scheduled in order to retain 
its high level of safety, dependability and performance.

Your GE Service Representative knows your LOGIQ™ 7 best and can provide competent, efficient 
service. Please contact us for further information and to schedule GE Medical Systems Ultrasound to 
perform this service for you.

The services and intervals shown in the maintenance schedule assumes that you use your LOGIQ™ 7 
for an average patient load (10-12 per day) and not used as a primary “mobile unit”.
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10-3-1 How often should PMs be performed? (cont’d)

Table 10-2 Periodic Maintenance Schedule

Service at Indicated Time Daily Weekly Monthly

Per 
Facilities 

QA 
Program Notes

Clean Probes •* * or before each use

Clean Probe Holders •

Clean Air Filter • more frequently depending on 
your environment

Inspect AC Mains Cable • Mobile Unit Check Weekly

Inspect Cables and Connectors •
Clean Console •
Clean Monitor and Touch Panel •
Inspect Wheels, Casters, brakes and 
Swivel Locks • Mobile Unit Check Daily

Check Control Panel Movement • Mobile Unit Check Daily

Console Leakage Current Checks •
also after corrective 
maintenance or as required by 
your facilities QA program

Peripheral Leakage Current Checks •
also after corrective 
maintenance or as required by 
your facilities QA program

Surface Probe Leakage Current Checks •
also after corrective 
maintenance or as required by 
your facilities QA program

 Endocavity Probe Leakage 
Current Checks

also after corrective 
maintenance or as required by 
your facilities QA program

Transesphongeal Probe Leakage 
Current Checks

also after corrective 
maintenance or as required by 
your facilities QA program

Surgical Probe Leakage 
Current Checks

also after corrective 
maintenance or as required by 
your facilities QA program

Measurement Accuracy Checks •
also after corrective 
maintenance or as required by 
your facilities QA program

Probe/Phantom Checks •
also after corrective 
maintenance or as required by 
your facilities QA program



GE HEALTHCARE
DIRECTION 2286865, REVISION 14 LOGIQ™ 7 SERVICE MANUAL
10-4 Section 10-3 - Periodic Maintenance Schedule

Section 10-4 
Tools Required

10-4-1 Standard GE Tool Kit
The following is a description of the “Standard” GE tool kit in the USA. Not all tools are required for PMs.

Table 10-3    Overview of GE-1 Tool Kit Contents 

Tool ID Description Tool ID Description

9-45358 Pliers Retaining Ring 9-XL9971MM Xcelite-hex Blade 1.27mm

9-4078 Scribe 9-XL9972MM Xcelite-hex Blade 1.5mm

9-44572 Wrench Open End 3/8 - 7/16 9-XL9973MM Xcelite-hex Blade 2 mm

9-44579 Wrench Open End 1/2 - 9/16 9-XL9974MM Xcelite-hex Blade 2.5mm

9-44579 Wrench Open End 1/2 - 9/16 9-XL9975MM Xcelite-hex Blade 3mm

9-45385 Pliers, Arc Joint 7 inch 9-XL9976MM Xcelite-hex Blade 4mm

9-45378 Pliers, Slip Joint 9-XL9977MM Xcelite-hex Blade 5mm

9-4518 Pliers, Long Nose, Miniature 9-XL991CM Handle

9-4518 Pliers, Long Nose, Miniature C2356E Screw starter - Kedman Quick Wedge

9-44776 Ignition Wrench Set, 10 pc. BLBO Box - 18 Compartment 

9-44601 Wrench, Adj., 4 inch DWL4283T Box - 5 Compartment

9-4151 Screwdriver, Blade, Stubby 9-41322 Pickup Tool, Claw type

9-41421 Screwdriver, Blade, Pocket clip 9-6757 6 pc Needle File Set

9-41594 Screwdriver, Blade 1/8 in. x 4 in. 9-9487 Utility Knife

9-41581 Screwdriver, Blade 3/16 in. x 4 in. 9-45341 Pliers Vice Grip 10 inch

9-39451 20' Steel Tape, locking Spring load 9-3001  Xacto Pen Knife

9-GH807 Ratchet, Offset, Slotted 9-HT62002 Solder Aid, Fork and Hook

68-412 Ratchet, Offset, Phillips 9-4099 Mirror, Round, Telescoping

9-GH130 Tapered Reamer 9-GH3001 Steel Rule Decimal 6 inch

9-41584 Screwdriver, slotted 1/4 in.X 6 in. 9-GH300ME Steel Rule Metric 6 inch

9-4118 Screwdriver, Phillips #2, Stubby 9-XL9920 Xcelite-hex Blade.050 inch

9-41293 Screwdriver, Phillips #0 9-XL9921 Xcelite-hex Blade 1/16 inch

9-41294 Screwdriver, Phillips #1 9-XL9922 Xcelite-hex Blade 5/16 inch

9-41295 Screwdriver, Phillips #2 9-XL9923 Xcelite-hex Blade 3/32 inch

9-46677 Hex Keys, 20 pc., Metric 9-XL9924 Xcelite-hex Blade 1/8 inch

9-34701 1/4 in. Standard.Socket set (19 pc) 9-XL9925 Xcelite-hex Blade 5/32 inch

9-43499 1/2 inch Socket 1/4 inch drive 9-XL9926 Xcelite-hex Blade 3/16 inch

9-4355 Flex Spinner 9-XL99764 Xcelite-hex Blade 7/64

9-43523  Breaker 9-XL99964 Xcelite-hex Blade 9/64

9-43531 6 inch Ext. 9-XLM60 Mini-screwdriver kit
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9-65283 Case 8.5 in. x 4.5 in. x 2 in. Deep 9-45072 Pliers 6 inch Diagonal

9-46696 Hex Keys 9-XL100X Wire Stripper/Cutter 5 inch - 100X

9-39829 Torpedo Level, Magnetic 9-XL87CG Pliers - very fine needle nose-87CG

9-38461 Hammer, Ball Peen, 4 oz 9-WEWDT-07 Weller-Soldering-Replacement Tip(1)

9-4280 Universal Joint 1/4 inch 9-WS175-E Wiss - Surgical Scissors

9-WEW60P3 Weller - Soldering Iron, 3 wire KH174 Hemostat 5 inch Straight 

9-WECT5B6 Weller - Soldering Iron Tip KH175 Hemostat 5 inch curved

9-WEWDP12 Weller - Desoldering Pump 9-Z9480121 Alignment tool (red)

93383 Flashlight Mini-Mag Lite (AAA Bat.)

9-GH408 Tweezers

21576 Brush - Bristle

9-4516 Pliers 4 1/4 inch Diagonal

Table 10-4    Overview of GE-2 Tool Kit Contents 

GE-2 Sears Kit (#99034) 

Tool ID Description Tool ID Description

9-45381 Pliers, Arc Joint 9 1/2 inch 9-44067 Socket 1 1/16 in. for 1/2 in. drive

9-45092 Pliers, Linesman 8 1/2 inch 9-42679 Socket 10MM Hex for 1/2 in. drive (2273333) 

9-42882 Punch, Pin 3/32 inch 9-44262 Extension 10 inch for 1/2 in. drive (2273405)

9-42884 Punch, Pin 5/32 inch 9-4258 3/8 inch to 1/2 inch Adapter

9-42886 Punch, Pin 1/4 inch 9-34374 3/8 inch Metric Socket Set - 12 PT

9-42973 Cold Chisel 1/2 inch 9-44311 16mm Socket 12 pt.

9-GH77 Center Punch Automatic 9-33485 Metal Socket Tray

9-GH890 File Handle, Adj. 9-33484 Metal Socket Tray

9-31276  File, Round, Bastard 8 inch 9-33484 Metal Socket Tray

9-31277  File, Half Round, Bastard 8 inch 9-52068 Tap and Drill Set

9-31263 File, Flat Mill 8 inch 9-52722 #6 Tap

21045C Close Quarter Saw 9-52723 #8 Tap

9-44604 Wrench, Adj 10 inch High Speed Drill Set

9-41587 Screwdriver 5/16 inch x 8 inch #36 Drill

9-41586 Screwdriver, Stubby 5/16 inch  #29 Drill

9-GH19512 Countersink 1/2 inch 9-44046 3/8 inch Socket Set

9-44741 12 PC Combination Wrench Set

Table 10-3    Overview of GE-1 Tool Kit Contents (Continued)

Tool ID Description Tool ID Description
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10-4-2 Special Tools, Supplies and Equipment

10-4-2-1 Specific Requirements for Periodic Maintenance
 See Chapter 7

Table 10-5    Overview of Requirements for Periodic Maintenance

Tool  Part Number Comments

Digital Volt Meter (DVM)

Electric Safety Analyzer DALE 600 46-285652G1 For 120V Unit

Electric Safety Analyzer DALE 
600E 46-328406G2 For 220V Units

Leakage Current Ultrasound Kit 2113015 For 120V and 220V Units

Anti Static Kit

46–194427P231
46–194427P279
46–194427P369
46–194427P373
46–194427P370

Kit includes anti–static mat, wrist strap and cables for 200 to 240 
V system
3M #2204 Large adjustable wrist strap
3M #2214 Small adjustable wrist strap
3M #3051 conductive ground cord

Anti Static Vacuum Cleaner
46–194427P278
46–194427P279

120V
230V

Air Filter  air intake

Safety Analyzer 46–285652G1 DALE 600 KIT (or equivalent) for electrical tests

SVHS VCR Cassette
E7010GG
E7010GF

60 minute
120 minute

SVHS VCR Head Cleaner See VCR user manual for requirements

3.5” MOD MEDIA

E8381AA
E8381AB

blank 128 M disk (for 230MB MO drive)
blank 230 M disk (for 230MB MO drive)
blank 640 M disk (for 1.3GB MO drive)
blank 1.3 GB disk (for 1.3GB MO drive)

3.5” MOD Media Cleaner 2117811 cleans the diskettes

3.5” MOD Head Cleaner Kit  2148392 cleans the drive heads

QIQ Phantom E8370RB RMI Grayscale Target Model 403GS

CD-R Media cleaner cleans the diskettes

B/W Printer Cleaning Sheet See printer user manual for requirements

Color Printer Cleaning Sheet See printer user manual for requirements

Disposable Gloves
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Section 10-5
System Periodic Maintenance

10-5-1 Preliminary Checks
The preliminary checks take about 15 minutes to perform. Refer to the system user documentation 
whenever necessary.

 

Table 10-6   System Preliminary Checks

Step Item Description

1 Ask & Listen Ask the customer if they have any problems or questions about the equipment.

2 Paperwork Fill in the top of the Periodic Maintenance (PM) Inspection Certificate. Note all probes and system 
options.

3 Power up Turn the system power on and verify that all fans and peripherals turn on. Watch the displays during 
power up to verify that no warning or error messages are displayed.

4 Probes Verify that the system properly recognizes all probes.

5 Displays Verify proper display on the monitor and touch panel.

6 Presets Backup all customer presets on an CD-R. 
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10-5-2 Functional Checks (See Also Chapter 4)
The functional checks take about 60 minutes to perform. Refer to the system user documentation 
whenever necessary.

10-5-2-1 System Checks
 

NOTE: * Some software may be considered standard depending upon system model configuration.

Table 10-7   System Functional Checks

÷ Step Description

B-Mode Verify basic B-Mode (2D) operation. Check the basic system controls that affect this mode of 
operation.

CF-Mode Verify basic CF-Mode (Color Flow Mode) operation. Check the basic system controls that affect this 
mode of operation.

Doppler Modes Verify basic Doppler operation (PW and CW if available). Check the basic system controls that affect 
this mode of operation.

M-Mode Verify basic M-Mode operation. Check the basic system controls that affect this mode of operation.

*Applicable 
Software Options

Verify the basic operation of all optional modes such as Multi-Image, 3D, Contrast, Harmonics, Cine, 
Stress Echo,... etc. Check the basic system controls that affect each options operation.

Probe Elements Perform an Element Test on each probe to verify that all probe elements (and system channels) are 
functional.

System Diagnostic Perform the Automatic Tests to verify that all boards function according to specifications.

Control Panel Test Perform the Control Panel Test Procedure to verify that all keyboard controls are OK. This is 
performed by the internal PC (backend processor) which does a normal keyboard run through.

Monitor Verify basic Monitor display functions. Refer to Chapter 3 of the User Manual.

Touch Panel Verify basic Touch Panel display functions. Refer to Chapter 3 of the User Manual.

Measurements Scan a gray scale phantom and use the measurement controls to verify distance and area calculation 
accuracy. Refer to the User Manual, Chapter 18, for measurement accuracy specifications.
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10-5-2-2 Peripheral/Option Checks
If any peripherals or options are not part of the system configuration, the check can be omitted. Refer 
to the User Manual for a list of approved peripherals/options.

10-5-3 Input Power

10-5-3-1 Mains Cable Inspection
 

10-5-4 Cleaning

10-5-4-1 General Cleaning
 

Table 10-8   GE Approved Peripheral/Hardware Option Functional Checks

Step Item Description

1 VCR Verify record/playback capabilities of the VCR. Clean heads and covers if necessary.

2 B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and covers if necessary.

3 Color Printer Verify hardcopy output of the Color video page printer. Clean heads and covers if necessary.

4 DICOM Verify that DICOM is functioning properly. Send an image to a DICOM device.

5 InSite/iLinq Verify that InSite is functioning properly. Ensure two-way remote communications.
(Warranty & Contract Customers only)

6 Camera Verify hardcopy output of the film camera. Clean as necessary.

7 Footswitch Verify that the footswitch is functioning as programed. Clean as necessary.

8 ECG Verify basic operation with customer

9 3D Probe

Table 10-9   Mains Cable Inspection

Step Item Description

1 Unplug Cord Disconnect the mains cable from the wall and system.

2 Inspect Inspect it and its connectors for damage of any kinds.

3 Verify Verify that the LINE, NEUTRAL and GROUND wires are properly attached to the terminals, and that no 
strands may cause a short circuit.

4 Verify Inlet connector retainer is functional.

Table 10-10   General Cleaning

Step Item Description

1 Console Use a fluid detergent in warm water on a soft, damp cloth to carefully wipe the entire system. Be careful 
not to get the cloth too wet so that moisture does not enter the console.

2 Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).

3 Monitor and 
Touch Panel
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10-5-4-2 Air Filter Cleaning
 \

NOTE: For your convenience or of the air filter is too dirty, replacement filters are available. Refer to 
Chapter 9 for the air filter replacement part number.

10-5-5 Physical Inspection
 

Table 10-11   Air Filter Cleaning - frequency varies with your environment

Step Item Description

1 Remove Filter 
Cover Refer to Chapter 8 for air filter location and removal instructions

2 Clean Filter The filters can be cleaned in sprinkling water, or they can be dusted with a vacuum cleaner. If the filter 
is metal wash and/or vacuum. If the filter is fiber or plastic vacuum or replace

3 Install Filter Install the clean filter.

Table 10-12   Physical Checks

Step Item Description

1 Labeling Verify that all system labeling is present and in readable condition. .

2 Scratches & Dents Inspect the console for dents, scratches or cracks.

3 Control Panel Inspect keyboard and control panel. Note any damaged or missing items.

4 Control Panel 
Movement

Verify ease of control panel (Operator I/O Panel) movement in all acceptable directions. Ensure that 
it latches in position as required.

5 Wheels & Brakes Check all wheels and casters for wear and verify operation of foot brake, to stop the unit from moving, 
and release mechanism. Check all wheel locks and wheel swivel locks for proper operation.

6 Cables & 
Connectors

Check all internal cable harnesses and connectors for wear and secure connector seating. Pay 
special attention to footswitch assembly and probe strain or bend reliefs.

7 Shielding & 
Covers

Check to ensure that all EMI shielding, internal covers, air flow panels and screws are in place. 
Missing covers and hardware could cause EMI/RFI problems while scanning.

8 External I/O Check all connectors for damage and verify that the labeling is good.

9 Op Panel Lights Check for proper operation of all operator panel and TCG lights.

10 Monitor Light Check for proper operation of any monitor lights and/or

11 External 
Microphone Check for proper operation of any external microphones by recording an audio test.
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10-5-6 Optional Diagnostic Checks
To complete the PM checks, access the diagnostic software as described in Chapters 5 or 7. View the 
error logs and run desired diagnostics.

10-5-6-1 View the Logs

1.) Review the system error log for any problems.
2.) Check the temperature log to see if there are any trends that could cause problems in the future.

10-5-7 Probe Maintenance

10-5-7-1 Probe Related Checks
 

10-5-7-2 Basic Probe Care
The system user manuals and various probe handling cards provide a complete description of probe 
care, maintenance, cleaning and disinfection. Ensure that you are completely familiar with the proper 
care of GE probes.

Ultrasound probes can be easily damaged by improper handling. See the User Manual and probe care 
cards for more details. Failure to follow these precautions can result in serious injury and equipment 
damage. Failure to properly handle or maintain a probe may also void its warranty.

Any evidence of wear indicates the probe cannot be used.

Do a visual check of the probe pins and system sockets before plugging in a probe.

TEE and Interoperative probes often have special considerations and individual probe user manuals. 
For TEE and Interoperative probes also refer to their separate user manuals.

10-5-7-3 Basic Probe Cleaning
Refer to the User’s Manual for details on probe cleaning.

NOTE: To help protect yourself from blood borne diseases, wear approved disposable gloves. These are made 
of nitrile derived from vegetable starch to prevent allergic latex reactions.

NOTE: Failure to follow the prescribed cleaning or disinfection procedures will void the probe’s 
warranty. DO NOT soak or wipe the lens with any product not listed in the User Manual. Doing 
so could result in irreparable damage to the probe. Follow care instructions that came with the 
probe.

NOTE: Disinfect a defective probe before you return it. Be sure to tag the probe as being disinfected.

Section 10-6
Using a Phantom

See the Basic User Manual “Customer Maintenance” for information on using a phantom and quality 
assurance tests.

Table 10-13   Probe Related Checks

Step Item Description

1 Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).

2 Probes Thoroughly check the system probe connectors and remove dust from inside the connector sockets 
if necessary. Visually check for bent, damaged or missing pins
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Section 10-7
Electrical Safety Tests

10-7-1 Safety Test Overview
The electrical safety tests in this section are based on and conform to NFPA 99 (For USA) and IEC 
60601-1 Medical Equipment Safety Standards. They are intended for the electrical safety evaluation of 
cord-connected, electrically operated, patient care equipment. If additional information is needed, refer 
to the NFPA 99 (For USA) and IEC 60601-1 documents.

 

Test the system, peripherals and probes for leakage current. Excessive leakage current can cause 
injury or death in sensitive patients. High leakage current can also indicate degradation of insulation and 
a potential for electrical failure. Do not use probes or equipment having excessive leakage current.

To minimize the risk that a probe may shock someone the customer should:

• Not use a probe that is cracked or damaged in any way
• Check probe leakage current:

* once a year on surface probes
* twice a year on endocavitary probes
* whenever probe damage is suspected

WARNINGWARNING THE USER MUST ENSURE THAT THE SAFETY INSPECTIONS ARE PERFORMED AT 
LEAST EVERY 12 MONTHS ACCORDING TO THE REQUIREMENTS OF THE PATIENT 
SAFETY STANDARD IEC-EN 60601-1. ONLY TRAINED PERSONS ARE ALLOWED TO 
PERFORM THE SAFETY INSPECTIONS MENTIONED ABOVE.

CAUTION To avoid electrical shock, the unit under test must not be connected to other electrical 
equipment. Remove all interconnecting cables and wires. The unit under test must not be 
contacted by users or patients while performing these tests.

CAUTION Possible risk of infection. Do not handle soiled or contaminated probes and other components 
that have been in patient contact. Follow appropriate cleaning and disinfecting procedures 
before handling the equipment.
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10-7-2 GEMS Leakage Current Limits
The following limits are summarized for NFPA 99 (For USA) and IEC 60601-1 Medical Equipment 
Safety Standards. These limits are GEMS standards and in some cases are lower than the above 
standards listed.

 

 

NOTE: *Mains Applied refers to the sink leakage test where mains (supply) voltage is applied to the 
part to determine the amount of current that will pass (or sink) to ground if a patient contacted 
mains voltage.

The following tests are performed at the factory and should be performed at the site. These tests are: 
grounding continuity, chassis leakage current, probe leakage current, and ECG leakage current. All 
measurements are made with an electrical safety analyzer Model 600/600E built by Dale Technology 
Corporation or equivalent device.

Table 10-14   Chassis Leakage Current Limits—Accessible Metal Surfaces

Country Normal Condition Open Ground Reverse Polarity Open Neutral

USA N/A 0.3 mA 0.3 mA N/A

Other 0.1 mA 0.5 mA 0.5 mA 0.5 mA

Table 10-15   Type BF Applied Part Leakage Current Limits - Non-Conductive 
(Floating) Surface and Cavity Probes

Country
Normal 

Condition Open Ground Reverse Polarity Open Neutral *Mains Applied

USA 0.05 mA 0.05 mA 0.05 mA 0.05 mA N/A

Other 0.1 mA 0.5 mA 0.5 mA 0.5 mA 5.0 mA

Table 10-16   Type CF Applied Part Leakage Current Limits - Surgical Probes and 
ECG Connections

Country
Normal 

Condition Open Ground Reverse Polarity Open Neutral *Mains Applied

USA 0.01 mA 0.05mA 0.05 mA N/A 0.025 mA

Other 0.01 mA 0.05 mA 0.05 mA 0.05 mA 0.05 mA
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10-7-3 Outlet Test - Wiring Arrangement - USA & Canada
Test all outlets in the area for proper grounding and wiring arrangement by plugging in the neon outlet 
tester and noting the combination of lights that are illuminated. Any problems found should be reported 
to the hospital immediately and the receptacle should not be used.

The Dale 600 has self-contained lamps designed for testing the outlet wiring arrangement. Plug the Dale 
600 into each outlet to be tested comparing the lamp status.

NOTE: No outlet tester can detect the condition where the Neutral (grounded supply) conductor and the 
Grounding (protective earth) conductor are reversed. If later tests indicate high leakage currents, this 
should be suspected as a possible cause and the outlet wiring should be visually inspected.

Figure 10-1 Typical Alternate Outlet Tester

Figure 10-2 Dale 600 Outlet Test

Combination 
of 

Lights

Condition CORRECT
WIRING

REVERSE
POLARITY

OPEN
GROUND

OPEN
HOT

HOT/GROUND
REVERSED
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10-7-4 Grounding Continuity  

Measure the resistance from the third pin of the attachment plug to the exposed metal parts of the case. 
The ground wire resistance should be less than 0.2 ohms. Reference the procedure in the IEC 601-1.1.

10-7-4-1 Meter Procedure
Follow these steps to test the ground wire resistance.

1.) Turn the LOGIQ™ 7 unit OFF.
2.) Plug the unit into the meter, and the meter into the tested AC wall outlet.
3.) Plug the black chassis cable into the meter's “CHASSIS” connector and attach the black chassis 

cable clamp to an exposed metal part of the LOGIQ™ 7 unit.
4.) Set the meter's “FUNCTION” switch to the RESISTANCE position.
5.) Set the meter's “POLARITY” switch to the OFF (center) position.
6.) Measure and record the ground wire resistance.

CAUTION Electric Shock Hazard. The patient must not be contacted to the equipment during this test

Figure 10-3 Ground Continuity Test
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10-7-4-2 Dale 600 - Ground Continuity
The Dale 600 measures line cord resistance from the third pin of the attachment plug to the meter’s 
Chassis Cable clamp. Test the grounding continuity of the system to all exposed metal parts in 
accordance with the IEC 601-1.1 procedure as above. Refer to the Dale 600 Instruction Manual for 
meter self tests and operation. Record measured resistance of the grounding continuity. The ground 
wire resistance should be less than 0.2 (Use any safety analyzer.)

 

Figure 10-4 Dale 600 Ground Continuity Test
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10-7-5 Chassis Leakage Current Test

10-7-5-1 Definition
This test measures the current that would flow in a grounded person who touched accessible metal 
parts of the bedside station if the ground wire should break. The test verifies the isolation of the power 
line from the chassis. The meter is connected from accessible metal parts of the case to ground. 
Measurements should be made with the unit On and Off, with the power line polarity Normal and 
Reversed. Record the highest reading. 

10-7-5-2 Generic Procedure
The test verifies the isolation of the power line from the chassis. The testing meter is connected from 
accessible metal parts of the case to ground. Measurements should be made with the unit ON and OFF, 
with the power line polarity Normal and Reversed. Record the highest reading of current.

When using the Microguard or a similar test instrument, its power plug may be inserted into the wall 
outlet and the equipment under test is plugged into the receptacle on the panel of the meter. This places 
the meter in the grounding conductor and the current flowing from the case to ground will be indicated 
in any of the current ranges. The maximum allowable limit for chassis source leakage is shown in Table 
10-14.

CAUTION Electric Shock Hazard. When the meter's ground switch is OPEN, don't touch the unit!

CAUTION Equipment damage possibility. Never switch the Polarity and the status of Neutral when the unit 
is powered ON. Be sure to turn the unit power OFF before switching them using the POLARITY 
switch and/or the NEUTRAL switch. Otherwise, the unit may be damaged.

Figure 10-5 Set Up for Chassis Source Leakage Current, 
IEC 601-1 Clause 19 - Continuos Leakage Currents and 

Patient, Auxiliary Currents
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10-7-5-3 Dale 600 Meter Procedure
When measuring system chassis currents with the Dale 600, always use the CHASSIS selection of the 
external/chassis function switch. This requires the ground clip lead and changing the meters switches 
in accordance with the IEC 601-1.1. Refer to the Dale 600 Instruction Manual for meter self-test and 
operation. Record the highest leakage current measured.

Follow these steps to test the unit for leakage current.

1.) Turn the LOGIQ™ 7 unit OFF.
2.) Plug the unit into the meter, and the meter into the tested AC wall outlet
3.) Plug the black chassis cable into the meter's “CHASSIS” connector and attach the black chassis 

cable clamp to an exposed metal part of the LOGIQ™ 7.
4.) Set the tester's “FUNCTION” switch to CHASSIS position.

5.) Follow the test conditions described for respective test points shown in Table 10-17. 

6.) Keep a record of the results with other hard copies of PM data kept on site.

Figure 10-6 Ground and Chassis Leakage Current Test

Table 10-17 Chassis Leakage Current Test Condition

TEST CONDITION

1 Mounting screw for probe receptacle

2 Wheel support

3 Mounting screw for CRT housing

4 Mounting screw for peripheral plugged into unit

5 Mounting screw for other peripheral powered by unit
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10-7-5-4 Data Sheet for Chassis Source Leakage Current
The test passes when all readings measure less than the value shown in Table 10-14. Record all data 
on the PM Inspection Certificate.

10-7-6 Isolated Patient Lead (Source) Leakage–Lead to Ground

10-7-6-1 Definition
This test measures the current which would flow to ground from any of the isolated ECG leads. The 
meter simulates a patient who is connected to the monitoring equipment and is grounded by touching 
some other grounded surface. Measurements should be made with the ground open and closed, with 
power line polarity normal and reversed, and with the ultrasound console Off and On. For each 
combination the operating controls, such as the lead switch, should be operated to find the worst case 
condition.

Table 10-18 Typical Data Sheet for Chassis Source Leakage Current

Unit Power
Tester Polarity 

Switch

Tester Neutral 
or Ground 

Switch

Test 1 
Probe 

Connector
Test 2 
Wheel

Test 3 
CRT

Optional 
Test 4 

Optional 
Test 5

Enter Name of tested peripheral here:

ON NORM OPEN

ON NORM CLOSED

ON REV OPEN

ON REV CLOSED

OFF NORM OPEN

OFF NORM CLOSED

OFF REV OPEN

OFF REV CLOSED

CAUTION Equipment damage possibility. Never switch the Polarity when the unit is powered ON. Be sure 
to turn the unit power OFF before switching the polarity using the POLARITY switch. Otherwise, 
the unit may be damaged.
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10-7-6-2 Generic Procedure
Measurements should be made with the ground open and closed, with power line polarity normal and 
reversed, and with the unit Off and On. For each combination, the operating controls such as the lead 
switch should be operated to find the worst case condition. 

10-7-6-3 Dale 600 Meter Procedure
The Dale 600 provides five snap type ECG buttons for testing patient leads. Snap on all patient leads 
to the meter and assure that the ground clip is connected to the system’s ground terminal. Select the 
meter’s LEAD-GND function. Select and test each ECG lead positions (except “ALL”) of the LEAD 
selector, testing each to the power condition combinations found in “PATIENT LEAD LEAKAGE” table 
in the “PM CHECKLIST”. Record the highest leakage current measured for each Power selection.

Follow these steps to test the ECG module for leakage current.

1.) Turn the LOGIQ™ 7 unit OFF.
2.) Plug the unit into the meter, and the meter into the tested AC wall outlet.
3.) Plug the black chassis cable into the meter's “CHASSIS” connector and attach the black chassis 

cable clamp to an exposed metal part of the LOGIQ™ 7 unit.
4.) Connect the patient leads to the corresponding snaps located at the upper front of the Dale 600/

600E. Lead nomenclature for this test is not important.

Figure 10-7 Test Circuit for Measuring Non-Isolated 
Patient Leads

CAUTION Line voltage is applied to the ECG leads during this test. To avoid possible electric shock 
hazard, the system being tested must not be touched by patients, users or anyone while the ISO 
TEST switch is depressed. When the meter's ground switch is OPEN, don't touch the unit!

POWER
OUTLET

H   (Black)

N   (White)

G   (Green)

Internal
circuitry

Insulating surface

Polarity reversing switch
(use both positions) 

Appliance power switch
(use both “off” and “on” positions)

Patient connected leads

The connection is at service entrance
or on the supply side of a separately
derived system

Building
ground

Grounding contact switch (use in both
“open” and “closed” positions)

Current meter
H = Hot
N = Neutral (grounded)
G = Grounding conductor

H 

N

G

Patient lead selector switch (if any)
(activated as required)

Appliance

Between each patient 
lead and ground
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10-7-6-3 Dale 600 Meter Procedure (cont’d)

5.) Set the meter's “FUNCTION” switch to LEAD TO GROUND position to measure the patient lead to 
ground leakage current.

6.) Select and test each ECG lead positions (except ALL) of the LEAD selector, testing each to the 
power condition combinations.

Figure 10-1 ECG Leakage Current Test

Table 10-19  Testing Power Conditions

ECG Power Meter’s Polarity Switch Meter’s Neutral Switch

ON NORM CLOSED

ON NORM OPEN

ON REVERSE CLOSED

ON REVERSE OPEN

OFF NORM CLOSED

OFF NORM OPEN

OFF REVERSE CLOSED

OFF REVERSE OPEN

ECG
Patient
Cable
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10-7-6-3 Dale 600 Meter Procedure (cont’d)
7.) Record the patient lead to ground leakage current measured on the data sheet.
8.) Set the meter's “FUNCTION” switch to LEAD TO LEAD position to measure the lead to lead leakage 

current.
9.) Select and test each ECG lead positions (except ALL) of the LEAD selector, testing each to the 

power condition combinations.
10.)Record the lead to lead leakage current measured on the data sheet.
11.)Set the meter's “FUNCTION” switch to LEAD ISO position to measure the patient lead isolation 

current.
12.)Select and test each ECG lead positions (except ALL) of the LEAD selector, testing each to the 

power condition combinations.
13.)Depress the rocker switch to ISO TEST and read the isolation current. To apply the voltage to the 

lead safely, the voltage is only applied when the rocker switch is depressed to ISO TEST.
14.)Record the patient lead isolation current measured on the data sheet.

10-7-7 Isolated Patient Lead (Source) Leakage–Lead to Lead
Reference the procedure in the IEC 60601-1. When using the Dale 600, switch the meter’s function 
selector to the LEAD-LEAD position. Select and test each of the five ECG lead positions (except ALL) 
on the LEAD selector, testing each to the power condition combinations found in the table. Record the 
highest leakage current measured.

10-7-7-1 Dale 600 Patient Lead Tests
NEUTRAL POLARITY

1.) Closed Normal
2.) Open Normal
3.) Closed Reversed
4.) Open Reversed

10-7-8 Isolated Patient Lead (Sink) Leakage-Isolation Test
Reference the procedure in the IEC 60601-1. When using the Dale 600, switch the meter’s function 
selector to the LEAD-ISO. Select the ALL position on the lead selector. Depress the rocker switch to 
ISO TEST to test lead isolation.

NOTE: It is not necessary to test each lead individually or power condition combinations as required in 
previous tests.

CAUTION Line voltage is applied to the ECG leads during this test. To avoid possible electric shock 
hazard, the system being tested must not be touched by patients, users or anyone while the ISO 
TEST switch is depressed.
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10-7-8-1 Data Sheet for ECG Leakage Current
The test passes when all readings measure less than the value shown in the table below. Record all 
data on the PM Inspection Certificate.

Table 10-20 Maximum Allowance Limit for ECG Leakage Current

AC Power 
Source

Maximum
Allowance Limit

GROUND OPEN
GROUND 
CLOSED

Patient Lead to Ground Leakage Current Test
and

Patient Lead to Lead Leakage Current Test

115V 10uA 10uA

220/240V 500uA 10uA

Table 10-21   Maximum Allowance Limit for ECG Leakage Current

AC Power 
Source

Maximum
Allowance Limit

Patient Lead Isolation Current Test
115V 20uA

220/240V 5mA

Table 10-22 Typical Data Sheet for ECG Leakage Current

ECG 
Power

Tester 
Polarity 
Switch

Tester 
Ground 
Switch

Tester Lead Selector

RL RA LA LL C

ON NORM CLOSED

ON REVERSE CLOSED

ON NORM OPEN

ON REVERSE OPEN

OFF NORM CLOSED

OFF REVERSE CLOSED

OFF NORM OPEN

OFF REVERSE OPEN
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10-7-9 Probe Leakage Current Test

10-7-9-1 Definition
This test measures the current that would flow to ground from any of the probes through a patient who 
is being scanned and becomes grounded by touching some other grounded surface.

NOTE: Some leakage current is expected on each probe, depending on its design. Small variations in probe 
leakage currents are normal from probe to probe. Other variations will result from differences in line 
voltage and test lead placement. 
It is abnormal if no leakage current is measured. If no leakage current is detected, check the 
configuration of the test equipment.

10-7-9-2 Test Equipment

Table 10-23 Test Equipment kits (Chapter 10 LOGIQ™ 7 Proprietary Service 
Manual)

Kit Description Contents

46-285652G1

Dale 601 - 
ULTRASOUND SAFETY 
ANALYZER FIELD KIT

-
for 120V unit

• ELECTRICAL SAFETY ANALYZER, DALE, MODEL 601 for 120V unit
• Vendor MODEL 600/100 8FT CHASSIS GROUND CABLE
• Vendor MODEL 600/102 6FT SALINE BATH GROUND CABLE
• Vendor MODEL 600/202 ULTRASOUND PROBE ADAPTER 
• Vendor MODEL 600/600 SOFT CARRYING CASE
• Vendor MODEL 600/900 OPERATORS MANUAL 
• Vendor MODEL 600/901 LMINATED OPERATORS GUIDE 

46-328406G2

Dale 601E - 
ULTRASOUND SAFETY 
ANALYZER FIELD KIT

-
for 220V unit

• ELECTRICAL SAFETY ANALYZER, DALE, MODEL 601E for 220V unit
• Vendor MODEL 600/100 8FT CHASSIS GROUND CABLE
• Vendor MODEL 600/101 16FT CHASSIS GROUND CABLE 
• Vendor MODEL 600/103 8FT CHASSIS GROUND PROBE 
• Vendor MODEL 600/200 8FT EXTERNAL LEAKAGE GROUND CABLE 
• #20 WIRE W/MINIGATOR CLIPS, 2 Ft
• CARRYING CASE and foam padding
• Vendor MODEL 600/900 OPERATORS MANUAL

2113015 ULTRASOUND PROBE 
LEAKAGE ADAPTER KIT

• LOGIQ FAMILY PROBE ADAPTER
• Vendor MODEL 600/202 ULTRASOUND PROBE ADAPTER 
• Vendor MODEL 600/203 RADIUS/SONOCHROME PROBE LEAKAGE 

CURRENT ADAPTER 
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10-7-9-2 Test Equipment (cont’d)
. 

Table 10-24 Test Equipment and Accessory Description

Dale Part number Accessory Name Picture Description

Vendor MODEL 
600/100 

46-285647P2 
CHASSIS CABLE

Black coil cord with extended 
length and black grips.

Used on DALE601/601E to measure 
earth resistance and enclosure 
leakage current. Also used as 

reference lead for external 
measurement. 

Vendor MODEL
600/102 

46-285647P4
CHASSIS GROUND PROBE

Black coil cord with needle probe 
for testing receptacles and for 

tight spaces.

Also referred to as “Saline Probe” or 
“Saline Bath Ground Cable”. 

Measures earth resistance and 
enclosure leakage current. Also used 

for grounding saline baths for 
isolation testing of probes. 

Used on DALE601/601E. This probe 
may be substituted for the 600/100 

Chassis Cable, and used as a probe 
instead of a clamp.

Vendor MODEL
600/200

46-285647P6

ISO/EXTERNAL LEAKAGE 
CABLE

Black coiled cord with red grips.

Standard auxiliary cable for external 
measurements of leakage current 
and voltage gradient between two 

surfaces.
Used on DALE601/601E to measure:
• Point-to-Point Leakage Current
• Probe and Transducer Isolation 

Current
May only be connected to the female 

connector of the Analyzer, labeled 
EXTERNAL

Vendor MODEL
600/202

2107545-2

ULTRASOUND LOGIQ FAMILY 
ADAPTER 

Use during M.A.P. or Isolation test
(see 10-7-9-5 - Meter Procedure 
Using Probe Adapter to Measure 
Probe Isolation (Sink) Current)
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10-7-9-3 Generic Procedure for Leakage Current
Measurements should be made with the ground open and closed, with power line mains polarity normal 
and reversed, and with the unit Off and On. For each combination, the probe must be active to find the 
worst case condition.

10-7-9-4 Meter Procedure Using Dale Meter to Measure Leakage Current
The ultrasound probe’s imaging area is immersed in a solution along with a grounding probe from the 
test meter to complete the current path. The solution is a mixture of water and salt. The salt adds free 
ions to the water, making it conductive. Use a mixture of 1 quart of water with one or more grams of 
table salt, mixed thoroughly.

Follow these steps to test each probe for leakage current:

1.) Turn OFF the LOGIQ™ 7 unit.
2.) Plug the unit’s mains power cord into the test meter, and plug the test meter into the tested AC wall 

outlet.
3.) Plug the Chassis Ground Probe (saline probe) into the test meter's “CHASSIS” connector.
4.) Set the test meter's “FUNCTION” switch to “CHASSIS” (Dale 600) or "ENCLOSURE LEAKAGE" 

(Dale 601).
5.) Connect the probe to be tested to the LOGIQ™ 7 unit.
6.) Put the saline probe and the probe’s probe face (imaging area of the probe) into the saline bath.

7.) Power ON the LOGIQ™ 7 unit.
8.) After the LOGIQ™ 7 unit has completed the boot process, select the probe to be tested so it is the 

active probe.
9.) Depress the LIFT GROUND rocker switch and record the highest current reading.
10.)Follow the test conditions described in Table 10-25 for every probe.

The test passes when all readings measure less than the values shown in Table 10-15 and Table 
10-16.

Figure 10-8   Set Up for Probe Leakage Current

CAUTION To avoid probe damage and possible electric shock, do not immerse probes into any liquid 
beyond the level indicated in the probe users manual. Do not touch the probe, conductive liquid 
or any part of the unit under test while the LIFT GROUND switch is depressed.

SALINE
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10-7-9-4 Meter Procedure Using Dale Meter to Measure Leakage Current (cont’d)
11.)Keep a record of the results with other hard copies of Planned Maintenance data.

 

CAUTION
Power off

Equipment damage possibility. Never switch the Polarity or the status of the Neutral when the 
Ultrasound unit is powered on. 
Power off the Ultrasound unit, allow the stored energy to bleed down, and turn the circuit 
breaker off BEFORE switching the POLARITY switch and/or the NEUTRAL switch on the leakage 
meter to avoid possible power supply damage.

Table 10-25   Typical Data Sheet For Probe Source Leakage Current

Probe Tested:

 Unit Power
Tester Power Polarity 

Switch
Tester NEUTRAL 

Switch
Tester GROUND 

Switch Measurement

Start with System Powered OFF

OFF NORMAL OPEN CLOSED

OFF NORMAL OPEN OPEN

OFF NORMAL CLOSED CLOSED

OFF NORMAL CLOSED OPEN

Open Neutral first, then attempt Power ON

ON NORMAL OPEN CLOSED

ON NORMAL OPEN OPEN

Close Neutral. Power System ON, and wait until Probe under test is active, before continuing

ON NORMAL CLOSED CLOSED

ON NORMAL CLOSED OPEN

Power System OFF using the Shutdown pop-up. 
Turn OFF System Circuit Breaker at rear of System or unplug from Meter outlet. 
Switch Tester Power Polarity switch to Reversed, then turn System Breaker ON or plug power 
cord into Meter outlet.

OFF REVERSED OPEN CLOSED

OFF REVERSED OPEN OPEN

OFF REVERSED CLOSED CLOSED

OFF REVERSED CLOSED OPEN

Open Neutral first, then attempt Power ON

ON REVERSED OPEN CLOSED

ON REVERSED OPEN OPEN

Close Neutral. Power System ON, and wait until Probe under test is active, before continuing

ON REVERSED CLOSED CLOSED

ON REVERSED CLOSED OPEN
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10-7-9-5 Meter Procedure Using Probe Adapter to Measure Probe Isolation (Sink) Current
The Dale 600/600E provides a method for testing probes independently from the system. The meter 
utilizes a probe adapter to apply a test potential commonly to all connector pins. 

The ultrasound probe’s imaging area is immersed in a solution along with a grounding probe from the 
test meter to complete the current path. The solution is a mixture of water and salt. The salt adds free 
ions to the water, making it conductive. Use a mixture of 1 quart of water with one or more grams of 
table salt, mixed thoroughly.

Follow these steps to test each probe for leakage current.

1.) Plug the test meter into the tested AC wall outlet.
2.) Plug the Chassis Ground Probe (saline probe in diagram) into the test meter's “CHASSIS” 

connector.
3.) Connect the probe to be tested to the LOGIQ Family Probe Adapter.
4.) Plug the LOGIQ Family Probe Adapter into the test meter's connector marked “EXTERNAL”.

5.) Set the meter's “FUNCTION” switch to EXTERNAL position.
6.) Put the Chassis Ground Probe and the probe’s probe face (imaging area of the probe) into the 

saline bath.

7.) Depress the ISO TEST (Dale 600) or Mains on Applied Parts (MAP) (DALE 601) ROCKER SWITCH 
and record the highest current reading.

Figure 10-9   Probe Isolation (Sink) Current Test

CAUTION To avoid probe damage and possible electric shock, do not immerse probes into any liquid 
beyond the level indicated in the probe users manual. Do not touch the probe, conductive liquid 
or any part of the unit under test while the ISO Test/MAP switch is depressed.
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10-7-9-5 Meter Procedure Using Probe Adapter to Measure Probe Isolation (Sink) Current (cont’d)

8.) Test every probe and record in Table 10-26 the test results for every probe.
The test passes when all readings measure less than the values in Table 10-30.

9.) Keep a record of the results with other hard copies of Planned Maintenance data.
. 

Table 10-26   Probes Tested for Isolation (Sink) Current 

Probe Tested ISO/Mains Applied
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GE Healthcare Leakage Current Limits for LOGIQ™ 7

The following limits are summarized for NFPA 99 (For USA) and IEC 60601-1 Medical Equipment 
Safety Standards. Measurement limits per IEC 60601-1 Medical Equipment Safety Standards, Table IV. 

 

 

NOTE: *Measurement limits per IEC 60601-1 Medical Equipment Safety Standards, Table 19.5DV.1

**Most meters (like Dale 600/601) only measure AC (rms).

***ISO (on Dale 600) and Mains Applied (on Dale 601) refer to the sink leakage test where 
mains (supply) voltage is applied to the part to determine the amount of current that will pass 
(or sink) to ground if a patient contacted mains voltage.

Table 10-27   Chassis Leakage Current Limits—Accessible Metal Surfaces

Country Normal Condition Open Ground Reverse Polarity Open Neutral

USA 0.1 mA 0.3 mA* 0.1 mA 0.3 mA

Other 0.1 mA 0.5 mA 0.1 mA 0.5 mA

Table 10-28   Type BF Applied Part Leakage Current Limits - Non-Conductive (Floating) Surface 
and Cavity Probes

All Countries Normal Condition Open Ground Reverse Polarity Open Neutral

AC 0.1 mA 0.5 mA 0.1 mA 0.5 mA

DC** 0.01 mA 0.05 mA 0.01 mA 0.05 mA

Table 10-29   Type CF Applied Part Leakage Current Limits - Surgical Probes and ECG 
Connections

Country Normal Condition Open Ground Reverse Polarity Open Neutral

USA 0.01 mA 0.05mA 0.01 mA 0.05 mA

Other 0.01 mA 0.05 mA 0.01mA 0.05 mA

Table 10-30   ISO (on Dale 600) and Mains Applied (on Dale 601) Limits***

Probe Type Measurement

BF 5 mA

CF 0.05 mA
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Section 10-1
When There's Too Much Leakage Current...

CHASSIS FAILS
Check the ground on the power cord and plug for continuity. Ensure the ground is not broken, frayed, 
or intermittent. Replace any defective part.

Tighten all grounds. Ensure star washers are under all ground studs.

Inspect wiring for bad crimps, poor connections, or damage.

Test the wall outlet; verify it is grounded and is free of other wiring abnormalities. Notify the user or 
owner to correct any deviations. As a work around, check the other outlets to see if they could be used 
instead.

NOTE: No outlet tester can detect the condition where the white neutral wire and the green grounding 
wire are reversed. If later tests indicate high leakage currents, this should be suspected as a 
possible cause and the outlet wiring should be visually inspected.

PROBE FAILS
Test the probe in another connector to isolate if the fault lies with the probe or the scanner.

NOTE: Each probe will have some amount of leakage, dependent on its design. Small variations in 
probe leakage currents are normal from probe to probe. Other variations will result from 
differences in line voltage and test lead placement. The maximum allowable leakage current for 
body surface contact probe differs from inter-cavity probe. Be sure to enter the correct probe 
type in the appropriate space on the check list.

If excessive leakage current is slot dependent, inspect the system connector for bent pins, poor 
connections, and ground continuity.

If the problem remains with the probe, replace the probe.

PERIPHERAL FAILS
Tighten all grounds. Ensure star washers are under all ground studs.

Inspect wiring for bad crimps, poor connections, or damage.

STILL FAILS
If all else fails, begin isolation by removing the probes, external peripherals, then the on board ones, 
one at a time while monitoring the leakage current measurement.

NEW UNIT
If the leakage current measurement tests fail on a new unit and if situation can not be corrected, submit 
a Safety Failure Report to document the system problem. Remove unit from operation.

ECG FAILS
Inspect cables for damage or poor connections
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PM INSPECTION CERTIFICATE  

* Scan Format: Phased Array, Linear Array, Curved Array, Mechanical Array or Other

FUNCTIONAL CHECKS PHYSICAL INSPECTION AND CLEANING 

COMMENTS: 
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________

Customer Name: System ID: Dispatch Number / Date Performed: Warranty/Contract/HBS

System Type Model Number: Serial Number: Manufacture Date:

Probe 1: Frequency: Scan Format*: Model Number: Serial Number:

Probe 2: Frequency: Scan Format*: Model Number: Serial Number:

Probe 3: Frequency: Scan Format*: Model Number: Serial Number:

Probe 4: Frequency: Scan Format*: Model Number: Serial Number:

Probe 5: Frequency: Scan Format*: Model Number: Serial Number:

Probe 6: Frequency: Scan Format*: Model Number: Serial Number:

Probe 7: Frequency: Scan Format*: Model Number: Serial Number:

Probe 8: Frequency: Scan Format*: Model Number: Serial Number:

Probe 9: Frequency: Scan Format*: Model Number: Serial Number:

Functional Check (if applicable)
OK? or 

N/A
Physical Inspection and Cleaning 

(if applicable) Inspect Clean

B-Mode Function Console

Doppler Modes Function Monitor

CF-Mode Function Touch Panel

M-Mode Function Air Filter

Applicable Software Options Probe Holders

Applicable Hardware Options External I/O

Control Panel Wheels, Brakes & Swivel Locks

Monitor Cables and Connectors

Touch Panel GE Approved Peripherals (VCR, CD-R, MOD, Printers)

Measurement Accuracy

GE Approved Peripherals
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ELECTRICAL SAFETY

Final Check. All system covers are in place. System scans with all probes as expected.

Accepted by: ______________________________________________________________________

Electrical Test Performed
Max Value 
Allowed

Value 
Measured OK? Comments

Outlet (correct ground &wiring config.)

System Ground Continuity

Chassis Source Leakage Current - Probe

Chassis Source Leakage Current - Wheel

Chassis Source Leakage Current - CRT

Patient Lead Source Leakage
(Lead to Ground)

Patient Lead Source Leakage
(Lead to Lead)

Patient Lead Source Leakage
(Isolation)

Peripheral 1 Leakage Current

Peripheral 1Ground Continuity

Peripheral 2 Leakage Current

Peripheral 2Ground Continuity

Peripheral 3 Leakage Current

Peripheral 3Ground Continuity

PROBES

Probe Number 
(from previous page)

Max Value 
Allowed

Max Value 
Measured OK? Comments

Probe 1:

Probe 2:

Probe 3:

Probe 4:

Probe 5:

Probe 6:

Probe 7:

Probe 8:

Probe 9:
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